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Dorico 5.1.30 

28 March 2004 

Improvements 

Audio engine 
Steinberg Built-in ASIO Driver. The Steinberg Built-in ASIO Driver has been updated to 

version 1.0.6 (Windows only). 

Barlines 
Systemic barlines. In special circumstances it is necessary to hide the systemic barline 

and brackets at the start of a system, or at a mid-system gap for a coda. To achieve 

this, a new Hide systemic barline property has been added for system and frame 

breaks, and for codas (which produce a mid-system gap). 

Repeat barlines. When creating a start or end repeat barline, Dorico now considers 

whether an end or start repeat barline already exists at that position, and if so, 

creates a combined end-start repeat barline, instead of replacing the start repeat 

with an end repeat, or vice versa. 

Bar repeats 
Handle positions. The position of the end handle for bar repeat regions has been 

adjusted such that the end handle of one region will not collide with the start handle 

for an abutting region. This makes it easier to adjust the end and start handles of 

abutting regions. The same improvement has been made to rhythmic slash regions 

and chord symbol regions. 

Breaks 
Changing staff size. When activating the Space size property for a selected system or 

frame break, the default value for the property is now set from the prevailing staff 

size, making it much easier to determine the desired value relative to the current 

size. 

Holds and pauses 
Fermatas in slash regions. Fermatas now appear in slash regions if required. 

Lyrics 
Vertical position. It is now possible in Engrave mode to adjust the vertical position of 

lines of lyrics on condensed staves, on percussion kits shown using the five-line 

staff or grid presentation type, and in material cued from another instrument. 

Reset Appearance. The speed of Edit ▶ Reset Appearance on many selected lyrics has 

been significantly improved. This also correspondingly improves the speed of 
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resetting the appearance of chord symbols and text items. Furthermore, after doing 

Edit ▶ Reset Appearance, lyrics now remain selected. 

Markers and timecode 
Timecode components. New options on the Markers page of Engraving Options allow you 

to choose whether hours and frames are displayed in the timecode shown for 

markers and in timecode at the start of the system or on the timecode staff. 

Percussion 
Bar rests in percussion kits. A new option Bar rests in additional voices in five-line staff 

presentation has been added to the Percussion page of Notation Options. This 

allows Dorico to show a bar rest in the up-stem or down-stem voice in bars where 

no notes are present in that voice, without having to show additional bar rests in all 

instruments (via the existing Bar rests in additional voices option on the Rests 

page). 

Playback 
NotePerformer expression map. At the request of the team at Wallander Instruments, the 

playback options overrides for the dynamic delta for accent and marcato in the 

NotePerformer expression map have been removed; this change affects only newly 

created projects. 

Rehearsal marks 
Custom infix. In addition to allowing a custom prefix and suffix to specify text that should 

appear both before and after the letter or bar number in a rehearsal mark, Dorico 

now allows a custom infix, which will be inserted between each character of the 

rehearsal mark. Some fonts, such as Finale Jazz and Finale Broadway Copyist, use a 

combination of characters to provide handwritten-style borders and brackets. You 

can now specify an appropriate prefix, infix, and suffix to automate the production 

of such bordered rehearsal marks. The new Custom infix option can be found on 

the Rehearsal Marks page of Engraving Options, along with a new option Insert 

infix between final pair of characters. Some of these custom fonts expect the infix 

to appear between every pair of characters, while others work best if the infix is not 

specified between the final two characters. Check the documentation provided with 

your custom font to determine whether this option should be activated. 

Repeat markers 
Coda gaps. The flexibility of gaps before codas has been improved. A new Default gap 

before coda section at start of system option has been added to the Repeat 

Sections section of the Repeat Markers page of Engraving Options, allowing you to 

specify the default gap when a coda falls at the start of a system, rather than in the 

middle of the system. 
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In addition, a new Coda gap width property has been added, allowing you to 

override the coda gap for a selected coda item. 

Staff labels 
Ranges for condensed staves. A new option Consecutive player numbers has been added 

to the Condensing page of Engraving Options, allowing you to specify that 

consecutively numbered instruments condensed onto the same staff should be 

shown as a range: for example, four horns condensed onto the same staff can now 

be shown as Horn 1–4 rather than Horn 1.2.3.4. 

Instrument changes. When Instrument transition position is set to Before first note in 

new instrument on the Players page of Layout Options, Dorico will switch to the 

new instrument at the barline immediately prior to the first note in the new 

instrument. If this happens in the middle of the system, and the old instrument has 

no notes on that system, you might prefer the staff label at the start of the system to 

show the instrument that will start playing in the middle of the system, rather than 

the instrument that was playing on the previous system. If so, activate the new 

Show first sounding instrument on system option on the Staves and Systems 

page of Layout Options. 

Smart quotes. A new Smarten quotes option has been added to the Case section of the 

Staff Labels page of Engraving Options. When activated, any straight quotes or 

typewriter apostrophes in staff labels will be replaced with curved versions. 

User interface 
Status bar. It is possible to choose which elements should appear in the status bar by 

right-clicking anywhere on the status bar. A context menu appears, from which you 

can choose to show or hide any of the controls shown for the current project 

window mode. The choices you make here are saved as application preferences, so 

affect all project windows. If you use a display in portrait orientation, or otherwise 

need to make the Dorico project window especially narrow, you will find it helpful to 

hide some of the items in the status bar, as this allows the project window to have a 

narrower minimum width. 

Object creation panel. When reopening a project, Dorico now restores the object creation 

panel in Write mode that was visible when you were last working on your project. 

Key signatures in the Hub. On the Create New page of the Hub, when creating a major 

key signature, you will now find G♭ rather than F♯ as one of the available root notes. 

Recent files. The File ▶ Open Recent menu no longer shows the names of recent projects 

prepended by numbers on macOS, as is conventional for that platform. (The 

projects are still prepended by numbers on Windows, as before.) 
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Diagnostic reports. Recent versions of macOS have started to move crash log files into a 

new Retired subfolder inside the DiagnosticReports folder. When you choose Help 

▶ Create Diagnostic Report, Dorico will now also look for crash logs inside 

subfolders of DiagnosticReports. Crash logs up to 96 hours old will now be collected 

for the report (previously, the threshold was 48 hours). 

Dorico SE and Elements 
Upgrade reminders. Dorico SE is available for free download, and allows the creation of 

projects with up to eight players. It has many of the powerful, smart features of 

Dorico Elements and Dorico Pro. To help Dorico SE users identify where they could 

further benefit from the additional functionality of Dorico Elements, the menus in 

Dorico SE now contain all the items that are present in Dorico Elements with a 

special lock icon, and when clicked, they provide a simple way to buy an upgrade to 

Dorico Elements from the Steinberg online shop. 

Similarly, in Dorico Elements, some of the advanced customization options of 

Dorico Pro are excluded. These items, particularly in the Library menu, are now 

shown with a lock icon. When clicked, they too provide a simple way to buy an 

upgrade to Dorico Pro from the Steinberg online shop. 
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Issues resolved 
Component Issue 

Audio engine On some systems, the audio engine could crash on start-up due to a problem with detecting 

certain models of CPU; this has now been fixed. 

Chord symbols Chord symbols that have been suppressed in playback no longer incorrectly print in gray if 

View ▶ Note and Rest Colors ▶ Suppressed Playback is activated. 

Chord symbols When editing a chord symbol in Engrave mode with multiple components, Dorico could crash 

when returning from a nested editor; this has now been fixed. 

Device Setup On some systems, changing settings via Edit ▶ Device Setup after opening a project but before 

all sounds have been loaded could cause a crash; now you cannot open Device Setup before 

sounds have finished loading. 

Divisi Under some circumstances, slurs in a secondary voice in a divisi staff could disappear in 

unison ranges; this has now been fixed. 

Divisi Under rare circumstances involving condensed divisi sections, music under slurs could 

sometimes disappear; this has now been fixed. 

Dynamics When duplicating a flow, subito modifiers on dynamics are now correctly reproduced. 

Dynamics When the new option Position end of hairpin relative to note or chord is set to Right side of 

note on main stem and the hairpin ends at the start of a bar where an immediate dynamic is 

present, the hairpin now correctly stops before the barline. 

Dynamics When a hyphenated text dynamic begins with an immediate dynamic, the dynamic no longer 

overruns the rhythmic position at which it is expected to end. 

Dynamics When a hyphenated text dynamic ends with an immediate dynamic, the immediate dynamic 

is no longer vertically displaced outside the gradual dynamic. 

Dynamics Gradual dynamics drawn as hyphenated text where Final syllable at end of line is active no 

longer sometimes overprint following immediate dynamics in the event that the gradual 

dynamic is preceded by an immediate dynamic with a long suffix. 

Key signatures When specifying the octave at which an accidental should appear in a custom key signature 

for a particular clef, those choices now correctly apply to octave clefs based on the same clef 

symbol. 

Key signatures When a custom key signature appears at a mid-system preamble, for the beginning of an 

extra staff or an ossia, accidentals are now correctly positioned at the chosen octave for the 

prevailing clef. 
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Component Issue 

Library Manager Where available, items in the Library Manager are now shown in the current application 

language, instead of always appearing in English. 

Library Manager The controls to sync options between the factory or user library did not always work reliably 

when the Library Manager was first opened, until a different category was chosen in the left-

hand list; this has now been fixed. 

Lines It is now possible to create multiple rhythmic position-attached horizontal lines in succession 

from a loaded mouse pointer, if settings dictate. 

Live editing Dorico could crash when making a selection with the mouse, or when trying to initiate a live 

editing drag; this has now been fixed. 

Lyrics The appearance of elision slurs, also used for Japanese and Korean lyrics, have been improved 

such that they look more consistent at different combinations of staff and lyric size. 

Note input When making a marquee or Shift+click selection across a fretted instrument displaying both 

notation and tablature, Dorico now only selects the notation; previously, it would select both 

notation and tablature, which could lead to odd problems when, for example, undoing the 

selection. 

Note input When using extended tonality systems, respelling a note using the note name above or below 

could cause the note to become unexpectedly detuned; this has now been fixed. 

Note input When creating a region-based item (for example, a bar repeat region or numbered bar 

region), if the selection starts or ends with a dynamic that is part of a larger, unselected group, 

the created region no longer unexpectedly extends to the end of the dynamic group. 

Note input The rhythmic grid selector in the bottom left-hand corner of the project window now correctly 

updates on undo and redo. 

Octave lines It is now once again possible to create octave lines by clicking and dragging with the mouse. 

Page layout In rare circumstances, enlarging the staff size or reducing the height of a music frame such 

that only a single system can fit could cause a crash; this has now been fixed. 

Playback In very rare circumstances, Dorico could hang when opening a project if the trill or tremolo 

duration specified in Playback Options was set to zero; this has now been fixed. 

Playback Removing a player from a flow now immediately updates playback, so when you next 

playback, you will not continue to hear the removed player’s music. 

Playback The randomness of dynamic humanization has been improved. 

Playback The default playback sound for instruments in the Sketch family have been improved. 
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Component Issue 

Playback Dorico could crash when attempting to calculate playback for trills bounded by grace notes; 

this has now been fixed. 

Playback Under some circumstances, Dorico could fail to restore the correct tempo at an a tempo 

following a fermata; this has now been fixed. 

Playback Under some circumstances, a trill that changes speed over its duration could end with the 

same pitch as the following note, resulting in the note being restruck; this has now been fixed. 

Players Under certain circumstances, player names could change unexpectedly when reopening a 

project after having changed options on the Language page of Engraving Options; this has 

now been fixed. 

Project files Using the Share ▶ Dorico Project option in Dorico for iPad for a project located in iCloud Drive 

but not in the Dorico folder within iCloud Drive now works correctly (Dorico for iPad only). 

Project Statistics Dorico now calculates statistics based on the full score layout if the project only has a single 

full score layout; otherwise, it calculates statistics for the current layout. 

Setup mode Choosing Setup ▶ New Player Group from the menu could unexpectedly cause a group to be 

created for a player other than the currently selected players; this has now been fixed. 

Staff labels The {@staffLabelsFull@} token now respects the options for the appearance of instrument 

transpositions on the Language page of Engraving Options. 

Text export When exporting dynamics to a CSV file, modifiers such as poco and molto are now correctly 

included. 

Text export When exporting tempo to a CSV file, tempos are now exported more accurately. 

Time signatures Dorico did not correctly account for the size of large time signatures shown for percussion 

and keyboard instruments, which could under some circumstances result in notes 

overprinting time signatures; this has now been fixed. 

Time signatures When different empty staves are hidden on successive systems, the cautionary large time 

signature at the end of a system could appear at a different vertical position than earlier time 

signatures on the system; this has now been fixed. 

Trills In rare circumstances, Dorico could crash when attempting to position a trill; this has now 

been fixed. 

User interface When creating or removing split views, Dorico now attempts to restore the last view position 

for each view. 
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Component Issue 

User interface The width of the column showing the checkbox in the MIDI Input Devices list on the Play page 

of Preferences has been increased. 

User interface When player names are shown in lists in Layout Options, any tokens for accidentals in their 

names are now correctly removed. 

User interface Dorico now brings the selection into view if casting off changes as a result of changing Layout 

Options. 
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Dorico 5.1.20 

14 February 2024 

Improvements 

Accidentals 
Cautionary accidentals. Dorico 5.1.10 included a change in its cautionary accidental 

calculation algorithms that resulted in some unnecessary cautionary accidentals 

no longer appearing; specifically, a cautionary accidental on the same pitch name 

and in the same octave but in another voice on the same instrument (including on 

another staff, for grand staff instruments) would previously have appeared, but as 

of Dorico 5.1.10 no longer does. 

A new option Suppress cautionary accidentals at same pitch and octave in other 

voices on the same instrument has been added to the new Advanced Options 

section of the Cautionary Accidentals page of Notation Options, allowing you to opt 

out of this new behavior. This option is enabled in new projects but disabled in 

existing projects to avoid unexpected changes. 

Comments 
Comments panel. It is now possible to right-click on the list of comments in the 

Comments panel in Write mode to show a context menu with two submenus. The 

Show submenu allows you to choose which metadata should appear in each card in 

the list of comments. If you do not collaborate with other editors, for example, it 

may be unnecessary for you to see the name of the author of every comment, or the 

date. The choices you make in this menu are stored for the application as a whole 

and are automatically applied for each project you open. 

The Sort By submenu allows you to choose the order in which the comments are 

listed in the panel. By default, comments are listed by flow and bar, but you might 

prefer to group comments by instrument, or by the comment text itself. Like the 

choices you make in the Show menu, the choices you make here are stored for the 

application as a whole and are automatically applied for each project you open. 

Export comments. When exporting comments, the exported web page now includes only 

those fields that are shown in the Comments panel. 

Dynamics 
Hairpin end position. A new option Position end of hairpin relative to note or chord has 

been added to the Advanced Options section of the Gradual Dynamics section of 

the Dynamics page of Engraving Options. This allows you to specify that the right-

hand end of a hairpin that is not followed immediately by another dynamic should 
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either be aligned with the left-hand side of the notehead at the rhythmic position 

where it ends, or should instead be aligned with the right-hand side of the 

notehead. 

In new projects, this option is set to Right side of note on main stem, but to avoid 

unexpected changes, it is set to Left side of note on main stem in existing projects. 

Holds and pauses 
Caesuras and multi-bar rests. A caesura that appears immediately before the barline 

– which is rhythmically positioned at the same position as the barline, and which 

shows an attachment line to the start of the following bar – no longer causes the bar 

in which it is drawn to be split from an ongoing multi-bar rest. 

Fermatas on barlines and multi-bar rests. Previously, a fermata rhythmically positioned 

at the start of a bar but set to appear on the following barline by way of the Attach to 

barline property would not cause the bar in which it is attached to be split from an 

ongoing multi-bar rest, but if it was positioned anywhere else in the bar, the multi-

bar rest would be split. Now, a fermata set to appear on the barline will not cause 

the bar in which it is attached to be split from an ongoing multi-bar rest, regardless 

of the fermata's actual rhythmic position within the bar. 

Note spacing 
Minimum length for ties. When spacing music, Dorico enforces a minimum length for 

ties between notes (and in some other situations), to ensure that ties are not drawn 

so short that they become hard to read. The options in the Length section of the Ties 

page of Engraving Options govern this behavior. 

Previously, Dorico would always enforce the specified minimum length for ties, 

even when the tied note crosses a barline. Typically, the gap between the last note 

or chord of the bar and the first note or chord in the following bar is sufficient that 

the minimum tie length is easily exceeded. However, the minimum length should 

still be applied for a tie immediately before the barline at the end of the system, as 

the tie will always stop short of the barline and could therefore appear too short. 

In new projects, Dorico no longer enforces the minimum length for a tie at the end 

of a bar, except at the end of the system, to reduce the spacing distortion that such 

ties can create. In existing projects, this improved behavior is disabled by default, to 

avoid unexpectedly changing the rhythmic spacing. To enable the new behavior, 

deactivate the new Enforce minimum length for ties before barline option in the 

Length section of the Ties page of Engraving Options. 

Mixer 
Editing values. It is now possible to edit numeric values in the Mixer using the keyboard: 

hold Alt and click on the value you want to edit, type the new value, and hit Return 
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to confirm. When editing gain for an output fader, you can type -inf or -oo to set the 

gain to negative infinity (silence). For pan, values can be in the range -100 to 100. 

MusicXML export 
Chord symbols. When exporting chord symbols, if the root alteration is zero, meaning 

that the root is a natural, the alteration is now omitted; this prevents some 

applications from showing an explicit natural sign for the root note. 

Guitar techniques. The export of hammer-ons, pull-offs and taps on grace notes has 

been improved. 

Playback 
Glissando playback. Dorico can now play continuous (pitch bend) glissandos to and from 

notes with microtonal pitches, if required. 

Trills and unmeasured tremolos. Since the introduction of playback of holds and pauses 

in Dorico 5.1, Dorico has also attempted to play generated trills and unmeasured 

tremolos in such a way that the repetition speed of the generated notes remains the 

same during the tempo changes used to play holds and pauses. 

If you would prefer Dorico to play trills and tremolos as it did previously, you can 

now deactivate the new option Play generated trills at constant speed during 

tempo changes on the Trills page of Playback Options, and the corresponding 

option for tremolos Play tremolos at constant speed during tempo changes on 

the Timing page. 

When playing back via NotePerformer, the behavior to play trills and tremolos at a 

constant speed during tempo changes is now always disabled, to avoid interfering 

with NotePerformer's own interpretation. 

When the playback options to play trills and unmeasured tremolos at a constant 

speed during tempo changes are enabled, the playback is now much improved. 

Playing techniques 
Bowing marks. A new option Placement of bowing marks relative to text or grouped 

playing techniques has been added to the Vertical Position section of the Playing 

Techniques page of Engraving Options. This allows you to determine whether 

bowing marks should go outside all other playing techniques, or (the default option) 

inside text-based and grouped playing techniques. 

A new Bowing marks checkbox has been added to Library ▶ Playing Techniques, 

allowing you to designate the edited playing technique as a bowing mark. These 

playing techniques will either be positioned inside or outside text-based and 

grouped playing techniques, according to the above option. 
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Slurs 
Flat slurs. The appearance of flat slurs has been improved. Previously, a flat slur would 

appear slightly thinner in the middle than at the shoulders; the slight bulge at the 

shoulders of the slur has now been removed. 

Staff labels 
Show staff labels on first flow only. In layouts for one or two instruments, some 

publishers like to show staff labels at the start of the first system of the first piece or 

movement, but not for any subsequent pieces or movements. Furthermore, they 

would want the first system of each subsequent piece or movement to be indented, 

in lieu of showing a staff label. 

To make this easier, two new options have been introduced, and both are found on 

the Staves and Systems page of Layout Options. Firstly, a new Show staff labels 

option allows you to choose between On all flows or On first flow only. Secondly, a 

new Apply indent when staff labels are shown option has been added below 

Indent first system of flow by n spaces, allowing you to specify that the indent for 

the first system should not be applied when staff labels are shown on the first 

system of the flow. 

Staff spacing 
Vertical spacing for organ instruments. Organ instruments with three staves show two 

braced staves, for the manuals, and a third, unbraced staff, for the pedals. The 

distance between all three staves has always been governed by the Braced staff to 

braced staff gap value on the Vertical Spacing page of Layout Options. This is 

inconvenient, because it makes it impossible to have a different default gap 

between the two braced staves and the unbraced pedal staff below them. 

In new projects, Dorico now uses a new Braced staff to unbraced staff gap value to 

determine the distance between the braced staves for the manuals and the 

unbraced staff for the pedals. 

In existing projects, the new gap is set to the value of the existing Braced staff to 

braced staff option, which avoids any unexpected changes. 

Time signatures 
Aggregate time signatures. Aggregate time signatures – which display two or more 

meters in the same bar, with dashed barlines showing the subdivisions between the 

meters – can now be consolidated into a single displayed time signature, if they 

share a common denominator. 

This can be enabled for all compatible aggregate time signatures in the project by 

activating the new option Combine aggregate time signatures with common 
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denominators in the Design section of the Time Signatures page of Engraving 

Options. This option can also be overridden for an individual time signature by 

activating the Combine compatible aggregates property in the Time Signatures 

group in the Properties panel. 

  



 

 

Dorico 5 Version History 17 Steinberg Media Technologies GmbH 

Issues resolved 
Component Issue 

Chord symbols Using Select More to select more chord symbols now works as expected if you have both a 

main and capo chord symbol selected. 

Chord symbols The horizontal position of a stack of main and capo chord symbols is now correct if set to be 

center-aligned. 

Engrave mode If you edit a paragraph style while editing a page template, the changes to the paragraph style 

are now reflected in the text frames in the template right away. 

Engrave mode It is now possible to drag lines with no drawn body in Engrave mode. 

Fingering It is now possible to correctly set and unset the Stopped finger position property for grace 

notes. 

Fingering The Slur-relative position property now appears as expected for fingerings for fretted 

instruments positioned outside the staff. 

Fingering The thumb indicator for left-hand fingering on fretted instruments is now drawn using the 

correct T symbol. 

Font styles Using the Move Up/Move Down buttons to re-order fonts in the Substitute fonts list in 

Library ▶ Font Styles could lead to corruption; this has now been fixed. 

Guitar tablature Changing the number of strings in a fretted instrument could cause the strings in tablature to 

become misaligned in galley view during note input and editing; this has now been fixed. 

Guitar tablature Under some circumstances, changing the options on the Players page of Layout Options to 

hide or show notation and tablature could result in bar rests appearing or disappearing 

incorrectly in the tablature; this has now been fixed. 

Harp pedals It is now possible to create a harp pedal change using the new Harp Pedals section of the 

Playing Techniques panel at the caret position. 

Instrument score 

orders 

Although every instrument type is expected to be found in every instrument score order, if for 

some reason an instrument is not found, it will now be positioned next to its parent, if it is 

based on another instrument type, rather than always being positioned at the very end of the 

list. 

Key Editor Using Increase Dynamic Intensity or Decrease Dynamic Intensity now correctly updates the 

display in the velocity editor right away. 

Live editing When auditioning dragged notes, any transposition defined in the expression map is now 

correctly applied. 
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Component Issue 

Localization The default shortcut for creating a MIDI trigger region in French has been corrected. 

Lyrics Under some circumstances, a lyric extender line at the start of the system for a lyric on the 

previous system could be drawn at the wrong vertical position relative to the staff; this has 

now been fixed. 

Lyrics The appearance of lyric slurs for East Asian lyrics has been improved, so that they appear 

suitably curved at a wider range of staff sizes. 

MusicXML export Slashed grace notes are now correctly exported to MusicXML. 

MusicXML export The text components of immediate and gradual tempo changes are now correctly exported to 

MusicXML once more. 

MusicXML export Under some circumstances, Dorico could export invalid MusicXML for lyrics; this has now 

been fixed. 

Navigation It is now possible to navigate to a hairpin starting at the same position as the selected note or 

chord with Tab, and to cycle the selection back to the note or chord by repeatedly pressing 

Tab. 

Note input If Jump over rests to next note only if closer than n quarters (crotchets) is activated, Dorico 

now correctly takes into account the duration of the note at the caret position when 

determining whether to leave Lock Duration mode. 

Note input Dorico once again shows a warning as expected when trying to create bars without first 

creating a time signature. 

Page layout Under rare circumstances, an edit to the first bar on the system would not cause Dorico to 

reconsider whether that bar could now fit on the previous system, resulting in the casting off 

changing unexpectedly later on when further edits have occurred; this has now been fixed. 

Percussion If a percussion legend has overridden text that consists only of whitespace, Dorico now 

correctly shows a signpost. 

Play mode When adding a new VST plug-in, by default its FX sends are now correctly disabled. 

Play mode Adding a new voice to a grand staff instrument now causes an extra track to appear right away 

in Play mode if independent voice playback is enabled. 

Playing techniques Under some circumstances, adjacent playing techniques that partially overlap could have an 

unstable vertical order; this has now been fixed. 

Project files Project files are no longer marked as dirty as soon as they are opened. 
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Component Issue 

Project files Under some circumstances, Dorico could crash when trying to retrieve information about 

stem connection points for noteheads; this has now been fixed. 

Project files Under some circumstances, Dorico could trigger auto-save in the middle of exporting audio, 

MIDI, or MusicXML files, which could result in the application freezing; this has now been 

fixed. 

Rehearsal marks Go To Rehearsal Mark and the Go To mode of the jump bar now handle rehearsal mark 

sequences where the first rehearsal mark in the flow has an overridden index. 

Slurs Slurs with overridden Curvature type properties now use the correct middle thickness value 

as specified in Engraving Options. 

Text The corner radius for text borders using the Round rectangle border style now appear 

consistently at different staff sizes. 

User interface The buttons in the Grace Notes section of the Timing page of Playback Options now work as 

expected. 

User interface It is now possible to add or remove individual items to or from the selection in the instrument 

families and instrument score order editors using Ctrl+click (Windows) or Command-click 

(macOS). 

User interface If the location where Dorico expects to position the popover is out of view – for example, above 

the top staff in the system when adding a time signature or barline – the popover is now 

moved so that it appears within the current view. 

Video Under rare circumstances, Dorico could crash when opening a project with an attached video; 

this has now been fixed. 
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Dorico 5.1.10 

14 January 2024 

Improvements 

Accidentals 
New View options. Two new options have been added to the View ▶ Note and Rest Colors 

submenu to highlight different kinds of accidentals in the music: 

§ Cautionary Accidentals causes accidentals that appear due to the options 

set on the Accidentals page of Notation Options to be displayed in pink. 

§ Forced Accidentals causes accidentals that appear due to the Accidental 

property being used to force the visibility of the accidental to be displayed in 

a blue-green color. 

You can change the colors using the corresponding new options found in the Other 

Colors section of the Colors page of Preferences. These new view options are useful 

for proof-reading. 

Brackets and braces 
Custom instruments. Dorico now allows adjacent players holding custom instruments 

that are variants of the same parent instrument, and which have identical full and 

short staff labels, and identical transpositions, to show sub-brackets. 

Chord diagrams 
Fingerings. Fingerings are now always displayed in Library ▶ Chord Diagrams. 

Chord symbols 
Scaling of parentheses. The Height of parentheses relative to height of chord symbol 

option in the Parentheses section of the Chord Symbols page of Engraving Options 

is now always applied, not only when Scale parentheses to height of chord symbol 

with linear arrangement is activated. 

Harp pedals 
Harp pedals editor. A new Harp Pedals section has been added to the Playing Techniques 

panel in Write mode, containing a simple editor for harp pedal changes. When you 

select a harp pedal change in the music area, you can use the new editor to change 

the pedals of the selected item. With nothing selected, you can instead set up the 

pedals for a new harp pedal change: when you click Create, the harp pedal diagram 

will either be created at the selected position, or (if your preferences allow) the 

mouse pointer will be loaded, allowing you to click in the music area to place the 

new harp pedal change. 
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Instrument editor 
Instrument families editor. You can now select and move multiple instruments in or out 

of a family at the same time. 

Instruments 
Default noteheads for crash cymbals. Crash cymbals now show regular noteheads when 

added as an individual percussion instrument, but still use cross noteheads as 

expected when they appear in a drum set. 

Jump bar 
Navigation to rehearsal mark in flow. In Go to mode, it is now possible to navigate to a 

specific rehearsal mark in a flow using fxry, where x is the flow number and y is the 

rehearsal mark letter or number. 

Library Manager 
Page sizes. Custom page sizes are now shown in the Library Manager, and can be 

imported into projects as needed. 

MusicXML export 
Pick-up bars. Pick-up bars are now exported correctly, with the appropriate prefix for 

their bar number. 

Bar rests. Bar rests are now more correctly encoded when exporting MusicXML. 

System-attached items. System-attached items, for example tempos, now correctly use 

the system attribute to differentiate them from staff-attached items. 

Slurs and ties. Style information for slurs and ties, in particular whether they are solid or 

dashed, is now exported to MusicXML. 

Notes. Stem information for notes is now exported more reliably, both for whole notes 

(breves) and longer that naturally show no stem, and for notes that normally show a 

stem but whose stems have been hidden. In addition, Dorico now exports notes 

whose size has been changed using the Scale or Custom scale properties as cue-

sized, grace note-sized, or cue grace note-sized. 

Lyric elisions. Lyrics with elisions are now exported correctly to MusicXML. 

MusicXML import 
Custom paragraph styles. A new Import font style information option has been added to 

the Other Notations section of the MusicXML Import page of Preferences, allowing 

you to specify whether Dorico should create new paragraph styles for text items it 

imports, to retain the specified font family, size, and formatting in the MusicXML 

file. 
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Note input 
Special barlines. Special barlines are now included when performing marquee 

selections, and when repeating selected material with R. 

Page sizes 
Page size editor. A new Library ▶ Page Sizes dialog has been added, allowing you to edit 

the preset page sizes shown in the Page Setup page of Layout Options and define 

your own. If you save changes as defaults to your user library, they will appear both 

in the Create New page of the Hub window, and in the Page Setup page of Layout 

Options for newly created projects. 

Playback 
Glissando playback. Keyboard and pitched percussion instruments now produce a white 

notes glissando by default. 

Playback techniques 
Used playback techniques. In Library ▶ Playback Techniques, Dorico now only allows 

you to delete user-defined playback techniques that are not referenced by playing 

techniques in your project. 

Staff labels 
Grouping for custom instruments. Dorico now allows grouped staff labels for adjacent 

players holding custom instruments that are variants of the same parent 

instrument, and which have identical full and short staff labels. 

Text export 
Open after export preference. A new option Open text CSV in default application after 

export has been added to the Files section of the General page of Preferences, 

allowing you to choose whether the exported CSV file should be opened in the 

default application for that file type on your system immediately after export. 

User interface 
Staff size in Layout Options. The read-out of the staff size in the Page Setup page of 

Layout Options is now always shown to a precision of two decimal places. 
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Issues resolved 
Component Issue 

Accidentals Under rare circumstances, Dorico could show an unnecessary cautionary accidental for a 

note in a different octave in the following bar if the note that introduces the accidental at the 

original octave was in a different voice; this has now been fixed. 

Audio export When using sample rates higher than 88.2kHz, the first notes in an exported audio track 

would have incorrect note positions; this has now been fixed. 

Bar numbers In some circumstances, irregular bars could be numbered incorrectly, so that the bar count 

does not increment correctly; this has now been fixed. 

Bar repeats Bar repeat regions appear correctly in condensed staves once more. 

Brackets and 

braces 

Under some circumstances, sub-brackets for condensed staves would not always appear in 

systems where staves are hidden; this has now been fixed. 

Chord symbols When activating the Hidden property for chord symbols, any displayed chord diagram is now 

correctly and immediately hidden. 

Condensing Under certain circumstances, when condensing section players where some but not all divisi 

staves can be condensed, Dorico could end up showing a multi-bar rest and hiding music on 

one or more of the divisi staves; this has now been fixed. 

Condensing Under some circumstances, creating new custom condensing groups would not cause time 

signatures to appear on the new condensed staves until the project was reopened; this has 

now been fixed. 

Cues Highlights to show suggested cue locations now appear on the correct staff in projects with 

divisi staves or condensing enabled. 

Dynamics Splitting a flow in the middle of a dynamic group now works more reliably, and properties set 

on the dynamic group are now retained. 

Fingering It is now possible to add left- and right-hand fingering for user-defined fretted instruments, 

as it should be. 

Instrument editor Instrument families are now listed in the same order as the prevailing instrument score order 

in Library ▶ Instrument Families. 

Instrument editor Changing the families in which an existing instrument in the project appears now 

immediately updates its position in the score order, provided a score order is set for the 

project. 

Instrument editor If a single variant instrument is shown in an instrument family in the score order editor, it 

would sometimes appear without its variant description; this has now been fixed. 
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Component Issue 

Instrument editor Editing an instrument's family now always updates its bracketing in the current project 

immediately. 

Instrument editor The Jazz instrument score order has been revised to fix some errors that had crept in. 

Instrument editor Dorico no longer unnecessarily writes the user library when confirming the Library ▶ 

Instrument Families dialog if no changes need to be saved. 

Instrument editor It is now possible to make a project-local change to an instrument family that is saved in the 

user library, without also unexpectedly updating the family in the user library. 

Instrument editor Under some circumstances, a custom instrument family could appear in the families list in 

Library ▶ Instrument Score Orders, even though no instruments from that family appear 

there in the order; now, empty families are correctly filtered out. 

Instrument editor Creating a new instrument or variant based on a factory default instrument that has been 

moved to another instrument family no longer causes a crash. 

Instrument editor Deleting a user-defined instrument now also removes references to it from the instrument 

families and instrument score orders in which it appears. 

Live editing Under some circumstances, dragging notes from a percussion staff to a pitched staff would be 

incorrectly disallowed; this has now been fixed. 

Live editing Dragging tuplets containing a mixture of notes and rests now works correctly, regardless of 

whether you are dragging a note or a rest. 

Live editing Under some circumstances, dragging notes could result in a crash in layouts where multi-bar 

rests are shown; this has now been fixed. 

Live editing When auditioning dragged notes, instrument transposition is now correctly taken into 

account. 

Lyrics Under some circumstances, Dorico could show a verse number before a lyric extender line at 

the start of the system; this has now been fixed. 

Lyrics The positioning of lyrics on percussion kit and grid staves is correct once more. 

Lyrics Setting properties on lyrics on percussion kit and grid staves now works more reliably. 

Lyrics Pasting East Asian language lyrics into the Shift+L popover no longer causes the lyric to be 

pasted twice. 

MusicXML export Rehearsal marks are correctly exported to MusicXML once more. 
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Component Issue 

Note input The Toggle MIDI Input and Toggle MIDI Thru commands now work reliably in all 

circumstances. 

Note input The focus is now automatically returned to the music area after creating an item via a 

popover, allowing you to navigate with Tab right away. 

Note input When setting a flat, natural, or sharp accidental on a selected note when using a custom 

tonality system, Dorico would sometimes fail to choose an appropriate accidental if the 

default music symbol was not used; now it will choose the first accidental that provides the 

required pitch delta. 

Percussion The read-out of the percussion instrument and playing technique for selected notes now 

appears correctly once more. 

Playback When activating an existing project for playback for the first time, the appropriate space 

template settings were not correctly applied; this has now been fixed. 

Playback Dorico Elements will now correctly show playback templates that use HALion Symphonic 

Orchestra if you have a dedicated license for that library. 

Playback Fermatas following metric modulations now always play with the correct duration. 

Playback Under certain circumstances, gaps following fermatas at fast tempos could result in the 

wrong, very fast tempo being used following the fermata; this has now been fixed. 

Play mode When changing playback template, the list of presets displayed in the Routing section of the 

Track Inspector panel now updates immediately (Dorico for iPad only). 

Play mode Applying a playback template now correctly updates the state of the port and channel spin 

boxes in the Routing section of the Track Inspector. 

Play mode Changing the expression or percussion map in the Routing section of the Track Inspector now 

immediately refreshes playback. 

Print mode For projects with one or more pages of front matter before the first page of music, Dorico 

could crash when attempting to export separate PDFs for each flow; this has now been fixed. 

Project files The Dorico Projects folder in the default save location was not always created correctly when 

running Dorico for the first time; this has now been fixed (macOS only). 

Project files When opening existing projects, Dorico now sets the Default Music Text Font font style to 

have no parent if it finds that it has one set. 

Project files Under some circumstances, Dorico could crash when opening projects due to a problem with 

calculating fermata playback; this has now been fixed. 
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Component Issue 

Scrub playback Dorico now more reliably determines the chosen microtonal playback method from the 

current expression map. 

Text Paragraph styles that use a Bold Italic weight now appear correctly. 

Text When applying Markdown formatting to text tokens, Dorico now more reliably combines 

existing formatting in the text item with the Markdown formatting. 

Text export When exporting text from the project, multi-line text items are now always exported with 

spaces replacing line breaks. 

Text export Staff- and system-attached text are now correctly classified when exporting text. 

User interface The system track now shows the rhythmic grid for the whole duration of an open meter bar at 

the end of a flow in galley view. 

User interface The list of music fonts on the Create New page of the Hub is now correctly alphabetically 

sorted. 

User interface The contrast between the foreground and background of the Follow playhead switch on the 

status bar when using the light theme has been improved. 

User interface The state of the hand/marquee tools in the status bar now always correctly matches the 

corresponding preference when opening an existing project. 

User interface The button to show or hide the tab bar is now correctly disabled when the page template or 

flow heading editor is open. 

User interface Under some circumstances, opening the flow heading editor when the page template editor is 

open could cause the page template editor to be unexpectedly reopened when switching to 

another layout; this has now been fixed. 

User interface The suggested default path provided for exporting expression and percussion maps from their 

respective dialogs is now more sensible. 
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Dorico 5.1 

13 December 2023 

New features 

Iconica Sketch 
Iconica Sketch is a complete orchestra with 34 different instruments and 140 

articulations in an exceptionally intuitive interface — optimized in file size and CPU 

performance. The original recordings from Iconica have been carefully selected 

and remastered to deliver a well-balanced, high-quality orchestral experience. 

The following instruments are included in the library: 

§ Woodwinds: Piccolo, Flute 1, Flute 2, Clarinet 1, Clarinet 2, Bass Clarinet, 

Oboe 1, Oboe 2, English Horn, Bassoon 1, Bassoon 2, Contra Bassoon 

§ Brass: Trumpet (solo), Trumpets (ensemble), Horn (solo), Horns (ensemble), 

Euphonium, Trombone (solo), Trombones (ensemble), Tuba 

§ Pitched percussion: Harp, Celesta, Timpani, Tubular Bells, Marimba, 

Vibraphone, Glockenspiel, Xylophone 

§ Unpitched percussion: Percussion Map, including gran cassa, snare, toms, 

piatti cymbals, tam tam, tambourine, triangle, cowbells, congas, vibraslap, 

bongos, castanets, wood blocks, bell tree, chimes 

§ Strings: Violins I, Violins II, Violas, Celli, Basses 

Each instrument section provides a consistent set of playing techniques: 

§ Woodwinds: legato, staccato, marcato, sustain, sustain vibrato 

§ Brass: legato, staccato, marcato, sustain, sustain vibrato 

§ Strings: legato, staccato, pizzicato, piccato, sustain, legato, tremolo, sustain 

vibrato 

§ Unpitched percussion: hit, roll (for most instruments) 

To use Iconica Sketch in Dorico 5.1, choose one of the factory playback templates 

that include Iconica Sketch in its name. 

Default playback template. When Dorico detects that new sound content that is handled 

by one of its factory playback templates has been installed, it will now show a simple 

dialog when you next start the application, allowing you to update your chosen 

default playback template to make use of the new sounds. 

For example, when you first run Dorico 5.1 after installing the new Iconica Sketch 

sounds, Dorico will show the dialog and offer to set the best available factory 

playback template that includes Iconica Sketch. If Groove Agent SE is installed, it 
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will also allow you to choose whether to use a default playback template that uses 

Groove Agent SE for drum set instruments. 

The dialog will also appear if Dorico detects that NotePerformer has been installed, 

allowing you to easily choose the NotePerformer playback template by default. 

You can review and change the default playback template on the Play page of 

Preferences at any time. 

Changing the default playback template does not affect the choice of playback 

template in existing projects: if you want to use, say, Iconica Sketch in an existing 

project, open the project, then choose Play ▶ Playback Template, select the 

playback template you want to use, then click Apply and Close. 

Example projects. Three example projects are included that show off the capabilities of 

Iconica Sketch. Find them in /Users/Shared/Dorico Example Projects on macOS 

and in %PUBLIC%\Documents\Dorico Example Projects on Windows. 

Instrument families editor 
Building on the new instrument editor introduced in Dorico 5.0, Dorico 5.1 

introduces an editor for instrument families, allowing you to move instruments 

between existing families, and create your own, either for the purposes of a single 

project or to create new default families for all future projects. 

To get started, choose Library ▶ Instrument Families. This dialog appears: 
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On the left-hand side of the dialog, the instrument families in the current project 

are shown. The familiar action bar at the bottom of the list allows you to create a 

new empty family, or a new family based on the currently-selected family. From 

right to left, the buttons at the right-hand end of the action bar allow you to: delete 

the selected family, if it is a user-defined one; revert the selected family back to its 

factory state, if it is a default one; and to save the current state of the selected family 

to the user library, so that it will be available in other projects. When the star icon is 

filled, the selected family is saved in the user library, and when it is an outline, the 

selected family is not saved in the user library. 

The list in the middle of the dialog shows the instruments in the current family, in 

alphabetical order. The order in which instruments appear in the score is defined 

separately, since different ensembles and types of music have different 

conventions for how instruments should be ordered. 

The list on the right-hand side of the dialog shows all of the instruments that are not 

in the current family. Instruments can appear in multiple families if necessary. To 

add instruments to the current family, select them in the Instruments not in 

selected family list and click Add instrument to family in the action bar. 

Likewise, to remove one or more instruments from the selected family, select them 

in the central list and click Remove instrument from family. 

Instrument score order editor 
In addition to the new editor for instrument families, Dorico 5.1 also now introduces 

an editor for instrument score orders, allowing you both to edit the factory-

supplied score orders, and create your own. 

To get started, choose Library ▶ Instrument Score Orders. This dialog appears: 
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The list on the left-hand side shows the instrument score orders in the current 

project. You can create a new score order by selecting an existing score order and 

clicking the New from Selection button in the action bar. 

For each of the Families, Instruments, and Variants columns, you can select an item 

and click Move Up or Move Down to move the selection in the overall score order. 

Moving, for example, a selected family down in the list will move all of the 

instruments in that family below all of the instruments in the family that now 

appears above it in the list. 

To save a new instrument score order as a default that will be available in new 

projects, click the star button. When the star icon is filled, the selected score order is 

saved in the user library, and when it is an outline, the selected score order is not 

saved in the user library. 

Instrument score order selector. A new selector has been added to the status bar in Setup 

mode, allowing you to see at a glance which instrument score order is currently in 

force. (This does not appear in Dorico for iPad.) 

Applying an instrument score order. When you choose an instrument score order, either 

via the long-press button in the action bar in the Players panel or via the new 

selector in the status bar, Dorico now immediately sorts the players according to 

the newly chosen score order. 

Manually ordering players. When you manually reorder players in the Players panel, 

Dorico now automatically sets the instrument score order to None, so that 

subsequent operations in the Players panel, such as adding or deleting players, 

don't undo the manual changes by re-applying the current instrument score order. 

Jazz instrument score order. A new Jazz instrument score order has been added, with 

thanks to Todd Bashore. The order is essentially: woodwind, brass (with trumpets 

above horns), vocals, pitched percussion, guitars, keyboard instruments, bass (bass 

guitars, upright bass, string bass), drums, other unpitched percussion, harp, strings, 

sketch instruments. 

Orchestral instrument score order. The orchestral score order has been improved, with 

particular attention paid to percussion instruments, which now follow more closely 

the recommendations in Kurt Stone’s book Music Notation in the 20th Century. 

Polyphonic voice balancing 
Building on the pitch contour emphasis algorithm introduced in Dorico 5.0, this 

update introduces sophisticated algorithms that aim to improve the relative 

balance of voices in music written for polyphonic instruments such as piano, guitar, 

harp, and mallet percussion. When performing, human musicians always try to 
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bring out the melody, with the bass being given almost as much emphasis, and 

accompaniment textures being given the least emphasis. By contrast, when 

software plays back music that was not originally performed by a human musician, 

each voice is given equal emphasis, which can sound unmusical. 

Dorico 5.1’s new polyphonic voice balancing features produce human-like 

interpretation of polyphonic textures. To avoid changing the playback of existing 

projects, these features are disabled by default when opening an existing project, 

and enabled by default for newly-created projects. To enable them, activate Use 

automatic polyphonic voice balancing on the Dynamics page of Playback Options. 

Optionally, Dorico can also attempt to identify contrapuntal themes in the music, 

and can then emphasize these during playback, regardless of the voice in which 

they appear. This is especially useful for fugues, but may also produce pleasing 

results in other contrapuntal music with shared thematic material. This option is 

disabled both in existing projects and in newly created ones: to enable it, activate 

Use rules for contrapuntal music on the Dynamics page of Playback Options. 

Example projects. We have included two example projects that show off the polyphonic 

voice balancing (Liszt’s Liebesträume) and contrapuntal theme identification (Fugue 

16 from the first book of The Well-tempered Clavier by J.S. Bach). Find them in 

/Users/Shared/Dorico Example Projects on macOS and 

in %PUBLIC%\Documents\Dorico Example Projects on Windows. 

Text export 
Publishers often need to be able to extract textual information from projects, to 

populate catalogue databases or simply to be able to review the text that appears in 

the project for the purposes of proof-reading and correction. Dorico can now 

generate a comma separated values (CSV) file from the project, extracting all the 

visible text, including: 

§ Values from File ▶ Project Info, both for the overall project and for each flow 

§ Text frames on each page 

§ Staff-attached and system-attached text 

§ Lyrics 

§ Immediate and gradual tempo instructions 

§ Playing techniques 

§ Dynamics 

§ Rehearsal marks 

§ Markers 

§ Comments 
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To export text from the current project, choose File ▶ Export ▶ Text. You will be 

prompted to specify the filename for the resulting CSV file. Once saved, Dorico will 

attempt to open the exported file using the default application associated with CSV 

files on your system. 

Project statistics 
Professional music copyists are sometimes required to calculate the number of 

frames they have copied to calculate their fee for a job. In this context, a frame is a 

bar in a staff, so a short chamber piece of 80 bars for 5 instruments would have 400 

frames. It may also be necessary to differentiate between frames with music in, and 

empty frames containing only bar rests, as in some union pay scales these can be 

charged at different rates. 

Dorico now provides an easy way to gather the number of frames in your project, 

along with many other handy statistics, via the new File ▶ Project Statistics dialog. 
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The dialog shows a few key statistics about the full score layout in the project, if one 

exists; if no full score layout exists, Dorico will calculate statistics based on the 

layout you are currently viewing. By default, combined statistics for all flows in the 

project are shown, but you can choose any of the flows in the project from the Show 

statistics for drop-down menu to view statistics for only one flow. 

If you need to work with this information in another application, click Export to 

export all the statistics to a plain text file. Each category of data and its 

corresponding value is separated with a tab stop, so the resulting file can be easily 

imported into a spreadsheet application. 

History dialog 
A new Edit ▶ History dialog has been added, allowing you to undo or redo to any 

point in the history. The edits listed in the History dialog use the same names that 

are used directly in the Edit menu for the Undo and Redo menu items. 

 

Depending on the size of your project and the speed of your computer, you may see 

the intervening edits carried out when you undo or redo by many steps. Dorico 

needs to carry out each edit in turn to ensure that the correct history is always 

maintained. 
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Improvements 

Accidentals 
Accidentals and unshortened ledger lines. By default, Dorico shortens ledger lines on the 

left-hand side of notes to allow accidentals to tuck in more closely to the notes 

without colliding. If you choose not to shorten ledger lines, Dorico uses the values 

defined in the Gaps section of the Accidentals page of Engraving Options to 

determine the distance between the rightmost accidental and the ledger line. These 

options are used for the staff position at which the accidental appears, and the 

adjacent positions directly above and below. 

However, a sharp on the top or bottom line of the staff may come too close to the 

first ledger line outside the staff, so to allow Dorico to give a sharp a little more 

breathing room, a new option Use gap for rightmost sharp if to left of adjacent 

unshortened ledger line has been added. This is activated by default in new 

projects but deactivated in existing projects to maintain their current appearance. 

Audio engine 
Error recovery. If Dorico’s audio engine crashes or hangs during start-up, Dorico now 

shows a message and quits. It also creates a diagnostic report on your computer's 

desktop, suitable for attaching to a ticket to your local support team, or posting on 

the Dorico forum. 

Similarly, if the audio engine takes an unusually long time to initialize when Dorico 

starts up, it will now show a message informing you of that fact, and offering to 

terminate the audio engine if necessary. Alternatively, it may be that a VST plug-in 

being scanned by the audio engine is showing a message box or dialog that requires 

user input. If you choose to terminate the audio engine, Dorico will force it to quit, 

then exit, again creating a diagnostic report on the desktop. 

Steinberg built-in ASIO Driver. On Windows, Dorico now includes a new default ASIO 

driver, the Steinberg built-in ASIO Driver. This new ASIO driver does not try to take 

exclusive ownership of the audio device in your computer, so it should always be 

possible to both play back in Dorico and hear audio from other applications at the 

same time. 

Initial time signature. For plug-ins that rely on knowledge of the time signature, Dorico 

now transmits the initial time signature to VST instruments as well as the initial 

tempo. Only the initial time signature and tempo are transmitted: changes of time 

signature and tempo will be supported in a future version. 

Bar numbers 
Avoiding collisions. In instrumental parts for commercial music and recording sessions, 

it’s common to show bar numbers on every bar, and to position bar numbers 
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immediately above or below each barline, typically using a narrow font at a 

relatively small staff size. It’s desirable for such bar numbers to tuck in as close as 

possible to the barline. By default, Dorico will move bar numbers outside 

obstructions coming from the staff, such as ties or slurs that cross above or below 

the staff. If you would prefer Dorico never to move bar numbers by default, so that 

you can manually adjust the specific bar numbers you think need to be 

repositioned, deactivate the new Avoid collisions option on the Bar Numbers page 

of Layout Options. 

Brackets and braces 
Brace position. From the department of vanishingly small minutiae, when determining 

the precise position and size of the brace glyph for a grand staff instrument, Dorico 

now considers the thickness of the top and bottom staff lines. This makes a small 

but perceptible difference to the size and placement of the brace relative to the 

staff. 

Chord diagrams 
Exclude from chords used frame. A new property Exclude from chords used at start of 

flow has been added to the Chord Symbols group in the Properties panel; activate 

this if you want the chord diagram associated with that chord symbol not to appear 

in the grid of chord diagrams shown at the start of the flow, if present. 

Clefs 
Positioning on irregular staves. Clefs are now correctly positioned on staves with more or 

fewer than five staff lines. Pitched staves in Dorico are always built upwards from 

the bottom staff line, so if you have a pitched instrument with a 1-line staff, the 

single staff line that appears is the bottom line of the staff; i.e. if you have a treble G 

clef, the pitch of a note on that single staff line would be E4, or if you have a bass F 

clef, the pitch of a note on that single staff line would be G2. 

Cues 
Clefs for cues starting at barlines. A new option Position of clef at start of cue coincident 

with barline has been added to the Clefs section of the Cues page of Engraving 

Options. This allows you to specify that a cue starting at a barline position that 

requires a clef change should have its clef positioned to the left of the barline rather 

than to the right, as some publishers prefer. 

Rhythmic cues. It is now possible to use rhythmic slashes instead of regular noteheads in 

rhythmic cues. This can be set as a default for the project and overridden for an 

individual cue using the Properties panel. A new Use rhythmic slashes option has 

been added to the Rhythmic Cues section of the Cues page of Engraving Options, 

where you can also choose what type of slashes should be used for rhythmic cues.  
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To override this setting for an individual cue, select the cue label and activate the 

Use rhythmic slashes property to specify whether a rhythmic cue should be 

displayed using slashes, or set Slash appearance to use a different slash 

appearance for that cue. 

It is also now possible to move rhythmic cues into the staff if desired, by setting the 

Distance property to a negative value. 

Divisi 
Divisi labels. A new option Snap divisi unison labels to notes option has been added to 

the Staff Labels section of the Staves and Systems page of Layout Options. When 

activated, Dorico will snap the unis. labels for a return to unison after a divisi 

passage to the first note in the unison passage, if the return to unison occurs at a 

rest. This option is switched on in new projects but switched off in existing projects 

to preserve their appearance. 

Horizontal position. A new Default horizontal offset option has been added to the Divisi 

Change Labels section of the Divisi page of Engraving Options, allowing divisi labels 

to be positioned slightly to the left of the entry to which they apply, if desired. 

Erase background. A new Erase background with padding option has been added to the 

Divisi Change Labels section of the Divisi page of Engraving Options, allowing you 

to specify that Dorico should erase the background behind divisi labels. 

Unison ranges. The way that ranges of unison music on systems where staves transition 

to or from divisi has been completely reworked, which will allow us to fix a number 

of long-standing problems concerning the appearance of music at and around 

these transitions, including the appearance (or occasional non-appearance) of time 

and key signatures, problems with accidental calculation, and spacing. 

Dynamics 
Hyphenated text gradual dynamics. A new option Position of final syllable has been 

added to the Hyphenated Text section of the Gradual Dynamics section of the 

Dynamics page of Engraving Options, allowing you to specify whether a gradual 

dynamic shown as hyphenated text, for example cresc-en-do, should end with its 

final syllable, or should show a dashed or dotted line after the final syllable. 

By default, in new projects, the gradual dynamic now ends with its final syllable. 

However, if a gradual dynamic is followed immediately by an immediate dynamic, 

you may find it preferable for that gradual dynamic to end with a dashed or dotted 

line to provide some separation between the final syllable do and the immediate 

dynamic. If so, you can override this engraving option using the new Final syllable 

at end of line property in the Dynamics group in the Properties panel. 
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A further new option, Hyphenated line vertical position, can be found in the 

Advanced Options section. This allows you to choose whether the line joining the 

syllables for this dynamic should be positioned at the text baseline, or at half the 

text x-height (where a hyphen would typically appear). By default, in new projects, 

this new option is set to Half x-height. 

Finally, two new options, Hyphenation for diminuendo and Hyphenation for 

decrescendo, have been added to the Advanced Options section, allowing you to 

choose between two different ways of hyphenating these words. 

Text with lines gradual dynamics. Two new options have been added to the Advanced 

Options section of the Text with Lines section of the Gradual Dynamics section of 

the Dynamics page of Engraving Options. Abbreviation for diminuendo and 

Abbreviation for decrescendo allow you to choose between two alternatives for the 

abbreviation for each of these dynamics, which are used when the Abbreviate 

property is activated. 

Mouse editing. When dragging dynamics in Write mode with the mouse, the positions 

that the dynamics will snap to are now consistent with the positions at which the 

dynamics can appear when moving them via the Alt+←/→ shortcuts. 

Engrave mode 
Nudging slurs. In previous versions of Dorico, dragging slurs with the mouse always 

constrained their movement to the vertical dimension, and it was necessary to hold 

the Alt key to drag them horizontally. This meant that it was not possible to nudge 

slurs horizontally using the standard key commands of Alt with the arrow keys. 

Now things are different: it is now possible to drag slurs in any direction with the 

mouse, though you can hold Shift after you have started dragging to constrain the 

movement to either the vertical or horizontal dimension, as with other items. This 

also means that it is now possible to nudge a selected slur by holding Alt and using 

the arrow keys. 

Frame dimensions. When a single frame is selected in Engrave mode, the dimensions of 

the frame are now shown in the status bar. 

Fingering 
Substitution positioning. A new option Alignment of fingering substitution relative to 

note has been added to the Position section of the Fingering page of Engraving 

Options, allowing you to choose whether immediate substitutions should be left- or 

center-aligned with the notehead. 
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Fonts 
Nepomuk. The included version of Nepomuk has been updated, with improvements to 

the bold weights and the appearance of some eastern European characters. 

Graphics export 
Transparent background. When exporting graphics in TIFF or PNG format, you can now 

choose whether to export with a transparent background (the previous default), or 

whether to use a white background. This option can be found both in the Graphic 

Slices panel in Engrave mode (Dorico Pro only), and in the right-hand options panel 

in Print mode. 

Harp pedals 
Border and padding. A new option has been added to the Harp Pedals page of Engraving 

Options allowing you to choose whether pedal changes shown using note names 

should use the border thickness and padding settings from Engraving Options, or 

instead from the Harp Pedal Settings paragraph style. The advantage of using the 

paragraph style is that it allows you to adjust the border independently on each side, 

which may be necessary for some font families. 

Instrument editor 
Families. A new Edit Families button has been added to the instrument editor, allowing 

you to choose to which families the instrument being edited should belong. 

Instrument score orders. New instruments created in the instrument editor are now 

automatically added to the instrument score orders present in the project. 

Percussion playing techniques. It is now possible to edit the percussion playing 

techniques of an individual percussion instrument via the instrument editor. 

Jump bar 
Opening directly in either mode. Two new commands have been added to the UI category 

on the Key Commands page of Preferences: Show Jump Bar in Commands Mode 

will show the jump bar and ensure it opens in commands mode, while Show Jump 

Bar in Goto Mode will show the jump bar and ensure it opens in goto mode. This 

allows you to assign a separate key command to open the jump bar in either mode if 

you wish. 

Key Editor 
Lock Played Durations. A new Lock Played Durations button has been added to the Key 

Editor toolbar. This button appears only when the piano roll is displaying notated 

durations. With this new tool enabled, edits you make to the position or duration of 

a note in the piano roll will not affect the played position and duration of that note. 

This allows you to manually quantize the displayed notation while retaining the 
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precise nuance of the notes if they were recorded in real time or created via MIDI 

import. 

Default duration display. A new Default piano roll display option has been added to the 

General page of Preferences, allowing you to specify whether the piano roll should 

use Played Durations or Notated Durations by default. 

Double-clicking in the ruler. If Dorico is playing back, double-clicking in the ruler will now 

stop playback. 

Key signatures 
Cautionary key signatures. A new option Cautionary key signature at end of system has 

been added to the Key Signatures page of Notation Options, allowing you to specify 

that Dorico should hide the cautionary key signature that appears at the end of the 

system for a key change that occurs at a system boundary. This can also be 

overridden for a selected key signature via the new Cautionary at end of system 

property in the Key Signatures group in the Properties panel. 

Appearance on irregular staves. Key signatures will now draw on staves with more or 

fewer than five staff lines. There are no options to control at which staff position a 

specific accidental will appear if multiple positions within the staff are possible. 

Lines 
Vertical lines. When placing vertical lines in the staff, for example when using lines with 

hooks at the top or bottom to indicate which notes on one staff of a grand staff 

instrument that should be played by the other hand, it may sometimes be desirable 

for those lines to have no impact on horizontal spacing. It is now possible to specify 

that a vertical line should play no part in rhythmic spacing by deactivating Avoid 

collisions in Library ▶ Lines. This can also be overridden for an individual line by 

setting the new Avoid collisions property in the Lines group in the Properties panel. 

Live editing 
Chromatic pitch dragging. You can now edit the pitches of selected notes chromatically 

by holding down Shift after you begin dragging them vertically. 

Dragging rests. When selecting a mixture of notes and rests, you can now drag the 

selection vertically or horizontally by dragging one of the selected rests, instead of 

only being able to drag notes. 

Lyrics 
Lyric-hyphen gaps. It is now possible to override the default gap between lyrics and 

hyphens, and the gaps between hyphens, using two new Engrave mode properties 

in the Lyrics group of the Properties panel. Gap between lyrics and hyphens is an 
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override for the Minimum gap between lyric and hyphen engraving option, while 

Gap between hyphens overrides the similarly named engraving option. 

Verse numbers. A new option Paragraph style to use for verse number has been added 

to the Verse Numbers section of the Lyrics page of Engraving Options, allowing you 

to choose whether verse numbers should use their own dedicated paragraph style, 

or instead use the same paragraph style as the following lyric. 

Smart quotes. Dorico now correctly handles smart quotes in Spanish, where punctuation 

such as commas and periods (full stops) are positioned after the closing quotation 

marks. 

Korean IME support. When entering lyrics using the Korean Input Method Editor (IME) 

on macOS, it is now possible to simply press Space to advance the popover to the 

next note or chord. 

When inputting lyrics in Korean, Dorico now enters Japanese-style lyric hyphens 

when you advance the caret with Space during input. These lyric hyphens are also 

now center-aligned with the front notehead of the main stem of the note below or 

above which they appear. 

Mixer 
Apply default output level. A new command Play ▶ Apply Default Output Level has been 

added, allowing you to reset the faders for plug-in outputs and the master output in 

the Mixer to the Default output level value specified on the Play page of 

Preferences. 

MusicXML export 
New additions. MusicXML export has been greatly expanded in Dorico 5.1, with the 

following all now included when exporting: 

§ Arpeggio signs and non-arpeggio signs 

§ Holds and pauses including fermatas, caesuras, and breath marks. 

§ Laissez vibrer ties 

§ Multi-bar rests 

§ Staff- and system-attached text items 

§ Trills (including trills over multiple notes, showing different accidentals 

along their length) and ornaments 

§ Glissando lines and slides 

§ Playing techniques (including bowing marks, natural harmonics, double- 

and triple-tongue, snap pizzicato, organ heel/toe, fingernails on harp, 

mute/half-open/open, brass bends, flips, smears, and more) 

§ Guitar techniques (including bends, pre-bends, hammer-ons, pull-offs, 

taps, left-hand taps, vibrato bar dips, and vibrato bar scoops) 
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§ Page-attached text (title, composer, copyright, etc.) 

§ System and staff formatting 

Vertical position. Dorico now exports vertical positioning information for a number of 

items: 

§ Dynamics. 

§ Lyrics. 

§ Octave lines. 

Barlines. If Dorico shows a double barline at a change of key signature, that is now 

reflected in MusicXML export. 

Tuplets. When exporting tuplets to MusicXML, Dorico now includes information about 

whether the bracket/number is visible. 

Octave lines. Voice-specific octave lines are now exported via MusicXML. 

Slurs. Slurs that start in one voice and end in another (for example, in cross-staff 

notation) are now exported to MusicXML. Dorico now also exports the curvature 

direction for both slurs and ties. 

Chord symbols. The encoding of some chord symbol qualities, for example 7sus4 and 

m(b5), has been tweaked to improve interoperability with other applications, for 

example, Finale. 

Instrument sounds. Dorico now includes the appropriate MusicXML sound ID for each 

instrument part when exporting MusicXML. 

MusicXML import 
Non-arpeggio signs. Non-arpeggio signs are now imported from MusicXML files. 

Arpeggio signs. A new option Ambiguous arpeggio signs span all staves has been added 

to the MusicXML import page of Preferences, allowing you to specify that Dorico 

should create arpeggio lines across all staves of a multi-staff instrument if the 

MusicXML file does not correctly specify its extent. 

Note input and editing 
Select to start of system and flow. Two new commands, Edit ▶ Select to Start of System 

and Edit ▶ Select to Start of Flow, have been added. 

Toggle MIDI Thru. A new command Toggle MIDI Thru has been added to the Note 

Input category in the Key Commands page of Preferences. You can assign a key 

command, or use the jump bar, to use this command to toggle the Enable MIDI 

thru option on the Play page of Preferences. 
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Octave lines 
Dashed line alignment. Two new options have been added to the Advanced Options 

section of the Appearance section of the Octave Lines page of Engraving Options, 

allowing you to adjust the precise vertical position of the dashed or dotted line that 

follows the symbol at the beginning of an octave line, both on the first system and 

following a continuation symbol on a subsequent system. In new projects, these 

new options have been set to provide a better appearance for octave lines by 

default, but they are not set for existing projects to maintain their appearance. 

Percussion 
Grace notes. Because of the unique way percussion kit notation works in Dorico, with the 

notation from individual instruments brought together in the five-line staff 

presentation type, it has always been impossible to show a run of grace notes 

spanning multiple instruments in the kit: all of the grace notes will appear as a 

chord. You can now select a grace note in the five-line staff presentation type and 

use Alt+←/→ to move it visually so that you can create the desired run. 

Importing and exporting percussion maps. When exporting a percussion map via Library 

▶ Percussion Maps, Dorico will now include any user-defined instruments and 

playback techniques in the exported library file, so that the percussion map can be 

fully usefully employed in another project. 

Playback 
Holds and pauses. Fermatas, caesuras, and breath marks all now influence playback. 

Playback of holds and pauses works by automatically manipulating the tempo 

during playback to achieve the required prolongation of the held note, and likewise 

manipulates the played lengths of the affected notes to allow a gap, if required, 

before the normal tempo resumes. 

For fermatas, options to control the default amount by which the written duration 

should be extended and the length of the gap for each type of fermata from short to 

very long are found on the Timing page of Playback Options, and these can also be 

overridden on a per-fermata basis via the new Hold duration and Gap duration 

properties in the Holds and Pauses group in the Properties panel. 

A new Hold only property has also been added for fermatas, making it easier to 

specify that a fermata should only extend the duration of notes, and not create a 

silence before the next note. 

Caesuras do not extend the duration of the notes at that position: instead, they 

simply insert a gap. By default, a caesura produces a gap of 50% the beat duration of 

the bar in which it occurs. This can be adjusted by way of the Gap duration property. 
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When editing caesuras in the tempo editor in the Key Editor, note that only the 

second point in the region can be edited; dragging this down increases the duration 

of the gap, while dragging it up decreases the duration of the gap. 

Like caesuras, breath marks do not extend the duration of notes; indeed, breath 

marks do not insert any musical time, instead only shortening the durations of the 

notes that precede them, by default using a value of 50% of the beat duration. To 

edit the effect of an individual breath mark, simply adjust the played duration of the 

notes immediately preceding the breath mark in the piano roll. 

The playback of holds and pauses can be disabled altogether by deactivating the 

Play back pauses option on the Timing page of Playback Options. Individual holds 

and pauses also respond to the Suppress playback and Suppress on passes 

properties. 

Glissandos. Dorico can now use MIDI pitch bend to play back continuous glissandos, 

depending on the capabilities of the chosen virtual instrument or playback device. 

In earlier versions, glissandos always played back chromatically, except on harp, 

where they played back according to the current pedal settings. Dorico now 

determines the default approach for glissando playback according to instrument 

family: brass, singers, electronics, and strings all play back continuous glissandos 

by default; other families play back chromatic glissandos. 

A new Playback type property in the Glissando Lines group in the Properties panel 

allows you to override the default playback approach, and includes the option White 

notes, which can be useful on piano and other keyboard instruments. 

The extent to which Dorico can play back continuous glissandos using pitch bend is 

contingent on the Pitch bend range value in the relevant expression map. This 

setting is found in the Expression Map Data section at the top of Library ▶ 

Expression Maps, which is closed by default when editing an existing expression 

map. The Iconica Sketch and HALion Symphonic Orchestra sounds that ship with 

Dorico can only play pitch bend up to a range of +/-2 half-steps (semitones), so any 

glissando with a larger span will fall back to chromatic playback. NotePerformer, on 

the other hand, can play back pitch bend up to a range of one octave; any glissando 

with a larger span will similarly fall back to chromatic playback. 

Because MIDI pitch bend applies to the whole channel, Dorico also considers 

whether other notes will be played by the same endpoint, and falls back on 

chromatic playback if other notes would be affected by the pitch bend. 

In new projects, glissandos play back with a delayed start by default; this means that 

the glissando fits into the second half of the duration of the note on which the 
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glissando begins. This is controlled by a new Delayed start option on the new 

Glissando Lines page of Playback Options, and can be overridden via the Delayed 

start property in the Glissando Lines group in the Properties panel. You can also 

adjust the delay via the Delay property. 

When opening projects last saved in an earlier version of Dorico, the Playback type 

property is set to Chromatic (or, for harp, to Auto) to preserve the existing playback 

behavior. 

Monophonic legato. A new Monophonic checkbox has been added to the Expression 

Maps dialog, available when the selected base switch includes the Legato playback 

technique. This allows you to specify that the legato provided by this patch can only 

be correctly handled if the music is monophonic and that chords cannot be played. 

If this checkbox is activated, when playing back your music, Dorico will detect 

whether the legato section contains chords or notes in other voices that will be 

played by the same endpoint, and remove the legato playback technique; however, 

the legato note length as specified in Playback Options will still be used. This is 

enabled, for example, for the legato playback techniques in the new Iconica Sketch 

library. 

All notes off. You can now send MIDI messages to stop all sounding notes, reset MIDI 

controllers, and reset pitch bend by clicking the Stop button in the main Transport 

window when playback is stopped. 

Successive gradual dynamics. By default, when Dorico encounters two or more gradual 

dynamics in the same direction (in other words, both crescendo or both diminuendo) 

of up to four quarters (crotchets) in length, less than four quarters apart, it treats 

them as so-called phrasing dynamics, such that the overall dynamic level does not 

change. This is often desirable, but not in every circumstance. To allow you to 

disable this behavior, a new option Reset dynamic level for short consecutive 

gradual dynamics of same direction has been added to the Humanize section of 

the Dynamics page of Playback Options. 

Playback of chords with repeated notes on keyboard instruments. A new option 

Shortening behavior for other notes belonging to chords with shortened notes 

due to repetitions on the Timing page of Playback Options allows you to specify 

that when Dorico encounters a chord that abuts a previous note or chord where one 

or more of the notes are in common, Dorico should account for the time it would 

take for the key to be lifted and pressed again by either shortening only the 

common notes, or shortening the whole chord. By default, Dorico shortens the 

whole chord, but you can disable this effect altogether if you wish.  
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Players 
Instrument changes. A new option Instrument transition position has been added to the 

Instrument Changes section of the Players page of Layout Options, allowing you to 

specify whether the change from one instrument to another occurs immediately 

After last note of old instrument or Before first note in new instrument. 

Instrument change warnings. A new Instrument Change Warnings paragraph style has 

been added and is now used to label the end of the material in the old instrument, 

prior to the entry on the new instrument. This allows the two labels conventionally 

used in parts to indicate to players when they should take a new instrument to have 

a different appearance if desired. 

In new projects, the existing Instrument Change Labels paragraph style now shows 

a border, so the label that appears at the entry of the new instrument is now boxed. 

Hiding or showing instrument change warnings. A new option Show instrument change 

warnings has been added to the Instrument Changes section of the Players page of 

Layout Options, allowing you to specify whether instrument change warnings 

should be shown in the current layout. In new projects, this option is deactivated in 

full score layouts and activated in part layouts, since instrument change warnings 

are typically not required in the full score. 

Playing techniques 
Placement relative to fermatas. Text-based playing techniques – such as pizz., arco, etc. 

– and groups of playing techniques joined with arrows or other continuation lines 

are now positioned outside fermatas. Individual glyph-based playing techniques – 

such as harmonics, upbow, downbow, etc. – are positioned inside fermatas, as they 

have always been. 

Play mode 
Track inspector. The Track Inspector panel in the Routing tab in Play mode now includes 

drop-down menus allowing you to see and change the expression map used by the 

endpoint playing back the selected track, and, if the track corresponds to a 

percussion kit or instrument, the percussion map used. This allows you to see and 

change these settings at a glance, without needing to open the Endpoint Setup 

dialog. The buttons to the right of each drop-down open Library ▶ Expression Maps 

and Library ▶ Percussion Maps respectively, providing a quick way to edit the 

currently chosen expression or percussion map. 

Playing techniques 
Hidden playing techniques. When using the Shift+P popover to create playback 

techniques, if you wrap your input in parentheses, e.g. (pizz.), the resulting playing 

technique item will be hidden by default. 
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Project Info 
Markdown formatting. It is now possible to use simple Markdown formatting for adding 

bold, italic, and bold italic formatting to the fields in File ▶ Project Info, which will be 

reproduced when these fields are used to substitute text tokens in text frames in 

your layouts. To make text italic, add a single asterisk before the first character you 

want to be italic and add a single asterisk immediately after the last character; to 

make it bold, add two asterisks before and after the text to be emboldened; to make 

it bold and italic, add three asterisks before and after the text. 

To avoid unexpectedly changing the appearance of existing projects, Markdown 

formatting is disabled by default in projects last saved in earlier versions and 

enabled in newly created projects. To enable Markdown formatting in an existing 

project, activate the Resolve Markdown formatting for text tokens option at the 

bottom of the Project page in File ▶ Project Info. 

Print mode 
PDF export. When Flows is chosen in the Job Type section in the right-hand panel in 

Print mode, a new Separate file for each flow checkbox now appears. When this is 

activated, Dorico will export a separate PDF file for each flow chosen for export. 

Before you use this new capability, click Filename Options to edit the filename 

recipe for PDF export to include either or both the flow number and flow name in 

the exported filename; otherwise, each flow that is exported will overwrite the 

previous one. 

Repeat endings 
Appearance of repeat ending segments before the final one. A new option Right-hand end 

of segments before final segment has been added to the Segments section of the 

Repeat Endings page of Engraving Options. This allows you to choose whether the 

right-hand end of the repeat ending segments before the final segment should have 

a closed end immediately before the start of the next or final segment, or an open 

end, either stopping at the next barline, or immediately following the segment 

number. 

A further option Maximum length for open segment in open meter allows you to 

specify the appearance of repeat ending segment with an open right-hand end in a 

passage using open meter. 

Setup mode 
Delete Empty Players. A new Setup ▶ Delete Empty Players dialog has been added, 

allowing you to quickly delete players who have no music in any flow in the project. 

This can be useful when, for example, importing music into a large existing 
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template via MusicXML or MIDI, and you then want to remove players with no 

music. 

When you choose Delete Empty Players, Dorico shows a simple dialog listing the 

players in the project with no music: deactivate the checkbox for any players you 

want to remain in the project, then click Delete Selected Players to perform the 

operation. 

Duplicating players. When duplicating a player, Dorico now ensures that the newly-

created player is positioned in the player order after the existing identical player 

with the highest player number. 

Duplicating flows. When duplicating a flow in the Flows panel, Dorico now immediately 

brings the newly created flow into view. 

Staff labels 
Gap between inner and outer staff labels. A new option Distance between inner and 

outer staff labels on same staff has been added to the Horizontal Position section 

of the Staff Labels page of Engraving Options, allowing you to specify the distance 

between the inner and outer staff labels when both appear on the same staff. 

Previously this always used a fixed value of 1 space. 

Tempo 
Hiding tempos. It is now possible to specify that a tempo item should be hidden when it is 

created by wrapping the input for the Shift+T popover in parentheses. 

Gradual tempo changes. If you type rit... or accel... into the Shift+T popover, Dorico will 

now automatically set the Gradual tempo appearance property such that the 

resulting gradual tempo shows a dotted line. 

Properties panel. The Barline interaction property for gradual tempo items now appears 

in Write mode as well as in Engrave mode, for consistency with the analogous 

property for gradual dynamics. 

Text 
Copying rich text. When you copy one or more selected staff- or system-attached text 

items to the clipboard, Dorico now copies a rich text representation of the text to 

the clipboard, allowing you to paste the text into another application while 

preserving the formatting. By default, Dorico copies the text with HTML formatting, 

but you can instead specify that Dorico should use plain text (without any 

formatting information) or Markdown by setting Format for text items copied to 

clipboard in the Files section of the General page of Preferences. 

Paragraph Styles dialog. In the event that a paragraph style uses a font family that is not 

installed on your system, that font name is now displayed in the Font family menu, 
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with its name enclosed in parentheses. This prevents some confusing situations 

where the paragraph style appears to use, for example, the first font in the list, 

when the preview shows a different family name. 

Text editing popover. The maximum point size override allowed for text items is now set 

to the uselessly large limit of 999pt. 

Select More. The special behavior for Edit ▶ Select More to only select text items that use 

the same paragraph style as the first selected text item has now been extended 

such that if you select a text item on multiple staves, Dorico will now select only 

matching text items on all selected staves. 

Ties 
Tie direction. Two new options have been added to the Tie Direction section of the Ties 

page of Engraving Options. 

When a single voice is active, a chord with a mixture of tied and untied notes where 

the untied notes are furthest from the end of the stem and have different pitches 

(what Gould calls "single-stemmed moving chords" on page 70 of Behind Bars) will 

by default produce ties that all curve in the same direction, towards the end of the 

stem. This practice is not followed universally by all publishers, and so the new 

option Curvature direction for single-voice chords with moving notes allows you 

to specify whether ties should follow Gould’s recommendation (Uniform curvature 

direction) or should instead use the standard rules for tie direction (Allow natural 

curvature). 

Relatedly, when a single voice is active, a chord with a mixture of a single tied note 

and one or more untied notes where the untied notes are furthest from the end of 

the stem and have identical pitches will by default produce ties that curve upwards, 

because Dorico applies the standard rules for tie direction in this circumstance, and 

a single tie in a chord will, all other things being equal, curve upwards. If you would 

prefer Dorico to curve the tie away from the untied notes, set the new option 

Curvature direction for ties on innermost notes of single-voice chord to Ties 

curve towards stem. This is set by default in new projects but is set to Allow natural 

curvature in existing projects to preserve their current appearance. 

Time signatures 
Cautionary time signatures. A new option Cautionary time signature at end of system 

has been added to a new Time Signatures page in Notation Options, allowing you to 

specify that Dorico should hide the cautionary time signature that appears at the 

end of the system for a change of meter that occurs at a system boundary. This can 

also be overridden for a selected time signature via the new Cautionary at end of 

system property in the Time Signatures group in the Properties panel. 
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Color. Time signatures now support the Color property in the Common group in the 

Properties panel. 

User interface 
Key commands for zoom. It is now possible to create key commands for custom zoom 

levels via the Key Commands page of Preferences. Navigate to View ▶ Zoom in the 

tree of commands, enter the desired zoom percentage (without the percentage 

sign) into the Parameter 'ZoomPercent' input field, then add the desired key 

command. 

Zoom level. When switching between page and galley view, Dorico now retains the same 

zoom level, rather than reverting to the default zoom level defined in Preferences, 

and attempts to restore the last view position. 

Show VST plug-in window. A new command Show VST Plug-in Window For Selected 

Staff has been added to the Play category in the Key Commands page of 

Preferences. You can assign a shortcut to this command to show the window of the 

VST plug-in used to play back the first staff in the selection; if the instrument in 

question uses independent voice routing, Dorico will show the VST plug-in used to 

play the first voice in the selection. In Play mode, the shortcut will open the VST 

instrument used to play back the track selected in the track overview. 

Minimum project window size. When you reduce the width of the project window, Dorico 

now abbreviates the labels on the toggle buttons for switching between page and 

galley view, and between concert and transposed pitch, so that the minimum width 

of the project window in Write mode can now be smaller. 

Letter spacing and baseline shift. The values for letter spacing and baseline shift can now 

be set to two decimal places both in the Paragraph Styles dialog and in the text 

editing popover. 

Insert Music Text dialog. It is now possible to confirm your choice in the Insert Music 

Text dialog by double-clicking the desired glyph. 

Options dialogs. It is now possible to hit Return when the keyboard focus is in the find 

and search controls in Dorico’s five main options dialogs without the dialogs 

closing. 

Status bar. The informational read-out for the selected item in the status bar has been 

expanded as follows: 

§ Percussion kits: A selected note in an unpitched percussion instrument or kit 

now displays the MIDI pitch that will be played back for that note, taking into 

consideration the active percussion map. 
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§ Playing techniques: Dorico now shows not only the name of the selected playing 

technique, but also the name and internal ID of the playback technique that it 

gives rise to in playback. 

§ Notes: For notes with microtonal pitches, Dorico now shows the precise MIDI 

pitch, expressed as a fraction. 

Galley view margin. When a player is set to display its name in staff labels, it will 

nevertheless now show the instrument names in the galley view margin. 

Create New page of the Hub. A new pair of toggle buttons has been added to the Create 

New page of the Hub window, allowing you to toggle the list of project templates 

between the familiar grid view and a more compact list view. 

Action bars. The appearance of action bars has been unified and improved throughout 

the application. 

Video and timecode 
Updated video engine. The shared video engine has been updated. The new update now 

uses Direct2D rather than OpenGL on Windows. You should not notice any practical 

difference in using the Video window, but please let us know if you run into any 

problems on either platform. 

Marker appearance. A new Border style option has been added to the Design section of 

the Markers page of Engraving Options, allowing you to choose between the same 

border styles used for text items. 

View options 
Page numbers. By default, pages using the First page template do not show a page 

number, so when doing page layout in Engrave mode it can be difficult to match up 

pages in the music area with pages in the Pages panel to, say, apply a page template 

change. Similarly, when zoomed out to get an overview of the layout, page numbers 

may be too small to be read easily. To make identifying pages easier, a new View ▶ 

Page Numbers option has been added: this shows a large, translucent page in the 

upper corner of each page in the layout. 

Localization 
Importing page template sets. When running Dorico in a language other than English, 

the name of an imported page template set based on one of the factory page 

template sets will now use the translated name instead of the English name. 
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Dorico for iPad 
New General MIDI sounds. Dorico for iPad now uses a new sampler engine based on the 

same technology that powers the HALion sampler workstation on desktop, and 

includes a new set of General MIDI sounds that are much more expressive than the 

Microsonic sounds used by default in previous versions. To use the new sounds in 

an existing project, choose Reset Sounds from the application menu, and tap the 

Use General MIDI button. 

Iconica Sketch. For users with an active subscription or the Lifetime Unlock in-app 

purchase, Dorico for iPad now includes the new Iconica Sketch orchestral sound 

library. All the instruments and techniques of the full desktop version are included, 

and the sounds have been further compressed to take up only 2GB space on your 

device. 

Before you can use Iconica Sketch, you need to download the new sounds from 

within the app. If you have a subscription or Lifetime Unlock, you can download the 

sounds either from the General page of Preferences, or from the Reset Sounds 

dialog in the application menu. 

To use Iconica Sketch with large orchestral projects, your iPad needs to have more 

than 4GB RAM. Please check online to find out how much RAM your iPad has. Dorico 

for iPad examines the model number information about your iPad to determine 

whether it will recommend using Iconica Sketch for playback on your device. You 

can still use Iconica Sketch if your iPad has 4GB or less RAM, but we recommend 

you use it only with smaller projects of up to around 16 players. 

If your iPad has more than 4GB RAM, Dorico will default to using a combination of 

the General MIDI and Iconica Sketch sounds for new projects, but for iPads with 

4GB RAM or less, Dorico will default to using only the General MIDI sounds. You can 

switch between the two different playback templates using the Reset Sounds dialog 

in the application menu. 

Buffer size. A new option has been added to the Play page of Preferences to allow you to 

set the audio buffer size. If you encounter crackles or drop-outs in busy passages 

when using Iconica Sketch, try increasing the buffer size. 

Toolbar. The responsiveness to display orientation and display size on different models 

of iPad has been improved. The application menu should no longer ever be cut off at 

the right-hand side of the display, and Dorico now hides parts of the mini transport 

if required. 

Jump bar. You can now access the jump bar in Dorico for iPad by tapping the new icon on 

the toolbar. This allows users without a hardware keyboard attached to access the 

jump bar. 
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Read mode. When the project is shown in galley view in Write mode, it was impossible to 

make annotations with the Apple Pencil in Read mode. This has now been fixed. 

(Apple Pencil annotations in Read mode require an active subscription or the 

Lifetime Unlock in-app purchase.) 
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Issues resolved 
Component Issue 

Bar numbers Under some circumstances, the bar number for an irregular bar at the start of the system 

could incorrectly be shown in square brackets, as if it were the second half of a bar that started 

on the previous system; this has now been fixed. 

Bar numbers When hiding a selected bar number with the Hide/Show Item command, now only the 

selected bar number is hidden, rather than all bar numbers until the next time signature. 

Bar numbers Inserting a time signature in the middle of a bar and thus creating an irregular pick-up bar 

prior to the newly inserted time signature now immediately updates the bar number of the 

preceding bar, if shown. 

Bar numbers Changing the horizontal position of bar numbers from the center of the bar to the barline or 

vice versa could lead to some temporary artifacts where other items could avoid the previous 

position of each bar number; this has now been fixed. 

Chord diagrams After editing the strings and tuning for a guitar instrument in the project, the edited tuning 

now appears right away in the Chord Diagrams submenu of the player context menu in Setup 

mode, instead of appearing only after you have reopened the project. 

Chord symbols The alignment of parenthesized chord symbols relative to the note or chord with which they 

are center- or right-aligned has been improved. 

Chord symbols Changing chord symbol visibility for a player in Setup mode is now much quicker than before. 

Chord symbols The option to show chord symbols above the top staff in the system is now correctly applied 

even if the top instrument in the system is itself set not to show chord symbols. 

Comments Comments that are replies to another comment once again appear indented in the Comments 

panel, as they should. 

Comments If a comment was already selected in the Comments panel and a note selected elsewhere in 

the music, double-clicking a comment to edit it would result in the comment being moved to 

the position of the selected note when the edit was confirmed; this has now been fixed. 

Comments Line breaks are now removed from instrument names shown in comments in the Comments 

panel. 

Condensing Dorico would not always update the condensed music immediately after making changes in 

Layout Options; this is now fixed. 

Condensing Under rare circumstances, deleting custom condensing groups in Layout Options could result 

in a crash; this is now fixed. 
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Component Issue 

Condensing When condensing divisi sections, under some circumstances, the divisi label on a system may 

sometimes have only accounted for one of the sections condensed into the stem; this has now 

been fixed. 

Cues It is now possible to create a cue from a selected multi-bar rest in a part layout, if desired. 

Cues Rhythmic cues from slash voices on pitched instruments now appear correctly in percussion 

kits. 

Divisi Adjacent lyrics that are in divisi and unison regions respectively now correctly avoid each 

other when calculating rhythmic spacing. 

Divisi Cautionary time and key signature are no longer missing when unison is restored at a system 

break but with no intervening divisi unison range. 

Divisi Cautionary time and key signature are no longer missing when unison is restored at a system 

or frame break, but with no intervening divisi unison range. 

Divisi Key signature cancellations for divisi staves are now calculated and displayed correctly. 

Divisi Slurs that cross between divisi and unison ranges now appear more reliably. 

Divisi Slurs that cross transitions between divisi and unison passages now appear correctly in many 

more circumstances. 

Divisi System-attached items (like tempo markings) that straddle a change from divisi to unison no 

longer sometimes incorrectly appear on each divisi staff. 

Divisi The calculation of cautionary accidentals when transitioning between different numbers of 

divisions or between divided and unison music has been improved. 

Divisi The handling of octave lines in divisi sections, in particular where they cross between divisi 

and unison passages, has been significantly improved. 

Divisi The relative positioning of lines of lyrics and verse numbers in divisi staves is now correct. 

Divisi Under some circumstances, accidentals in divisi staves would not always appear correctly for 

transposing instruments by default; this has now been fixed. 

Divisi Under some circumstances, moving a divisi change past a clef change could result in a key 

change drawing twice, once at the staff positions described by one clef, and once at the staff 

positions described by the other; this has now been fixed. 

Divisi Under some circumstances, the required clefs at transitions between unison and divisi 

passages would not be shown; this has now been fixed. 
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Component Issue 

Divisi When returning to unison following a divisi passage in which the divided material has used a 

local key signature, accidentals are now displayed correctly in the unison music following the 

return of the global key signature. 

Divisi Slurs that start in divisi and cross into unison now appear correctly on systems that are 

entirely unison. 

Divisi Slurs from divisi staves to unison staves now appear correctly across system breaks where 

unison is restored. 

Divisi Divisi unison ranges with more than a single active voice now prevent condensing, as they 

should. 

Divisi Horizontal lines now appear correctly in unison passages when they end at the start of a divisi 

passage. 

Divisi Note-attached lines starting in unison ranges and ending in divisi ranges now appear only on 

the destination divisi staff, like glissando lines. 

Divisi Slurs between divisi and unison transitions on condensed divisi staves now appear correctly. 

Divisi Slurs now appear correctly on condensed staves for adjacent section players. 

Divisi When there are no notes in the unison range, the unis. label now always appears at the start of 

the unison range. 

Divisi Under some circumstances, the endpoints for slurs that cross systems where the system 

break also represents a change in divisi or unison might not be positioned correctly; this has 

now been fixed. 

Dynamics Adding an immediate dynamic at a non-grace note position will no longer incorrectly replace 

a dynamic at a grace note position if there is one. 

Dynamics If the notation option to show a complete systemic barline at the end of the system is active, 

hairpins that cross the system break now stop short of the systemic barline, instead of 

abutting it. 

Engrave mode Moving a bar to the next or previous system now works as expected when a beam is selected. 

Engrave mode Clicking away from the staff gap measurement spin box in Engrave mode without changing 

the gap value no longer incorrectly shows the affected staff handle as having a modified value. 

Engrave mode It is no longer incorrectly possible to select the circular handles for adjusting voice column 

positions when marquee selecting a range of square handles for adjusting global column 

positions. 
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Component Issue 

Engrave mode Showing the Project Info dialog, then changing settings in the Preferences dialog, then editing 

a page template, could cause a crash; this has now been fixed (macOS only). 

Ensembles When saving a custom ensemble, Dorico now also saves any user-defined instruments to the 

user library. 

Flows Under some circumstances, using Split Flow with a note with a negative playback start offset 

could crash; this has now been fixed. 

Guitar tablature When deactivating Show rhythms in tablature in Layout Options, rhythm dots and rests are 

now correctly cleared immediately from the updated tablature. 

Harp pedals When editing an existing harp pedal change via the popover, any properties that were set on 

the original pedal change are now preserved. 

Holds and pauses If a caesura coincides with a mid-bar system break, it now appears correctly. 

Holds and pauses The Max. fermatas per staff property no longer appears when Attach to barline is activated. 

Instrument 

changes 

Moving music from one staff to another between instruments belonging to the player now 

immediately and correctly produces the expected instrument transition in page view. 

Instrument 

changes 

The appearance of transitions between instruments with different numbers of staff lines has 

been improved, with the stave lines no longer unexpectedly overlapping. 

Instrument editor Editing the Variant name field in the instrument editor is no longer particularly slow. 

Instrument editor Saving a percussion kit as default in the instrument editor now correctly includes all kit 

component instruments. 

Instrument editor Saving a percussion kit as a default now works correctly, including all of the required data for 

every component instrument in the kit. 

Instrument score 

orders 

Additional instrument score orders are now correctly loaded from library files, if present. 

Instrument score 

orders 

The order in which clarinets are listed in the default instrument score orders has been 

improved. 

Instrument types Duplicate domra instruments no longer appear in the Fretted instruments family in the 

instrument picker. 

Instruments When changing an instrument held by a player to another instrument with fewer staves, 

Dorico now correctly resolves clefs on the source staves so that only one clef can be created on 

the remaining staff. 
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Component Issue 

Key Editor Adding or removing tuplets in the score now correctly immediately updates the display of 

tuplets in the piano roll editor. 

Key Editor Annotations in the tempo editor at the very start of the flow now appear or disappear correctly 

immediately after the corresponding tempo item is created or deleted. 

Key Editor Clicking the Delete button in the Key Editor toolbar now causes the calculated data in the MIDI 

CC and other editors to be updated immediately as necessary. 

Key Editor Cutting notes with U, joining them with T, splitting them into multiple notes with Alt+U, or 

changing the duration of the selected note all now cause the calculated data in the MIDI CC 

and other editors to be updated immediately as necessary. 

Key Editor Under some circumstances, the ruler and background for the piano roll could appear the 

wrong length for certain irregular bar lengths; this has now been fixed. 

Key Editor When dragging points in the automation editor that cannot be dragged beyond the next or 

previous point in the editor, Dorico now ensures that the point cannot be dragged to the exact 

position of the next or previous point, which could otherwise disturb the region at that 

position. 

Key Editor When the tempo editor takes up the whole of the lower zone, because you have selected a 

tempo in the music area, the annotations that show which tempo item corresponds to each 

region now appear correctly. 

Key Editor The value read-out at the left-hand side is now constrained vertically so that it no longer 

disappears off the top of the editor when the mouse pointer is near the top. 

Key Editor The value readout which appears along with the mouse whilst using the pencil tool in the MIDI 

CC editor is no longer often out of view when the left-hand side of the view is beyond the start 

of the flow. 

Key Editor The annotations at the bottom of the dynamics editor now update immediately after editing a 

dynamic in the score. 

Key Editor The initial tempo value for a gradual tempo following a tempo primo instruction is now shown 

correctly in the tempo editor. 

Key Editor Percussion instruments that do not define a 'Natural' playing technique would previously not 

appear correctly in the percussion editor in the Key Editor; this has now been fixed. 

Key Editor The spin box showing the velocity of the first selected note now always updates when the 

selected note is repitched or has its duration edited. 

Lines When a vertical line or arpeggio crosses from one staff into another staff of a different size (for 

example, an ossia), the vertical position of each end of the line is now correct. 
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Component Issue 

Live editing Dragging combinations of notes and rests in tuplets now works more reliably. 

Live editing Dragging music in divisi staves now works correctly. 

Live editing The appearance of the live editing overlay when dragging grace notes has been improved. 

Lyrics Select More no longer sometimes incorrectly selects lyrics in multiple lines rather than 

selecting more lyrics in a single line if the bar starts with a rest. 

Lyrics When the option to show verse numbers only on the first system on which lyrics appear is set, 

Dorico would sometimes not immediately clear a verse number on a later system when 

adding a lyric on an earlier one; this is now fixed. 

Lyrics When the Paragraph style property is set, the vertical position of the extender line now 

correctly considers the overridden paragraph style. 

Lyrics The verse number for the first lyric on a system could be positioned at the wrong vertical 

position if a lyric extender line belonging to another line of lyrics crosses the start of the 

system. 

MIDI export The Transpose value specified in expression map switches is now correctly applied during 

MIDI export. 

MIDI export Under some circumstances, Dorico could export the wrong base MIDI pitch for certain 

microtonal pitches when using pitch bend for microtonal playback; this has now been fixed. 

Mixer Renaming a channel in the Mixer now takes effect immediately. 

Music symbols Scaling the number shown above a bar repeat no longer results in the area for background 

erasure, if set, being much larger than expected. 

MusicXML export When exporting gradual tempos that span multiple bars, the position of the end of the tempo 

indication is now more reliably exported. 

MusicXML import If you import a MusicXML file into an existing project, then rename or move the MusicXML 

file, Dorico no longer incorrectly starts saving to the MusicXML file’s new location when you 

choose File ▶ Save. 

Note input Edit ▶ Notations ▶ Voices ▶ Swap Voice Contents is now only operable when the selection 

consists of material in exactly two voices. 

Note input In some situations involving notes spanning tuplets, Dorico would not always correctly extend 

selected notes when using Extend to Next Note; this has now been fixed. 

Note input The speed of note editing operations such as pasting and doubling/halving note values has 

been increased, so that these operations are comparable in speed to previous versions. 
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Component Issue 

Note input Under certain circumstances, inputting notes or bars at the end of the flow in galley view 

would result in it being impossible to scroll to the end of the flow unless you change the zoom 

level; this has now been fixed. 

Note input When selecting a passage using the system track, notes in percussion kits now correctly show 

selected in orange, rather than incorrectly in the dark blue linked selection color. 

Note input When inputting a gradual dynamic during step-time input, Edit ▶ Undo now correctly 

shortens the gradual dynamic as you undo your input. 

Note input Saving the project no longer results in the instrument being used for MIDI monitoring being 

reset to the first instrument in the score. 

Note input The commands to double or halve note values now work correctly when explicit bar rests are 

present. 

Note input When multiple windows are open on the same project, the state of the caret and grid is now 

updated in all windows reliably. 

Note input Starting note input in one window when another window in the same project is in Engrave 

mode no longer sometimes causes Dorico to freeze. 

Note input Redoing to the point where all edits have been redone, then subsequently performing further 

edits, then redoing and undoing them, no longer sometimes causes two of those edits to be 

redone in a single step. 

Note spacing Grace notes positioned before the final barline on a system that coincide with a caesura before 

the final note of the system are now always spaced correctly. 

Note spacing Copying and pasting note spacing changes from one flow to another now correctly retains its 

settings. 

Note spacing Adding a natural harmonic using the Type property in the Harmonics group no longer causes 

spacing problems with, for example, lyrics at the same rhythmic positions. 

Noteheads Under some circumstances, the precise horizontal position of a parenthesis or bracket on the 

stem side of a notehead can be slightly wrong until after the music is edited; this has now been 

fixed. 

Notes When notes are selected in both staff notation and tablature for the same instrument, Reset 

Forced Stem now correctly resets stem directions in both representations. 

Octave lines It is once again possible to create a voice-specific octave line by holding Alt when confirming 

the popover or clicking the octave line in the notations panel. 
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Component Issue 

Ornaments It is no longer possible to create a guitar bend between two notes of the same pitch. 

Ornaments The Notehead submenu now once again appears in the right-click context menu when a trill 

is selected, allowing you to override the notehead used for the trill's auxiliary note. 

Page layout Move Bar to Previous System now works correctly when selecting a bar repeat, a notehead in 

a tie chain, or a dynamic in a dynamic group. 

Percussion Moving a note on a percussion kit to the adjacent instrument using Alt+↑/↓ no longer 

sometimes results in Dorico hanging. 

Percussion The Clear Row button in the action bar in Library ▶ Percussion Maps now works as expected 

for percussion maps that feature user-defined instruments. 

Percussion Custom percussion instruments added to the project by importing percussion maps are now 

added to the appropriate family. 

Play mode When splitting an existing flow in which players use independent voice routing, when 

switching to Play mode, all independent voices now immediately show the correct tracks. 

Play mode When expanding a percussion kit in Play mode, the component instruments now once again 

appear directly below the main kit instrument, instead of incorrectly being added at the end of 

the list. 

Play mode Double-clicking the track overview in new flow with newly created notes now always correctly 

opens or closes the lower zone. 

Playback Dorico now treats the case of the Muted playback technique followed by Open as a special 

case, such that Open removes Muted but does not add Open. 

Playback If a requested playing technique is not specified in the expression map, Dorico now more 

reliably chooses the expression map switch that matches the note length condition, if any, 

before it returns another fallback switch that does not match the note length condition. 

Playback MIDI trigger regions now produce the expected pitch when playing back on individual 

unpitched percussion instruments. 

Playback The Humanize the start positions of notes by option on the Timing page of Playback Options 

now works as expected once more. 

Playback Under rare circumstances, Dorico could crash when preparing for playback; this has now 

been fixed. 

Playback When adding or removing players from a layout, playback now immediately reflects the new 

subset of players in the layout. 
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Component Issue 

Playback When Dorico loads patches for percussion kits, it now much less often loads an unnecessary 

General MIDI kit patch and will more often route multiple instruments to the same patch if 

possible. 

Playback Dorico now correctly chooses orchestral percussion instead of the drum set patch in 

NotePerformer for kits. 

Playback Endpoint configurations with family overrides in the playback template no longer incorrectly 

get chosen for percussion kits. 

Playback Under some circumstances, successive notes of the same pitch under a slur could result in the 

second note being cut very short; this has now been fixed. 

Playback Dorico no longer allows the start position of a note that abuts a preceding note of the same 

pitch to be humanized, as this can result in the note on message for the second note to come 

before the note off of the first note, resulting in the second note being cut off unexpectedly. 

Playback Dorico could crash if you try to start playback by typing **P** when the sounds have not yet 

loaded; this has now been fixed. 

Playback When multiple instruments are played by the same endpoint, for example in the case of 

component instruments in a percussion kit, the playing techniques from the instrument with 

the largest number of playing technique regions will be played back, rather than the regions 

from the first instrument processed. 

Playback Deleting or adding bars via the system track now updates playback immediately, so that any 

change in, for example, repeats playback is reflected right away. 

Playback Appoggiatura chords now play back correctly. 

Playback Grace notes tied to rhythmic notes now play back correctly in more circumstances. 

Playing techniques When editing an existing playing technique via the popover, if the original playing technique 

was part of a group, the group is now retained. 

Playing techniques Playing techniques with continuation lines now draw at the correct size on grace notes. 

Play mode The Channel section of the Track Inspector panel now updates immediately after changing 

the output device in the Routing section. 

Print mode If you had Print mode open in one project window and then edited the project in a different 

window, Dorico could hang; this has now been fixed. 
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Component Issue 

Print mode On some Windows computers, switching to Print mode and then closing the project could 

result in a crash due to problems with certain printer drivers being slow to respond when the 

printer is disconnected or offline; this has now been fixed. If your printer has an affected 

driver, you will now experience a delay when switching to Print mode the first time after 

starting Dorico. 

Print mode The toggle buttons for printing all pages, a page range, or a selection of flows now work 

correctly when dealing with a selection of layouts with conflicting settings. 

Printing Under some circumstances, Dorico could crash if, after having visited Print mode, you close 

the project or quit the application before Dorico has been able to initialize your printer driver; 

this has now been fixed. 

Project files Under very rare circumstances, Dorico could crash when inputting notes; this has now been 

fixed. 

Project files Under some circumstances, Dorico could crash when opening projects with multiple flows; 

this has now been fixed. 

Properties Where properties are shown in pairs, e.g. X and Y, Dorico will now only show the labels in bold 

(meaning that the value applies globally) if both properties are set globally. 

Properties The speed of unsetting properties on many selected dynamics, lyrics, or slurs has been 

significantly improved. 

Read mode Annotations with the Apple Pencil now work correctly if the layout is shown in galley view in 

Write mode (Dorico for iPad only). 

Setup mode Under rare circumstances, players could end up missing from the Players panel in Setup 

mode if they are not present in any player group; Dorico now automatically returns any such 

players to the default player group when loading projects. 

Setup mode After deleting a player, hitting Delete again will no longer incorrectly prompt you about the 

deletion of the selected player. 

Staff labels The layout option Minimum indent for systems with staff labels is no longer incorrectly 

applied on systems with no staff labels. 

Tablature When calculating the string for each note in a chord for tablature, Dorico now allows a partial 

barre on the lowest two strings of the instrument if required. 

Tempo Some subtle problems involving relative, gradual and reset tempo items in repeat structures 

have been fixed. 
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Component Issue 

Text In the unlikely event that text items in the project refer to a paragraph style that has been 

deleted, Dorico will now repair these text items when the project is next loaded, resetting 

them to use the default paragraph style. 

Text It was not previously possible to edit an existing text item on a percussion instrument in a kit 

using the single-line presentation type; this has now been fixed. 

Text When editing text near to the edge of the viewport, the text editing controls no longer 

unexpectedly move left or right after typing the first character. 

Text Dorico’s handling for font families with no “Regular” style is improved. 

Text If a paragraph style specifies a border width of 0, Dorico no longer draws a cosmetic single 

pixel border around the text. 

Text The Default Music Text Font font style no longer incorrectly specifies the Default Text Font 

font style as its parent. 

Text Changing the line spacing (leading) value in a paragraph style now correctly automatically 

updates existing text items. 

Ties The option Gap between ends of ties that start and end on the same note now applies to 

the first tie in a tie chain as well as every subsequent one. 

Time signatures Dorico no longer crashes if you accidentally enter a decimal point with no numeric value as a 

pick-up duration in the Shift+M popover. 

Time signatures When copying and pasting a single time signature, Dorico will now ensure the destination bar 

contains the expected number of beats if Insert mode is active. 

Tuplets Under some circumstances, nudging a tuplet vertically could cause the vertical position of an 

adjacent tuplet to move vertically unexpectedly; this has now been fixed. 

User interface Dorico could sometimes crash when quitting the application if the Preferences dialog was left 

open; this has now been fixed. 

User interface If you switch away from Play mode having opened the VST instrument menu in the Routing 

section of the Track Inspector panel, the menu is now correctly closed. 

User interface Tool tips have now been added to the buttons in the notes toolbox that pop out when long-

pressed or right-clicked. 

User interface Trying to add a pitch to be filtered to the Filter Notes by Pitch dialog in a project using a 

custom tonality system could crash; this has now been fixed. 
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Component Issue 

User interface Under some circumstances, Dorico could crash when clicking buttons in the Notations panel 

after having changed some aspect of the visual theme; this has now been fixed. 

User interface When multiple tabs on the same layout are open, some in galley view and others in page view, 

Dorico will now attempt to keep the same tab active when switching to and from Engrave 

mode. 

User interface Choosing Play ▶ Fixed Tempo Mode now correctly updates the tempo display in the toolbar. 

User interface Dorico no longer crashes on start-up if the recentFiles.xml data file has been unwisely 

tampered with outside of the program. 

User interface The Explode and Reduce menu items now appear correctly in Dorico Elements once more. 

User interface Dorico no longer crashes if you quit the application while the Edit Percussion Kit dialog is 

open. 

User interface Key commands you assign in Preferences now work correctly in an existing project window as 

soon as they have been added. 

User interface Dorico no longer crashes after closing the last open project when it is set in Preferences to 

open a new empty project window rather than return to the Hub. 

User interface The appearance of checkboxes in an indeterminate state in the light theme has been 

improved. 

User interface The correct level of opacity has been applied to the Chords track in Play mode once more. 

User interface When Use custom player order is first activated on the Players page of Layout Options, the 

initial order of players now matches the current score order. 

User interface The appearance of long project names in the Open Recent page of the Hub has been 

improved. 

User interface Hiding or showing the tab bar while the text editor is open no longer results in some 

commands and menu items being incorrectly disabled. 

Video On some Mac systems, Dorico could crash on exit due to a problem in the shared video engine; 

this has now been fixed. 

Video Dorico no longer crashes if it is unable to extract the soundtrack from an attached video. 

Views Dorico no longer prevents you from scrolling all the way to the end of the layout in page view 

at zoom levels between 113% and 118%. 

Views Under rare circumstances, Dorico could crash when closing a project; this has now been fixed. 
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Dorico 5.0.20 

3 July 2023 

Improvements 

Groove Agent SE  
Jazz Essentials. The Groove Agent Jazz Essentials content set, which includes 10 styles 

performed by professional jazz drummers, is now included with Dorico 5. You can 

download this new content set via Steinberg Download Assistant: choose Dorico 

Pro 5 or Dorico Elements 5 on the left-hand side and install the Jazz Essentials 

download choice. 

To ensure you can use the content correctly in Dorico 5, please also run Steinberg 

Activation Manager and click the Refresh button in the top right corner. This will 

update your Dorico 5 license. 

Instrument editor 
Chord symbols. A new Rhythm section instrument checkbox has been added to the 

instrument editor. This allows you to specify whether the instrument should be 

considered a rhythm section instrument for the purposes of displaying chord 

symbols. 

Percussion kits. It is now possible to change via the instrument editor the number of staff 

lines displayed when the 5-line staff presentation type is used. This allows the 

creation of percussion kits containing two instruments that are shown respectively 

on the space above and below a single staff line. 

Key Editor 
Note editing in the piano roll. The editing of notes in the piano roll has been greatly 

improved. In previous versions, when dragging a note whose position or duration 

was not aligned to the Key Editor rhythmic grid, its position or duration would be 

incremented by the current grid value, rather than first snapping to the nearest grid 

position, as you might expect. This has now been changed such that moving or 

changing the duration of a note will snap it to the grid, and then increment it by the 

grid resolution. 

Mouse tracking is now improved as well. For example, when dragging the right-

hand end of a short note to make it longer, its duration no longer changes as soon as 

you start to drag to the right: instead, the note’s duration is only changed once the 

mouse pointer passes the right-hand end of the note. 

Dorico also constrains notes to the start of the flow when moving them 

rhythmically in the piano roll, rather than making it appear that you can drag notes 
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beyond the start of the flow. Similarly, when dragging notes vertically to change 

their pitch, they are now constrained to the lowest and highest pitches of the piano 

roll. 

When editing played durations, Dorico now allows notes to have a much shorter 

minimum duration (64th note, or hemidemisemiquaver). 

MIDI import 
Importing into an existing project. The performance of importing a MIDI file into an 

existing project has been greatly improved. 

Mixer 
Lower zone Mixer. When the lower zone is increased in height sufficiently, the upper 

section of the Mixer containing inserts and sends now appears in the lower zone. 

Note input 
Flip. Using Edit ▶ Flip for a tied note or chord in Write mode now flips the stem direction 

of all noteheads in the tie chain, rather than only the first. 

Playback 
Microtonal playback. When Microtonality playback is set to Auto in the expression map, 

Dorico will now automatically use VST3 note expression for all of Steinberg's VST3 

instrument plug-ins, so in addition to HALion family products, it will now also play 

back microtonal pitches correctly in instruments like Retrologue and Padshop. 

In addition, Dorico will now use VST2 detune messages to play microtonal pitches 

in Modartt Pianoteq 8 if the Microtonality playback option is set to Auto. You need 

to manually activate the MIDI Tuning option in Pianoteq 8 itself to hear microtonal 

pitches. 

Properties 
Properties for tied notes in Write mode. Many properties can have different values for 

different noteheads within a single tied note or chord in Engrave mode; for 

example, the Accidental property can be set on any notehead in a tie-chain to show 

or hide the accidental at that point in the note; similarly, the Direction property can 

be set on any tie to override its direction. However, in Write mode, setting these 

properties would only set the chosen value for the first notehead in a tie-chain, 

which is rarely the desired result. 

Now in Write mode Dorico will set properties like Direction or Design for ties for all 

notes in a tie-chain. Accidental is still treated specially, since you typically only 

want to show, hide or bracket the accidental at the start of the note, rather than on 

every notehead in the tie-chain; similarly, the properties in the Beaming group 

apply only to the first notehead in the tie-chain. 
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Space and stage templates 
Overwrite warnings. When clicking Save as Space Template from the Live Stage or Save 

as Space Template from the Live Space, Dorico now warns you if you are going to 

overwrite an existing stage or space template, rather than silently overwriting the 

existing one. 

Tempo 
Popover input. If you specify a metronome mark in the Shift+T popover, Dorico will now 

always create an immediate tempo, even if the text specified would otherwise 

create a relative tempo change. This allows you to type, for example, meno mosso 

q=96 and create an immediate tempo, rather than a relative one. 

Furthermore, Dorico no longer shows the percentage change for relative tempos as 

if they were metronome marks in the popover. Instead, relative tempos now have 

(relative) appended, so you can easily tell the difference between creating, for 

example, Lento as an immediate tempo or a relative tempo. 

Approximate tempos. It is now possible to specify whether the abbreviation for circa 

should be ca. with a terminating period (full stop) or ca without. 

Text 
Border color. If a paragraph style defines an overridden Foreground color, if you activate 

the Border property, the border will now be drawn in the chosen foreground color, 

rather than in black. 

User interface 
Playback techniques dialog. The Playback Technique Combinations dialog that is used 

when specifying playing techniques in expression and percussion maps now 

contains an auto-complete search field at the top of the dialog: this allows you to 

type part of the name of the desired playback technique. Confirming the auto-

completion by hitting Return adds the selected playback technique to the current 

combination. 

Project Info dialog. Invoking the Project Info dialog via the context menu for a specific 

flow in the Flows panel now always selects the chosen flow in the dialog when it 

opens. 

Platform support 
On macOS, Dorico 5 now requires Metal for parts of its user interface by default. 

Certain MacBook Air and Mac mini computers from 2014 and 2015 use Intel Iris Pro 

and Intel Graphics 5000 adaptors that have a bug in their Metal graphics drivers for 

hardware-accelerated graphics that cause them to crash when Dorico 5 starts. To 

work around this problem, Dorico now detects the problematic graphics adaptors 
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and, if found, automatically applies a workaround for the problem on those 

computers. 

Since these computers are now quite old and cannot run later operating systems 

than macOS 11 Big Sur, we recommend considering upgrading to a more recent 

model of Mac if possible. 

Dorico for iPad 
§ It is once again possible to double-tap the score to start note input or edit an 

existing item. 

§ Dorico for iPad no longer crashes when you hit Esc on the hardware 

keyboard to cancel certain dialogs. 

§ Under some circumstances, closing a read-only project with more than 

eight (or 12) players could cause players beyond the player limit to be 

removed from the project; this has now been fixed. 
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Issues resolved 
Component Issue 

Audio engine Playback to external MIDI devices now works correctly once more. 

Audio engine On some systems, the audio engine would often crash unexpectedly; this has now been fixed 

(macOS only). 

Audio engine Device names with multi-byte or special characters are now handled correctly; this resolves 

issues with device names including “smart” apostrophes, e.g. Valerio’s AirPods. 

Comments Shortening a note in Insert mode no longer unexpectedly deletes comments at the same 

position as the note. 

Condensing Under some circumstances, when instrument changes are disabled, some condensed music 

belonging to players holding multiple instruments could fail to appear in some systems; this 

has now been fixed. 

Condensing When you create a condensing change, Dorico no longer incorrectly shows the settings for a 

condensing change in another layout at the same rhythmic position. 

Dynamics Text-based gradual dynamics with dotted or dashed lines terminated with an immediate 

dynamic could start too far to the right; this has now been fixed. 

Key Editor The Make Constant/Linear buttons in the dynamics editor now work as expected, and only 

convert the final point in a region if that region is being merged with an adjacent one. 

Instrument editor Under some circumstances, editing a percussion kit in the instrument editor could result in 

the kit instruments being unexpectedly removed from the kit; this has now been fixed. 

Instrument editor Under rare circumstances, editing an instrument or using Change Instrument could cause 

Dorico to crash; this has now been fixed. 

Instrument editor The Instrument picker name shown in the instrument editor now uses the language of 

Dorico’s user interface, rather than the current project language. 

Instrument editor Under some circumstances, the instrument editor did not allow a custom instrument to be 

deleted when it should; this has now been fixed. 

Instrument editor Editing the clefs used for an existing instrument in the project now always works correctly; 

previously it was possible for some chosen clefs not to appear in the score immediately. 

Instrument filters When editing an instrument with the instrument editor, or using Change Instrument in Setup 

mode, any instrument filters that reference that instrument are now correctly updated. 

Jazz articulations The Jazz Articulations section of the Ornaments panel now works as expected with grace 

notes. 
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Component Issue 

Key Editor The piano roll and editors in the Key Editor now update correctly after notes have been 

created by holding Alt while using live note editing, when cutting material to the clipboard, 

and when deleting in the MIDI CC editor. 

Key Editor Playing techniques for percussion instruments in the percussion editor are always now 

correctly listed under the appropriate instrument rather than in a single, mingled list. 

Key Editor When using per-switch delays in expression maps, it was possible for the tool tip giving 

detailed information about the playing technique region in the Key Editor to refer to the 

wrong region; this has now been fixed. 

Key Editor Copying and pasting material from multiple staves in the same instrument now correctly 

handles accompanying MIDI CC data, so that the MIDI data is pasted to the right staff. 

Key Editor It is no longer incorrectly possible to change the linear/constant type of the final data points in 

a user-created region in the dynamics and MIDI CC editors. 

Lines Dorico no longer incorrectly creates two identical note-attached lines between two selected 

notes. 

Live note editing The position of the live note editing overlay when the selected notes span multiple systems 

has been improved. 

Live note editing It is no longer possible to attempt to drag material off the start of the flow. 

Live Stage The performance of using the expand/contract buttons in the Live Stage in large ensembles 

has been significantly improved. 

MIDI export When exporting MIDI files using MIDI pitch bend for microtonal pitches, the underlying pitch 

of the note could be exported incorrectly, resulting in the wrong played pitch in the exported 

MIDI file; this has now been fixed. 

MIDI import Dorico no longer attempts to detect slurs for unpitched percussion material when importing 

MIDI data. 

MIDI import When dragging and dropping MIDI data into the percussion editor in the Key Editor, Dorico 

now uses the percussion map assigned to the appropriate endpoint, resulting in the same 

mapping onto instruments and playing techniques that are produced when importing the 

data via File ▶ Import ▶ MIDI. 

Navigation Under some circumstances, navigating to the staff above or below from a bar rest after the last 

note in a staff could fail; this has been fixed. 

Note input MIDI CC data is now always excluded when using Edit ▶ Paste Special ▶ Reduce. 
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Component Issue 

Note input If MIDI CC data is included when copying and pasting music, it is now correctly copied or 

moved to the adjacent staff when using Move/Duplicate to Staff Above/Below. 

Note input When creating an item with duration, such as a slur, with the mouse, it is now once again 

possible to create and extend the duration of the item in a single motion. 

Note input When recording into the first bar of a flow other than the first in the project, Dorico no longer 

incorrectly resets the sound used for auditioning to the first instrument in the ensemble. 

Ornaments Trills can once again be created using the mouse when there is no selection in the score. 

Page layout Selecting a barline and clicking Move to Previous System no longer incorrectly moves the bar 

following the barline to the previous system. 

Page layout Move Bar to Previous System no longer sometimes causes an extra bar to be moved back to 

the previous system. 

Playback Under rare circumstances, Dorico could crash when preparing for playback in some projects, 

which would manifest as apparently random crashes after making an edit; this has now been 

fixed. 

Playback Dorico now correctly takes repeat structures into account when evaluating the note length 

conditions to determine the correct expression map switch. 

Playback When using per-switch delay values for different switches in an expression map, notes at the 

end of a slur could be incorrectly truncated to a very short duration; this has now been fixed. 

Playback Suppressing the playback of a tempo item could incorrectly cause some bars to be skipped in 

playback; this has now been fixed. 

Playback A gradual tempo in a second ending now correctly takes its starting tempo from the last 

tempo before the first ending, rather than a tempo found in the first ending, if present. 

Play mode Some editing operations that involve the creation of a new voice could cause the per-voice 

tracks for instruments using independent voice playback to appear in the wrong vertical 

position in the track overview; this has now been fixed. 

Play mode Changing the port and channel for the current endpoint in the Routing section of the track 

inspector now works more reliably. 

Play mode Selecting a track corresponding to an independent voice now correctly updates the sound 

used for MIDI monitoring to the appropriate voice. 

Print mode When selecting multiple layouts and clicking Flows in the right-hand panel to specify a 

selection of flows to be printed, this choice is now correctly applied to all selected layouts. 



 

 

Dorico 5 Version History 72 Steinberg Media Technologies GmbH 

Component Issue 

Project files In rare circumstances, a project created in an earlier version could cause Dorico 5 to crash 

when opening it; this has now been fixed. 

Scrub playback The ←/→ shortcuts for advancing scrub playback now work correctly on both macOS and 

Windows with English and German keyboard layouts. 

Setup mode Some instruments were missing from the instrument picker; this has now been fixed. 

Setup mode When running Dorico in languages other than English, it was possible for the display of 

transpositions in the third column of the instrument picker to change unexpectedly when 

invoking the picker repeatedly; this has now been fixed. 

Setup mode Using Change Instrument no longer causes ties from grace notes to rhythmic notes to be lost. 

Stage templates If the Near send and Far send channels have gain set to -infinity or describe a range of zero, 

the behavior of instruments in the Live Stage has been improved. 

Tempo Under some circumstances, the vertical position of a tempo mark overlapping a multi-bar rest 

might not be stable as edits are made in the bars following the multi-bar rest; this has now 

been fixed. 

Tempo Relative tempo markings no longer show a numeric value in the auto-complete suggestions in 

the popover. 

Text Under some circumstances, the wrong style name could be chosen in the text editor popover 

when editing text; this has now been fixed (macOS only). 

Text When running Dorico in languages other than English, re-selecting a paragraph style in the 

Library ▶ Paragraph Styles dialog could cause the wrong style name to be shown in the Style 

name menu; this has now been fixed (Windows only). 

Text Under some circumstances, non-transposing instruments could incorrectly be appended 

with the word “in” when displayed via the {@staffLabelsFull@} token; this has now been fixed. 

Timecode Some projects created in earlier versions of Dorico that show a timecode staff could cause 

Dorico 5 to crash; this has now been fixed. 

Timecode Layouts with multiple instruments that show timecode and multi-bar rests now correctly only 

show timecode at the start of each multi-bar rest. 

User interface Clicking in any of the panels in Setup mode now closes the instrument picker, if it is open. 

User interface The Scrub Playback button in the mini transport on the toolbar and in the Transport window 

is no longer incorrectly enabled when the project is not activated for playback. 
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Component Issue 

User interface Tokens for accidentals are now correctly substituted with the appropriate plain text 

representation in the list of layouts shown in the Layout Options dialog. 

User interface Under some circumstances it was possible to get the gradient display in the Colors page of 

Preferences into a muddle; this has now been fixed. 

User interface On some computers, the release of the mouse button when clicking on buttons or using the 

pencil tool in the Key Editor would be lost; this has now been fixed (macOS only). 

User interface Groups of buttons that are supposed to allow only one choice to be selected now work 

correctly once more. 

User interface It is once again possible to drag drum pads in the lower zone to change their displayed order. 

User interface The Show system track in new projects option in Preferences now once again works more 

reliably. 

User interface Under rare circumstances, Dorico could crash when attempting to add a player after having 

changed the application language during that session; this has now been fixed. 

User interface The button to hide and show the Video window on the toolbar now works as expected. 
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Dorico 5.0.10 

30 May 2023 

Improvements 

Live note editing 
Dragging by octaves. You can now hold down Ctrl (Windows) or Command (macOS) after 

beginning to drag notes to edit their pitch to snap to octaves. 

MIDI trigger regions 
Suppress playback. It is now possible to use the Suppress playback property with MIDI 

trigger regions. 

Default key command. The default key command Shift+0 (zero) has now been added to 

the default shortcuts sets for languages other than English. 

Scrub playback 
Instrument filters. In galley view, scrub playback now respects the active instrument 

filter, if any. Only instruments included in the instrument filter will be played back. 

Scrub only selected staves. Dorico now considers the selection when you activate scrub 

playback: if you have selected items from more than one staff, Dorico will include 

only those instruments when scrubbing; you can still hold Shift to solo the 

instrument under the mouse pointer. 

Toggle Scrub Playback command. It is now possible to use the Toggle Scrub Playback 

command from Write mode, so it is practical to define a custom shortcut to this 

command if desired. 

Key commands. It is now possible to step forwards and backwards through the score 

when scrub playback is active using the left and right arrow keys. The playhead now 

appears while scrub playback is active, helping you to orientate yourself in the 

music when scrubbing with the arrow keys. 
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Issues resolved 
Component Issue 

Audio engine On some Windows computers, the VST audio engine was slow to start up; this has now been 

fixed. 

Instrument editor Setting an octave transposition in the instrument editor no longer sometimes triggers a crash. 

Instrument editor User-defined instruments and variants are now always correctly bracketed with other 

instruments in the same family. 

Instrument editor Under some circumstances, the star icon in the instrument editor would not be lit up for an 

instrument saved in the user library; this is now fixed. 

Instrument editor Toggling the filter to show only instruments in the project no longer incorrectly causes copies 

or variants of instruments you have created during that dialog session to disappear from the 

list of instruments. 

Instrument editor Adding both a copy and a variant of an instrument to the project library no longer incorrectly 

causes the first of those added instruments to lose its family associations. 

Instrument editor Creating a new variant of a factory instrument no longer prevents the creation of the original 

instrument in the project. 

Instrument editor Under some circumstances it was impossible to delete the copy of a factory instrument in the 

instrument editor; this has now been fixed. 

Instrument editor It is now possible to reset user-defined instruments back to their saved state in the user 

library. 

Instrument editor Controls related to pitched instruments are now correctly disabled for unpitched percussion 

instruments. 

Instrument editor Under some circumstances, selecting an instrument in the instrument editor that is one of 

several held by the same player could cause a crash; this is now fixed. 

Key Editor The piano roll and other editors in the Key Editor now correctly update immediately after 

editing grace notes in played durations mode. 

Key Editor The piano roll and other editors in the Key Editor now correctly update immediately after 

editing articulations, slurs, glissando lines and octave lines in the music area. 

Key Editor The piano roll and other editors in the Key Editor now correctly update immediately after 

notes are input via MIDI keyboard. 

Key Editor Further improvements to the reliability of the vertical crosshair in the Key Editor, including 

ensuring that it immediately follows the mouse pointer when the zoom level changes. 
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Component Issue 

Live note editing When dragging notes rhythmically in galley view, notes no longer sometimes seem to bunch 

up at barlines. 

Live note editing Pitches in arbitrary EDO tonality systems are now correctly transposed when dragged with the 

mouse. 

Live note editing The durations of tied notes are now considered in the width of the overlay that shows the 

duration of the selection being dragged rhythmically. 

Live note editing Dragging cross-staff notes now works as expected. 

Note input In certain circumstances, Dorico could crash when using Insert mode to extend the duration 

of the current bar; this has now been fixed. 

Project files Dorico no longer crashes when opening some projects created in earlier versions. 

Text Italic, bold, and bold italic font styles now preview correctly in the Paragraph Styles dialog 

when running Dorico in languages other than English (Windows only). 

Time signatures Interchangeable time signatures are now correctly preserved when opening a saved project. 

User interface In some windows and dialogs, spin boxes would require you to move focus from them before 

they would register the change in value; now, the value is updated as soon as the contents of 

the input field changes. 

User interface The MIDI Import Options dialog now shows resize arrows at its edges when opened from the 

Hub window. 

User interface Under rare circumstances, changing one of the values for the Single Color and Gradient 

buttons in the Background Colors section of the Colors page of Preferences could cause the 

corresponding buttons for the other window mode to change unexpectedly; this has been 

fixed. 

User interface Dorico no longer crashes when you attempt to reset background colors when set to use a 

Single Color. 

User interface The instrument picker no longer lists duplicate instruments when running Dorico in a 

language other than English. 

User interface The initial state of the Follow playhead switch in the status bar for a newly-created project 

now correctly reflects the corresponding preference value. 

User interface It is now possible to close the toolbar layout selector by clicking outside its area. 

User interface Certain drop-down menus would open in full screen mode if the project window was already 

in full screen mode; this has now been fixed (macOS only). 
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Component Issue 

Video Attached videos are once again synced correctly during playback; they are not currently 

synced correctly during real-time recording, which will be addressed in future. 
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Dorico 5.0 

23 May 2023 

New features 

Space and Stage templates 
Dorico 5 helps you sculpt the sound of your playback with new tools to help you 

create a convincing performance: the players can be positioned on a stage, and that 

stage placed in a space with natural reverberation. 

Increasingly, orchestral sound libraries are recorded with a variety of microphone 

positions and with the musicians seated in the studio or hall in their usual 

performance configuration, so that the ensemble has a natural stereo field and a 

balanced sound. If you use the tree or hall mics rather than the close mics, you also 

get a strong sense of the space in which the library was recorded. 

This approach means that it’s easy to get a convincing sound for the ensemble, 

because the recording engineers have done all the hard work for you. The downside 

of this approach is that if you want something different, it can be harder work to 

achieve it. 

Some orchestral sound libraries – including HALion Symphonic Orchestra, the 

orchestra that ships with Dorico Pro – are recorded in a much more neutral way 

with close microphones, and with all the instruments positioned close to the center 

of the stereo field. 

This approach provides greater flexibility, as it means the sounds can be easily used 

at any stereo position, and it’s easy to try different levels of reverberation. But it also 

means that some work is required to separate the instruments on the virtual stage, 

and to provide appropriate effects to give the sound a particular character. 

Things get more complicated still when mixing patches from different libraries, 

recorded in different halls or studios and with different mic configurations.  

Experienced sound engineers have the skills to meet these challenges – and some 

improvements to the flexibility of Dorico’s mixer, including the ability to create up 

to eight send channels, are designed to help experienced users achieve their 

desired results more efficiently. 

But many composers and arrangers have little experience with mixing and shaping 

sound in this way. For these users, Dorico’s new space and stage templates will help 

them to produce convincing sounding ensembles more quickly and easily. 
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While these new features are no substitute for dedicated software solutions 

designed to emulate in precise detail the placement of instruments in a specific 

hall, such as Vienna Symphonic Library’s MIR, they provide convenient ways to 

make greater use of the high-quality effects plug-ins supplied with Dorico, and the 

automatic application of appropriate settings for each type of ensemble make an 

immediate and positive impact on the depth of the sound of Dorico’s playback, even 

if you are using only the factory-supplied sounds. 

Stage templates. Stage templates describe the position of players on a nominal stage. 

Imagining that you are looking down on the stage from directly above, the front of 

the stage is at the bottom, and the rear of the stage is at the top. Players can be 

positioned anywhere within this space. Changes in horizontal position from left to 

right are translated into stereo pan values, while changes in vertical position from 

near to far are translated into values for send channels: typically, the counterpart 

space template will define two send channels, one for near instruments with less 

reverb, and one for far instruments with more reverb. 

Stage templates can be defined very coarsely, with simple placement of entire 

instrument families on the stage, or very finely, with placement not only of 

individual instruments, but even multiple players of the same instrument, so that 

two violin sections can be differently placed, or four horn players, and so on. 

Applying a stage template. When you start a new project from one of the factory 

templates, one of the default stage templates is automatically applied. To reapply 

the current stage template, which resets any adjustments you have made to the 

positions of players in the Live Stage, or to apply a different stage template, choose 

Play ▶ Stage Template. 
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Choose the template you want to apply to the project and click Apply and Close. 

Factory templates are indicated in the dialog with a factory icon, and factory 

templates cannot be edited. However, you can create a new stage template based on 

a factory template by clicking Duplicate Stage Template. 

Live Stage. To see the effect of the current stage template, open the Live Stage window by 

clicking  in the Mixer toolbar, either in the lower zone or the separate Mixer 

window. 

 

Typically, every instrument in the project will appear on the Live Stage. However, an 

instrument will not appear if: 

§ the expression map or percussion map used for this instrument specifies 

that space templates should not be used, because the sound source is pre-

positioned; or 

§ the instrument is played by a MIDI device rather than a virtual instrument. 

To move an instrument in the stereo field, click and drag it to the desired position. 

When you release the mouse button, the new position will be applied to the pan and 

send amounts for that instrument’s output or outputs in the Mixer. 

You can expand or contract the overall stereo field for all instruments at once by 

clicking the Expand ( ) or Contract ( ) buttons. 

Creating a stage template from the Live Stage. A natural way to build your own stage 

template is to start from an existing project, where you can hear for yourself the 

effect of positioning each instrument on the stage. If you want to save the current 
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Live Stage setup as a stage template for future use, click Save as new Stage 

Template, which opens the Edit Stage Template dialog – see below. 

Editing a stage template. To edit a stage template, choose Play ▶ Stage Template, choose 

the stage template you want to edit, and click Edit. If the stage template you want to 

edit is a factory default, click Duplicate Stage Template first. 

 

Edit Stage Template is like the Live Stage, except that it allows you to define the 

positions for instruments, and entire instrument families, regardless of whether 

they are present in the current project. 

Instrument families are shown on the stage in a larger size than specific 

instruments. Each family is color-coded, so both the family itself and the 

instruments in the family are shown in the same color. 

To add an instrument family to the stage template, simply click and drag the top-

level item from the tree view on the left of the dialog onto the stage. To add an 

individual instrument, expand the tree view to find the specific instrument you’re 

looking for (or type its name in the search box to filter the list), then drag it onto the 

stage. Alternatively, simply select the family or instrument in the tree view and click 

the Add button in the action bar, which will place the instrument in the center of the 

stage. 

Reposition any family or instrument simply by dragging it on the stage, or remove it 

from the stage by clicking the Delete button in the action bar. 

As the stage becomes fuller, you might find it helpful to toggle whether the names 

for instruments and families appear; the switches above the stage make this 
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possible. You cannot select or drag items on the stage to reposition them if their 

names are not shown. 

As you add more instruments of the same kind to the stage, they will each be 

numbered. You can also click the Soloist button in the action bar to specify where 

an instrument of that kind that is set to be a soloist should be placed on the stage. 

You can also create groups of instruments, so that you can position those groups 

independently. For example, in a piece for double choir, you may want to position 

one choir on the left of the stage and the other on the right. The groups you define in 

the stage template will be used when you group players in Setup mode, as 

appropriate. 

When Dorico is positioning an instrument added to your project according to the 

current stage template, it uses the following order of precedence: 

§ First, it will use the corresponding numbered instrument, if any; 

§ Second, it will use the unnumbered instrument in the group, if any; 

§ Third, it will use the appropriate instrument family in the group, if any. 

Each of these rules is applied first to groups of instruments, if defined, and then to 

ungrouped instruments. If an instrument is designated as a soloist in Setup mode, 

then it will first prefer the corresponding soloist instrument on the stage, if any, 

before falling back using the order of precedence described above. 

Space templates. Space templates describe a nominal room into which any stage can be 

placed. In simple terms, a space template defines one or more preset send channels 

in the Mixer, and a set of minimum and maximum values for pan and for the send 

amounts to be used for each instrument on the stage. You can define different send 

channels for instruments towards the front of the stage (Near Send) and towards 

the rear (Far Send), or use the same channel for both. (Dorico’s default space 

templates use a single send channel with a single reverb plug-in to conserve system 

resources.) 

As you move instruments around the Live Stage, Dorico uses the values defined in 

the space template to adjust the Mixer settings for that instrument’s output or 

outputs. Lateral movement left or right adjusts the pan for that output, and the 

space template specifies the maximum left and right pan values that Dorico is 

permitted to use. 

Vertical movement from near to far adjusts the send values for that output: if you 

have the same send channel configured for both Near Send and Far Send, Dorico 

simply scales the send amount between the Near Send and Far Send values as you 

move the instrument between the front and rear of the stage. If you have different 
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send channels configured for Near Send and Far Send, Dorico scales between the 

specified value and zero, effectively cross fading the send amount between the two 

sends. 

Factory stage templates. A set of factory stage templates (Barbershop Quartet, Big Band, 

Brass Band, Chamber Brass, Chamber Strings, Chamber Woodwinds, Choir, 

Concert Band, Orchestra, Piano Trio, Saxophone Quartet, Small Jazz) is now 

included with Dorico 5. Projects created via the Create New page of the Hub now 

choose an appropriate stage template by default. Any of these stage templates can 

be applied to your own project via Play ▶ Stage Template. 

Dorico includes the REVerence convolution reverb plug-in, which includes more 

than 90 impulse responses, providing realistic representations of concert halls, 

churches, cathedrals, ballrooms, and recording studios. Using REVerence, or your 

own preferred reverb, you can create a space with exactly the kind of sound you 

want to hear. 

Applying a space template. When you start a new project from one of the factory 

templates, one of the default space templates is automatically applied. To reapply 

the current space template, which resets any adjustments you have made to the 

positions of players in the Live Stage, or to apply a different space template, choose 

Play ▶ Space Template. 

 

Choose the template you want to apply to the project and click Apply and Close. 
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Factory templates are indicated in the dialog with a factory icon, and factory 

templates cannot be edited. However, you can create a new space template based 

on a factory template by clicking Duplicate Space Template. 

Live Space. The Live Space window allows you to adjust the maximum pan and send 

values for the current project. open the Live Stage window by clicking  in the 

Mixer toolbar, either in the lower zone or the separate Mixer window. 

 

Configuring the Live Space is simple: the Left Pan and Right Pan values define the 

maximum pan value for instruments positioned at the extreme left and right of the 

Live Stage, and the Near Send and Far Send values define the named send channel 

and the amount of signal to be routed to that channel for instruments positioned at 

the extreme front or rear of the Live Stage. The pan and send values for instruments 

positioned anywhere in the two-dimensional space of the stage are determined by 

interpolating between these values. 

Fallback Y Position specifies the default near-far position for an instrument that is 

not defined in the stage template, expressed as a value between zero (meaning the 

front of the stage) and one (meaning the rear). 

Click Reverb specifies which send channel should be used for the metronome click 

output in the Mixer: you may want to use the same reverb you use for other 

instruments, a different send channel, or none. 

Although you can choose which send channel in the Mixer is used for Near Send 

and Far Send, you cannot directly configure these channels via the Live Space 

window: instead, you do so in the Mixer window. 
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When you want to create your own space template, this is how you begin: set up the 

send channels in the Mixer with the plug-ins you want to use, configure the settings 

in the Live Space window, then click Save as Space Template to open the Edit 

Space Template dialog. 

Editing a space template. Whether you choose to save a space template from the Live 

Space window, or you duplicate a factory space template via the Play ▶ Space 

Template dialog, you will see the Edit Space Template dialog. This dialog is 

identical in operation to the Live Space window, with the addition of an input field at 

the top of the dialog to allow you to specify the name of the space template. 

Multiple send channels. You can now add FX send channels to the Mixer, up to a 

maximum of eight channels. Click FX+ in the Mixer window toolbar to add a new 

send channel. Only the rightmost send channel can be deleted, so the FX- button is 

only enabled when selecting the rightmost send channel. You will also notice that 

faders for send channels in the Mixer now have a different colored background. 

Renaming Mixer channels. It is now possible to rename channels in the Mixer. Simply 

double-click the channel label at the bottom of the fader, either in the lower zone 

Mixer or the separate window, type the new name, and hit Return. To reset the 

name back to its default, simply clear the contents of the editor and hit Return. 

Factory space templates. A set of factory space templates (Ballroom, Church, Concert 

Hall, Recording Studio, Scoring Stage) is now included with Dorico 5. Projects 

created via the Create New page of the Hub now choose an appropriate space 

template by default. Any of these space templates can be applied to your own 

project via Play ▶ Space Template. 

Playback templates. When exporting a playback template, if a space template is 

specified, it will be exported as part of the exported playback template. 

Subsequently importing that playback template will also import the space template, 

and it will appear in Play ▶ Space Template. 

Multiple send channels. You can now add FX send channels to the Mixer, up to a 

maximum of eight channels. Click FX+ in the Mixer window toolbar to add a new 

send channel. Only the rightmost send channel can be deleted, so the FX- button is 

only enabled when selecting the rightmost send channel. You will also notice that 

faders for send channels in the Mixer now have a different colored background. 

Renaming Mixer channels. It is now possible to rename channels in the Mixer. Simply 

double-click the channel label at the bottom of the fader, either in the lower zone 

Mixer or the separate window, type the new name, and hit Return. To reset the 

name back to its default, simply clear the contents of the editor and hit Return. 
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Default stage and space templates for new projects. When you start a new project, the 

stage template defined in the project template will be used, if present; otherwise, 

the stage template specified in Default stage template on the Play page of 

Preferences will be used. 

The choice of space template for a new project is governed by one of three things: 

the playback template, the choice of space template defined in the project template, 

or the space template override in Preferences. 

If Space template override is set on the Play page of Preferences, Dorico will always 

use that space template when starting a new project and when applying or re-

applying a playback template. If it is not set, Dorico will use the space template 

specified in the project template when starting a new project, or in the current 

playback template when it is applied. 

If you have your own preferred reverb, compressor, or other settings that you 

always want to be applied to every project, define that setup as a space template and 

then choose it under Space template override in Preferences. 

Expression and percussion maps. You can specify in an expression map or a percussion 

map whether Dorico should apply the settings of the current stage and space 

templates to the endpoints using these maps. 

If the instrument or library you are using was recorded in situ, you probably don’t 

want to apply the stage template, and if the library has its own recorded 

reverberation, you likewise probably don't want to apply the space template. For 

example, NotePerformer, which handles stereo position and reverb on its own, is 

set by default not to apply either a space or a stage template. 

Pitch contour emphasis 
In Dorico 5, melodies play back more expressively and with a human touch, thanks 

to its new pitch contour emphasis algorithms. Previous versions of Dorico already 

include features to prevent playback sounding mechanical, including 

“humanization” which involves adding tiny amounts of randomness in timing and 

dynamics. Pitch contour emphasis augments these existing features with 

something more nuanced. 

Human musicians naturally make higher notes in phrases slightly louder than 

lower ones. However, it is insufficient to simply make all notes progressively a little 

louder as their pitch rises: human musicians are much more subtle, and the frame 

of reference for changes of dynamic tends to be a time window of a few seconds. 



 

 

Dorico 5 Version History 87 Steinberg Media Technologies GmbH 

Dorico emulates the subtle changes in dynamic in musical phrases produced by 

human musicians, making the performance more expressive but without 

exaggerating the rise and fall of the melody. 

The identification of pitch contour within a melody is based on a several heuristics 

including relative and absolute pitch, relative note timing and absolute note 

duration. The effect acts each staff individually, so notes on different staves – even 

different staves belonging to the same instrument – will not be treated as part of 

the same melodic line, except for notes that have been crossed from one staff to 

another. For polyphonic instruments, the top note of each staff is what will be 

considered when identifying melodic direction. 

Pitch contour emphasis is enabled by default in new projects, but is disabled in 

existing projects to avoid any unexpected changes in dynamics when playing back 

in Dorico 5. 

The options for pitch contour emphasis are found on the Dynamics page of 

Playback Options, in the Humanize section: 

§ Use pitch contour emphasis controls whether the effect is on at all. 

§ Scale effect by allows the effect to be turned up or down relative to the 

default level. 

§ Maximum change to written dynamic specifies the maximum change in 

dynamic level that Dorico can make in either direction. However high you 

turn up Scale effect by, the change in dynamic level will never be allowed to 

exceed this value. The default limit is 1.5 dynamic levels, although when 

Scale effect by is 100%, the maximum effect will be closer to 1.25 levels in 

any case. 

These values can also be overridden within an individual expression map. 

Be aware that pitch contour emphasis can cause the dynamic level to go below as 

well as above the default dynamic level - this is necessary to produce smooth 

transitions between ascending and descending melodic lines. However, any 

decrease caused by a descending line will be much smaller than an increase caused 

by a rising line. 

Beat stress. Because pitch contour emphasis produces a similar amount of dynamic 

change to beat stress and dynamic humanization, the existing defaults for those 

features have been adjusted for new projects. If you have your own custom settings, 

you may wish to change them. 

Because pitch contour emphasis does not affect unpitched percussion, the existing 

beat stress options can usefully be set to a higher value for percussion than for 
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pitched material. As such, the Beat stress options in the Note Dynamics section of 

the Dynamics page of Playback Options now provide separate values for pitched 

and unpitched instruments. 

Similarly, the Humanize written dynamic by n% option in the Humanize section 

also now provides separate values for pitched and unpitched instruments. 

Groove Agent SE 
Groove Agent SE is the entry-level version of Steinberg’s creative drum software 

and is now included with Dorico 5. It includes a version of The Kit, an acoustic drum 

kit recorded in Berlin’s Teldex Studios, including its classic reverb chamber, and 

provides a choice of two mic positions. 

Not only can Groove Agent SE be used as a high-quality drum kit playback device 

for your Dorico projects, but it also includes more than 400 MIDI drum patterns, 

performed by top studio drummers, and mixed by Steinberg’s expert engineers. 

You can trigger these in Dorico using the new MIDI trigger region or drag and drop 

any pattern onto the track overview in Play mode to import that pattern. 

Installing Groove Agent SE is optional but recommended. 

Factory playback templates. If Groove Agent SE is installed, Dorico will show two 

additional playback templates: HSSE+HSO+GASE (Pro) (Dorico Pro only) and 

HSSE+GASE (Elements) (Dorico Pro and Dorico Elements only). These playback 

templates will automatically load Groove Agent SE when you add a drum set to your 

project and use the sounds of the included Studio Kit for playback; these sounds are 

of superior quality, with greater variety, than the standard drum set in the HALion 

Sonic factory content. 

When Groove Agent SE is loaded, Dorico automatically loads the Studio Kit and a 

patch containing rock/country patterns. It is also configured such that patterns only 

respond to notes on MIDI channel 2, to avoid interference between the pitches used 

to trigger patterns and some of the extended techniques supported by the Studio 

Kit. When you use a MIDI trigger region to play patterns in Groove Agent SE, Dorico 

automatically directs the MIDI notes to channel 2 as required. 

None of the kits included with Groove Agent SE include woodblocks, so if you add a 

full drum set instrument to your project, or configure the drum set to have 

additional instruments, Dorico will load the standard HALion Sonic drum set or 

other unpitched percussion sounds as available to play back those instruments. 

When you first run Dorico 5, if Groove Agent SE is installed, Dorico will choose the 

appropriate Groove Agent-enabled playback template as your default playback 

template. If you are updating from Dorico 4 or earlier, Dorico will only choose the 
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Groove Agent-enabled playback template if the equivalent default playback 

template was chosen as the default in your previous version. You can adjust this at 

any time on the Play page of Preferences. 

Setting up Groove Agent SE manually. If you are not using a playback template that 

includes Groove Agent SE, you will need to set it up manually in your project. The 

first step is to add Groove Agent SE to the rack: 

§ Switch to Play mode. 

§ In the left zone, choose the VST and MIDI panel. 

§ Click  in the action bar at the bottom of the VST Instruments section to 

add an empty entry to the rack. 

§ Using the menu in the empty rack entry, choose Steinberg ▶ Drum ▶ 

Groove Agent SE to load the plug-in. 

The Groove Agent SE window is split into four main areas: 

§ Kit slot: located in the top left of the window, this shows the name of the 

loaded kit, allows you to load a different kit, and change some settings, 

including whether any associated MIDI patterns should be loaded when the 

kit is loaded ( ). 

§ Kit rack: located in the top right of the window, this shows the loaded kit. (In 

the full Groove Agent plug-in, you can load up to four kits here, but Groove 

Agent SE allows only one.) 

§ Pad section: located in the bottom left of the window, this section contains 

transport controls, group buttons, and drum pads. When the pad section is 

in Instrument mode, each pad corresponds to a single instrument in the kit; 

when in Pattern mode, each pad corresponds to a different pattern. 

§ Edit display: located in the bottom right of the window, the edit display 

contains the Edit, Mixer, and Options pages. 

At the top right-hand corner of the edit display, you will find two other useful 

buttons:  expands the window downwards to show a piano keyboard; and  

expands the window rightwards to show the MediaBay panel, allowing you another 

way to browse and load kits. 

To load a kit, either click the name of the kit in the kit slot, or the label below the 

empty slot in the kit rack. The small MediaBay panel appears: 
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Click the menu at the top of the panel to choose between the available kits, or click 

All to populate the panel with patches from all the kits. If you want to use Groove 

Agent SE’s MIDI patterns, make sure the Load Kit with Pattern button ( ) is 

activated in the top right-hand corner. Double-click the kit to load it. 

Once a kit is loaded, you need to connect the plug-in to a drum set in your project: 

§ Switch to Play mode. 

§ In the left zone, choose the Track Inspector panel. 

§ Select the drum set track in the track overview. 

§ In the Routing section of the track inspector, choose Groove Agent SE from 

the plug-in menu. 

§ Open the Endpoint Setup dialog by clicking . 

§ In Endpoint Setup, choose Groove Agent SE Studio Kit under the 

Percussion Map column for channel 1, and click OK. 

Now when you write music in your drum set staff, it will be played back by Groove 

Agent SE instead of the default drum kit in your chosen playback template. 

For more information on how to use Groove Agent SE, please refer to its dedicated 

Operation Manual. 

Using MIDI patterns. If the kit you have loaded into Groove Agent SE includes MIDI 

patterns, the Pattern button in the pad section shows a small orange activation 

indicator directly above it: click this, and the pad section will display a grid of 

patterns: 

https://steinberg.help/groove_agent_se/v5/en/
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Patterns are color-coded: regular (or “main”) patterns are yellow; fills are blue; 

intros are green, and endings are red. 

In the top right-hand corner of each pad, the MIDI pitch required to trigger this 

pattern is displayed. These MIDI pitches are displayed according to the convention 

that middle C (MIDI note 60) is C3. You may find it useful to set Dorico to use the 

same middle C convention, which you can do on the General page of Preferences: 

set Middle C (note 60) to C3. 

You can drag and drop a pattern into the track overview in Play mode or into the 

percussion editor in the Key Editor to import that pattern into your score: a red 

insertion point shows where the pattern will begin. 

The other way to use patterns is to trigger them using Dorico 5’s new MIDI trigger 

regions – see below. 

MIDI trigger regions 
The Key Editor allows you to output MIDI continuous controller values, pitch bend, 

tempo changes, and so on, all without affecting the printed score, but one thing it 

cannot do is output notes that are not printed in the score. 

This is what Dorico’s new MIDI trigger regions are designed to do: play a note or 

chord that doesn’t appear in the score for a period determined by you. 

This is especially useful for triggering MIDI patterns in plug-ins like Groove Agent 

SE, or other pattern-based instruments such as TGuitar. If you’re writing for a real 

drummer or guitarist, you don’t need to write out their part in full: give them the 

structure of the piece, a few rhythmic cues, and chord symbols, and they’ll take care 

of the rest. But if you want to have some realistic playback without spending a lot of 

time and effort writing out music that won’t ultimately be played by your human 

musicians, pattern-based plug-ins can save a lot of time. 
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Creating a MIDI trigger region. You can create a MIDI trigger region as follows: 

§ Select the region over which you want the note or notes to be played. 

§ Choose Write ▶ Create MIDI Trigger Region, or use the shortcut Shift+0 

(zero), to open the MIDI trigger region popover. 

§ Either type the names of the notes you want to be played, or play them on 

your MIDI keyboard, and hit Return. 

The MIDI trigger region is created in the score, with a light blue bar below the staff 

showing the names of the pitch or pitches that will be played for the duration of the 

region. 

When the popover is open, you can repeatedly play single notes or chords on your 

MIDI keyboard, allowing you to audition different patterns in Groove Agent SE or 

another pattern-based plug-in. Each separate note or chord you play while the 

popover is open replaces the previous note or chord, so you can try out as many 

different notes as you want before you hit Return. 

Specifying velocity. If you use a MIDI keyboard, you will also see the velocity of the note or 

chord you just played, appended to the list of pitches in parentheses. Dorico will 

play the notes defined in the MIDI trigger region at this velocity; if no velocity is 

specified, Dorico will use a default value, roughly equivalent to a dynamic of . 

You can also type a velocity value when typing into the popover: simply specify the 

velocity as a value between 0 and 127 in parentheses following the last pitch. 

Editing MIDI trigger regions. To change the note or chord played by an existing MIDI 

trigger region, select it and hit Return to reopen the popover: type or play the new 

note or chord to be played by the region, and hit Return to confirm the changes. 

MIDI trigger regions work the same way as other regions, such as bar repeat, 

rhythmic slash or chord symbol visibility regions: they can be moved, lengthened 

and shortened using the circular handles that appear when the region is selected, 

or you can use the standard Alt+←/→ shortcuts to move the region, and 

Shift+Alt+←/→ to shorten and lengthen the region. 

Viewing MIDI trigger regions. MIDI trigger regions won’t print (unless the View options 

checkbox is activated in the Annotations section of the right zone in Print mode). 

They appear on-screen by default, but you can hide or show them by toggling View 

▶ Highlight MIDI Trigger Regions. 

Middle C convention. The note names displayed in MIDI trigger regions follow the Middle 

C (note 60) option on the General page of Preferences. If you are using a plug-in 

that numbers middle C as C3, like Groove Agent SE, you may find it useful to set this 
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option to C3 so that the octave numbers shown in the MIDI trigger region match the 

octave numbers shown in the trigger pads in Groove Agent SE. 

Scrub playback 
Scrubbing is a term that dates from the days of editing audio tape, where the tape 

was manually dragged across the replay head by rotating the reels to locate an edit 

point, using an action like the cleaning action of scrubbing. In modern software, 

scrubbing has come to mean the process of playing the audio at variable speeds, 

either forwards or backwards, as the user drags with the mouse or uses a jog wheel 

to locate an edit point. 

In music notation and composition software, scrubbing can also be useful, even 

though the kinds of editing performed on music notation differs significantly from 

digital audio editing. As such, Dorico 5 introduces a new scrub playback feature that 

makes it easy to audition the whole ensemble or a single instrument at any point 

and move forwards or backwards through the playback at any speed. 

Enabling scrub playback. You can enable scrub playback in Write mode in any of the 

following ways: 

§ Choose Play ▶ Scrub Playback; or 

§ Activate the scrub playback button on the toolbar, found between the tempo 

read-out and the button to open the Transport window; or 

§ Hold down Ctrl+Space (Windows) or Alt+Space (macOS). 

When scrub playback is activated via the Play menu or the toolbar button, it 

remains active until you explicitly deactivate it, either by hitting Esc, choosing the 

Scrub Playback menu item again, or deactivating the toolbar button once more. 

However, when scrub playback is activated via the keyboard shortcut, it remains 

active only as long as the keys are held down. 

Using the keyboard shortcut is very convenient, as it allows you to quickly activate 

scrub playback for just a moment. (In this way, it’s like the instant print preview that 

can be activated by holding down the ~ key, and which temporarily hides all non-

printing items while you keep the key held down.) 

When scrub playback is active, as you move the mouse cursor over the music area, 

the cursor is shown as a speaker, and the notes that are sounding at the rhythmic 

position under the mouse cursor play continuously, allowing you to control when 

you move to the next or previous chord simply by moving the mouse cursor. 

Soloing an instrument. By default, Dorico plays all the notes at the rhythmic position 

under the mouse cursor; to solo the instrument directly under the mouse cursor, 

hold Shift. If you are holding down the Ctrl+Space (Windows) or Alt+Space (macOS) 
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shortcut to activate scrub playback, you must additionally hold down Shift to solo 

the instrument under the mouse cursor. 

Grace notes. Non-rhythmic notes like grace notes are not played during scrub playback. 

Repeats. When scrubbing through music with repeats, Dorico always plays the music as 

if for the first pass through the repeated section. 

Instrument editor 
Dorico has a database of more than 600 instrument types, which define the 

attributes that determine how the instrument appears, is labeled, and plays back in 

your project. This includes staff labels, transpositions, standard and advanced 

ranges, number of staves, number of staff lines, default clefs, and more besides. 

Dorico 5 introduces a new Library ▶ Instruments dialog that allows you to edit these 

definitions and define new instruments. You can save your changes and new 

instruments for use in future projects. 

Opening the instrument editor. There are two routes to open the instrument editor: 

§ In Setup mode, expand the card for the player holding the instrument you 

want to edit, open the instrument’s context menu by clicking … and choose 

Edit Instrument Definition. The instrument editor opens with the chosen 

instrument selected, ready for editing. 

§ Choose Library ▶ Instruments. The instrument corresponding to the first 

staff in which you have something selected in the score is selected, ready 

for editing. 

Project instruments and library instruments. The instrument editor lists each instrument 

type only once. If a particular instrument type is in use in your project, it appears in 

the left-hand list with (in score) appended to its name. Any edits you make to that 

instrument definition will be applied to all the instruments of that type in the 

project. 

For example, in the common case that you have two violins in your project, in the 

instrument editor you will see a single entry in the left-hand list, Violin (in score), 

and any changes you make will be applied to both violins in the project. 

If you have identical instruments in your project and you want to make changes to 

each of them individually, first use the instrument editor to create a new variant of 

the instrument definition, and then use Change Instrument in Setup mode to use 

the new variant for the relevant instrument. 

For any instrument that is not yet in your project, and changes you make in the 

instrument editor will be saved to the project’s library. When you subsequently 
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create an instrument that uses this edited instrument definition, it will reflect the 

edits you made earlier on. 

If you want to make edits to instrument definitions, or new instrument definitions, 

available in future projects, click Save as Default ( ) in the action bar: when the 

star icon is filled, the selected instrument definition matches the definition saved in 

your user library, thereafter available in all new projects. 

Click the Show only project instruments button ( ) at the top of the instrument list 

to quickly filter the list of instrument types such that only the project instruments 

are shown. 

You can otherwise filter the list of instruments by family using the Filter by family 

menu, or by typing all or part of the instrument’s name in the Search instruments 

input field at the top of the list of instruments. 

Edit Instruments dialog. The dialog looks like this, and is split into sections, as follows: 

 

Instrument section: 

§ Name in instrument picker is the name used in the middle column of the 

instrument picker. 

§ Variant name is the name used in the rightmost column of the instrument 

picker, if there are multiple variants for the parent instrument. Click the 

Reset variant description button to reset this to its default value. 
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§ Families is a read-out showing which families an instrument belongs to. 

You cannot yet edit this, but this is planned for a future release. 

§ If the instrument is a fretted instrument, the Edit Strings and Tunings 

button will appear; when clicked, this opens the usual editor for fretted 

instrument strings. 

§ If the instrument is a percussion kit, the Edit Percussion Kit button will 

appear; when clicked, this opens the usual editor for percussion kits and 

instruments. 

In the Staff Labels section, the current values for each of the names used in staff 

labels appears; to edit any of them, click Edit Instrument Names. 

Staves and Clefs section: 

§ Number of staves determines how many staves the instrument should 

have by default. 

§ Number of staff lines determines the number of staff lines shown in each 

staff belonging to the instrument. Even if you change the number of staff 

lines, Dorico will still treat the instrument as a pitched instrument. Dorico 

does not properly support pitched instruments with staves with more or 

fewer than five lines, so be prepared for some interesting results if you stray 

too far here. 

§ If the instrument has more than one staff, Span of barline allows you to 

specify which staves (from top to bottom) should be joined by a barline. 

§ Similarly, Span of bracket allows you to specify which staves should be 

joined by a bracket or brace, and the choice of what kind of primary bracket 

should be used can be specified by choosing either Bracket or Brace. 

§ Activating Vocal staff means that dynamics will go above the staff by 

default, and that barlines that would otherwise be joined to adjacent staves 

in the same primary bracket group should be broken, in service of making 

lyrics more legible. 

§ For each default staff defined for the instrument, you can specify the Clef 

for transposing layouts, and optionally a different Clef for non-transposing 

layout as well. 

In the Transposition section, you can specify the transposition interval for the 

instrument: 

§ Written middle C (note 60) sounds as specifies an octave transposition in 

concert pitch layouts: for example, assuming you are using the C4 middle C 

convention, for a guitar (which sounds one octave lower than written), this 

would be set to C3; for a piccolo (which sounds one octave higher than 

written), this would be set to C5. 
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§ In a transposing score, written middle C (note 60) sounds as specifies the 

transposition in a transposing layout: for example, again assuming C4 as 

middle C, an alto saxophone (which sounds a major sixth lower than 

written) would be set to Eb3, while a contrabass clarinet (which sounds two 

octaves and one whole step lower than written) would be set to Bb1. 

§ Uses key signature determines whether the instrument shows key 

signatures, or instead shows accidentals as required for every note. 

Finally, the Range section allows you to specify the standard and advanced ranges 

for the instrument, which are used when View ▶ Note and Rest Colors ▶ Notes Out 

of Range is activated. The pitches between the End values of Standard range and 

Advanced range are shown in dark red, while any pitch higher than the End value 

for Advanced range is shown in bright red. Likewise, the pitches between the Start 

values of Advanced range and Standard range are shown in dark red, while any 

pitch lower than the Start value for Advanced range is shown in bright red. 

Change instrument. In previous versions, the Change Instrument command in the 

instrument’s context menu in the Players panel in Setup mode was unavailable if 

the instrument had any additional staves, for example ossias, divisi staves, or extra 

staves added after the instrument was first created. These limitations have now 

been removed, though there are some caveats to be aware of: 

§ When reducing the number of staves in an instrument, any ossia staves 

associated with a staff that is removed will themselves be removed. 

§ When reducing the number of staves in an instrument, any extra staves 

beyond the new number of staves will be added as extra staves below the 

new lowest staff in the instrument. 

It is still not possible to use Change Instrument with percussion kits, but we plan to 

address this in a future release. 

Percussion kits. It is not currently possible to edit percussion kit instruments that exist in 

the current project via the Library ▶ Instruments dialog. As such, any percussion 

kits that are held by players in your project will not appear in the list on the left-

hand side of the Instruments dialog, and you cannot choose Edit Instrument 

Definition from the context menu for the instrument in the Players panel in Setup 

mode. We plan to relax this restriction in a future release. 

Instrument families and score orders. You cannot yet edit instrument families or the 

ordering used by Dorico when adding players and instruments to your project, but 

we plan to introduce editors for these in a future release. 
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Live note editing 
Dorico has historically never allowed the editing of the pitches or positions of notes 

using the mouse, with the justification that in other software this can be one of the 

most likely causes of inadvertent edits: you might be clicking and dragging to move 

the score in the view, accidentally click a note or, worse, a whole bar full of notes, 

and have edited the pitch before you really know what’s happened. 

However, we know that making these kinds of edits directly with the mouse can be 

very helpful, especially if you are already using the mouse when you spot the edit 

that you want to make. Furthermore, with the recent introduction of the Key Editor 

in Write mode, it became possible to edit the pitch and duration of notes in the 

piano roll editor using the mouse. 

Dorico 5, then, extends mouse editing in Write mode from the piano roll to the main 

music area, allowing you to edit the pitch or duration of selected notes by clicking 

and dragging. We have added constraints so that you can be sure you are editing 

either the pitch or the duration, but never both, and there is strong visual feedback 

in the score to ensure that you are always aware when you are editing the music. 

If you hold to Dorico’s original philosophy that it should be impossible to 

inadvertently edit the music with the mouse, you can also of course completely 

disable mouse-based editing of notes in Write mode if you prefer. 

Pitch edits. You can now repitch notes by dragging them vertically in Write mode. Hold 

Alt to copy them (so you can select a note or series of notes, hold Alt and drag up or 

down to build a chord). Dorico auditions each target pitch as you drag. 

In general, dragging notes up and down transposes the notes in the same way as 

transposing them stepwise with Alt+↑/↓. 

Rhythmic position edits. You can also move or copy notes to a new rhythmic position by 

dragging horizontally. Again, hold Alt to copy the music to the new position. The 

rhythmic grid appears as you drag to help you orientate the position at which the 

music will be dropped. The translucent rectangle showing the rhythmic extent of 

the passage being moved extends back to the start of any selected rests at the start 

of the selection, and to the end of the final note in the selection, to show you which 

music will be overwritten or displaced. 

This works as you would expect with Insert mode and chord input, allowing you to, 

for example, swap the material in two bars by engaging Insert mode and dragging 

the contents of one bar to the start of the next. 
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Visual feedback. During the drag, you will see ghost noteheads that correspond to the 

onset position for each note, and the region that will be affected is shown by a 

translucent rectangle that follows the ghost notes as they move. 

 

If you want to cancel your edit, simply hit Esc before you release the mouse pointer. 

Disabling mouse editing. If you want to disable this feature, deactivate the new Enable 

note pitch and rhythmic position editing using the mouse option on the Note 

Input and Editing page of Preferences. 

You can also toggle this mode of editing by assigning a custom key command to the 

Toggle Mouse Note Editing command in the Note Input category in the Key 

Commands page of Preferences or invoke this command using the jump bar. 

Multiple item creation 
Dorico 5 overhauls item creation from a selection: you can now create multiple 

items at the same time, on multiple instruments, and even at different positions on 

each instrument. 

In previous versions, selecting music across multiple staves and then creating an 

item via one of Dorico’s popovers or Write mode panels would create a single item 

at the earliest selected rhythmic position on the first selected instrument. There 

were a couple of notable exceptions to this rule: you can create slurs and dynamics 

on multiple instruments at the same time, and items that modify existing notes 

rather than creating new items (for example, articulations and jazz articulations) 

can be applied to all selected notes at the same time. Additionally, during note 

input, when the caret is extended across multiple staves, any item you create (for 

example, via a popover) will be created on all staves. 

Now, Dorico will create the specified item on each of the selected instruments: by 

default, it will do this at the rhythmic position of the first note in the selection on 

each instrument, which may be different, though you can specify that Dorico should 

instead create the item at the same rhythmic position (the earliest selected 

position) on each instrument if you prefer. 
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The items created on each instrument will also adapt to the selection on each staff. 

For example, when you select music across multiple instruments in which notes 

not only start at different positions, but the notes are of different durations or have 

rests at different positions, the item created on each instrument will have an 

appropriate duration. 

Some items have further special behaviors: for example, you can now select 

multiple chords and create arpeggio signs on each of them at the same time; and 

you can create multiple glissandos at the same time, including between chords with 

different numbers of notes or on different staves. 

Playing techniques. When creating playing techniques across a selection that spans 

multiple rhythmic positions on one or more instruments, Dorico now considers 

whether the underlying playback technique produced by the playing technique is a 

Direction or an Attribute. Direction playback techniques are sticky and last until 

they are countermanded by another playback technique, or are reset via naturale: 

for example, a pizzicato instruction. Attribute playback techniques, on the other 

hand, only last for the duration of the note on which they are written, automatically 

resetting at the next note; for example, an upbow or downbow instruction. 

Consequently, when you create a playing technique that maps to a Direction 

playback technique, Dorico creates a single playing technique with an appropriate 

duration, and draws either a continuation line or repeats the symbol according to 

the playing technique’s definition. 

When you create a playing technique that maps to an Attribute playback technique, 

by contrast, Dorico creates a separate playing technique on each selected note. This 

makes it very quick and easy to add bowing marks: select multiple notes, for 

example, with Ctrl+click (Windows) or Command-click (macOS), type Shift+P for 

the playing technique popover, type upbow, and hit Return. Each selected note will 

have an upbow playing technique added. 

Glissandos. In previous versions, to create a glissando you could either select both the 

starting and ending notes, or select the starting note and Dorico would 

automatically find the ending note when you create the glissando; in either case, 

Dorico could only create a single glissando line. 

Now, Dorico will automatically create as many glissando lines as possible within the 

selection: if you select a series of individual notes, Dorico will create a glissando 

between each pair of notes; if you select a series of chords, Dorico will create as 

many glissandos as it can between each chord, joining the highest notes of each 

chord, then the next highest, and so on, until it runs out of notes in either chord; this 
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even works across multiple staves belonging to the same instrument, making it 

very quick to create sweeping arpeggios for harp. 

Arpeggio signs. To create arpeggio signs on multiple chords at the same time, simply 

select each chord on which you want an arpeggio sign to appear, type Shift+O to 

open the ornaments popover, then type arp and hit Return. 

Ornaments and trills. Dorico now creates an ornament at each note position in the 

selection. 

A new option Create separate trills for each selected note has been added to the 

Note Input and Editing page of Preferences. When activated, Dorico will create a 

trill at each note position in the selection; when the option is deactivated, Dorico 

will instead create a single trill on each staff in the selection, starting at the first 

selected position and ending after the last selected position. 

Region-based items. Rhythmic slash regions, repeat bar regions, numbered bar regions, 

chord symbol visibility regions, and MIDI trigger regions can all be created across 

multiple selected instruments. The position and duration of each created region 

will be the same on every instrument. 

Position of first created item. By default, the position of the first created item will be 

determined by the position of the first note on each staff. This means you can 

quickly make, for example, a block selection by selecting a note or rest in one staff, 

then Shift+click in another staff, selecting notes and rests across multiple staves, 

then open the Shift+D popover and add a hairpin: the hairpin will be created on 

each staff, starting at the position of the first selected note on each staff. 

If you would prefer Dorico to create the chosen item at the start of the selection, 

regardless of whether there is a note at that position on every staff, deactivate 

Create items at position of first selected note in the Editing section of the Note 

Input and Editing page of Preferences. 

In Behind Bars, Gould recommends that clef changes should change at barline 

positions if possible, instead of immediately before the note. As such, a separate 

Create clefs at position of first selected note option allows you to specify whether 

clefs should be created at the start of the selection, even if you in general want 

items to be created immediately before the first note. 
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Improvements 

Accidentals 
Improved choice of accidentals when repitching. When using extended tonality systems, 

such as either of the default 24-EDO tonality systems, it is common to arrive at the 

desired microtonal accidental by inputting the nearest 12-EDO pitch, for example 

using a MIDI keyboard, and then repitch the note with Shift+Alt+↑/↓. 

However, in previous versions of Dorico, the order in which Dorico would choose 

the next accidental was not always easy to predict, and nor was it guaranteed that 

Dorico would show all the possibilities. 

Now, when repitching upwards and arriving at a new pitch class, Dorico will choose 

the “most flat” accidental; conversely, when repitching downwards, Dorico will 

choose the “most sharp” accidental. As you continue to repitch upwards or 

downwards, Dorico will continue to move sharper or flatter in a consistent fashion. 

Audio export 
Project activation warning. When you try to export audio (or MIDI) from a project that is 

not active for playback, Dorico now shows a warning that you need to activate the 

project for playback and try again. 

Bar numbers 
Bar numbers coinciding with start of multi-bar rest. If bar numbers are set to show at the 

start of every system, but a multi-bar rest falls at the start of the system and the 

option Show ranges of bar numbers under multi-bar rests and consolidated bar 

repeats is active, by default Dorico will not show a bar number at the start of that 

system. 

However, you might prefer the single bar number to appear in its normal position at 

the start of the system in addition to the range shown below the multi-bar rest, in 

which case activate the new option Show normal bar number if coincident with 

start of multi-bar rest showing range on the Bar Numbers page of Layout Options. 

Horizontal alignment. It is now possible to specify that bar numbers should be left-

aligned with barlines if desired. 

Hiding bar number changes. Bar numbers that arise from bar number changes can now 

be hidden via the Hide/Show Item command, accessed via the jump bar or a custom 

key command. 

Brackets and braces 
Sub-brackets for violins. New Sub-brackets for adjacent violin players option on the 

Brackets and Braces page of Layout Options, allowing you to specify that adjacent 
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violin players, for example Violin 1 and Violin 2 section players, should use separate 

sub-brackets. This is especially useful if divisi is employed, making it immediately 

clear which staves belong to which player. There are three choices: 

§ Single will join Violin 1 and Violin 2 with a single sub-bracket regardless of 

the number of staves each shows on the system. 

§ Separate will always give separate sub-brackets for Violin 1 and Violin 2, 

even if each only shows a single staff on the system. 

§ Separate for multiple staves will join Violin 1 and Violin 2 with a single sub-

bracket if each only shows a single staff on the system, but will otherwise 

only show a sub-bracket for either instrument if it shows multiple staves on 

the system. 

Sub-brackets matching primary brackets. New When sub-bracket matches primary 

bracket option on the Brackets and Braces page of Layout Options, allowing you to 

specify whether Dorico should draw a secondary bracket if the bracket will 

encompass the same staves as the primary bracket. 

Chord diagrams 
Used chord diagrams at start of flow. As part of a broader set of improvements to the 

alignment and positioning of chord symbols and diagrams, the chord diagrams 

shown before the first system of the flow when Show chord diagrams used at start 

of flow is activated are now properly measured, considering the geometry of the 

drawn chord symbols into account as well as the chord diagrams, and ensuring that 

they are all contained within the bounds of the automatic frame. 

Chord symbols 
Chord symbol alignment. A new Alignment of multi-line chord symbols relative to 

single-line chord symbols option has been added to the Position section of the 

Chord Symbols page of Engraving Options. 

 

When some chord symbols across the width of a system have altered bass notes (or 

are polychords) and others do not, this option determines whether the “single-

level” chord symbols should be aligned with the top, middle, or bottom of the 

“double-level” chord symbols. 
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Capo chord symbol horizontal alignment. A new Horizontal alignment of transposed 

chord symbol relative to main chord symbol option has been added to the 

Position section of the Chord Symbols page of Engraving Options. 

 

In existing projects, the upper chord symbol will continue to be left-aligned with the 

lower chord symbol, but in new projects the upper chord symbol will be center-

aligned. 

Position of root accidentals and stacked alterations. New options for the fine positioning 

and alignment of chord symbol root accidentals and the horizontal positioning of 

stacked alterations have been added to the Chord Symbols page of Engraving 

Options: 

§ In a new Advanced Options section under Vertical Position in the Position 

section, new Vertical offset for baseline root accidentals values allow you 

to adjust the vertical position of the accidental shown as part of the chord 

symbol root. 

§ A new Vertical offset for parentheses around stacked alterations option 

has also been added here, which controls the precise vertical placement of 

the full-height parentheses around stacked alterations. 

§ In the Alterations section, Position of stacked alterations relative to root 

determines whether vertically stacked alterations should be aligned with 

the chord symbol baseline (Align bottom with root) or center-aligned 

against the root (Center align on root). 

§ Also in the Alterations section, Horizontal alignment of stacked 

alterations allows you to choose between stacked alterations being Left 

aligned or Center aligned relative to each other. 

Height of parentheses. A new Scale parentheses to height of chord symbol with linear 

arrangement option has been added to the Parentheses section of the Chord 

Symbols page of Engraving Options. 

If a chord symbol has a linear arrangement, the parentheses can still be scaled to 

consider the height of, for example, the slash before an altered bass note. If you 
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prefer chord symbols without stacked alterations to use parentheses that match 

the root note height, deactivate this option. The effect is subtle, but is illustrated as 

follows, affecting only the first of the three chord symbols shown: 

 
Deactivated 

 
Activated 

6/9 chord symbol appearance. A new Use 6/9 appearance for chords with a sixth and 

ninth and additional alterations checkbox has been added to the Appearance of 

6/9 chords option in the Intervals section of the Chord Symbols page of Engraving 

Options. When this is activated, and when 6/9 chord symbols are set to display 

using some form of “6/9” rather than “6(add9)”, 6/9 chords with additional 

alterations will appear as, for example, “C6/9(#11)” instead of “C6(add 9, #11)”. 

Chord symbol regions. Copying and pasting a chord symbol region to a staff belonging to 

an instrument that does not show chord symbols, or using duplicate/move to staff 

above or below to copy or move a chord symbol region, will now automatically 

update the chord symbol visibility settings for that player as appropriate. 

Clefs and octave lines 
Hiding clefs and octave lines. Dorico has always provided a means of hiding clefs in a 

particular layout transposition, on the grounds that you may well want to omit clef 

changes if, say, the initial clef in the instrument is different; but it’s also the case 

that you may want some clefs to appear in the score to avoid ledger lines for the 

conductor, but the individual performer would be happy to read the ledger lines. 

Similar considerations apply to octave lines, which are in musical terms 

functionally the same. 

As such, a new Hide property has been added to both the Clefs and Octave Lines 

groups in the Properties panel, allowing clefs and octave lines to be hidden in the 

current layout. 

You can also use the Hide/Show Item command, either by assigning a custom key 

command or via the jump bar, to toggle the Hide property for clefs and octave lines. 

Condensing 
Condensing changes. When you choose Engrave ▶ Condensing Change with an item 

other than an existing condensing change signpost selected, Dorico will now look 

for an existing condensing change at the position of the earliest selected item, and 

if it finds one, it will edit that condensing change rather than creating a new one. 
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Dynamics 
Niente circle size and gap. The default size of the niente circle that appears at the start or 

end of a hairpin denoting a gradual dynamic that either rises from or falls to silence 

is larger in new projects, and a new Scale factor for niente circle option can be 

found in the Advanced Options section of the Gradual Dynamics section of the 

Dynamics page of Engraving Options, allowing you to further adjust this to your 

taste. 

Furthermore, some publishers prefer the niente circle to be positioned either 

slightly before or after the hairpin, rather than abutting it; a new Gap between end 

of hairpin and niente circle option allows you to change this as you see fit. By 

default, in new projects, there is now a quarter space gap between the end of the 

hairpin and the niente circle. 

Niente appearance. A new Style for niente 'n' option has been added to the Gradual 

Dynamics section of the Dynamics page of Engraving Options, allowing you to 

choose between using a bold or plain italic n for a niente marking at the start or end 

of a hairpin. 

Text on hairpins. A new Vertical position of modifier text inside center of hairpin 

option has been added to the Gradual Dynamics section of the Dynamics page of 

Engraving Options, allowing you to specify the default vertical offset for poco and 

molto text when drawn in the center of a hairpin. 

Gradual dynamic appearance. Entering cresc... or dim... in the Shift+D popover will now 

automatically set the Gradual style property such that the text-based gradual 

dynamic will show a continuation line. 

Expression maps 
Per-switch delay. Sounds with a slow attack or rise time can sometimes sound a little late 

if their notes are played exactly where written. It’s common therefore to adjust the 

start positions of notes using these sounds to compensate for their slow attack. 

You can now specify a delay in milliseconds for each switch in an expression map to 

accomplish this automatically: set Delay n milliseconds to the appropriate value. To 

make the notes sound earlier than written, specify a negative number; to make the 

notes sound later than written, specify a positive number. 

If you have abutting notes whose playback techniques require different switches 

with different delay values, you may encounter some overlaps. 
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Key Editor 
Velocity editor. A spin box showing the value of the first selected note’s velocity has been 

added to the editor header at the left-hand side. Changing the value shown here 

updates the velocity of all selected notes. 

Furthermore, the velocity value corresponding to the vertical position of the mouse 

pointer within the editor is now always displayed. 

Dynamics editor. The buttons to specify whether the selected point should be linear or 

constant have been added to the editor header at the left-hand side. Only points in 

blue regions created via the pencil or line tools can be edited in this way, so for 

green regions corresponding to dynamics in the score, these buttons are disabled. 

MIDI CC editor. If Include MIDI CC, pitch bend and dynamics from Key Editor when 

copying music is activated on the Note Input and Editing page of Preferences, 

when pasting MIDI CC data, existing regions will be retained, rather than all pasted 

MIDI CC data being merged into a single new destination region. 

Ruler. Double-clicking in the ruler in the Key Editor or in the track overview in Play mode 

now starts playback from that position. 

Layouts 
Propagate Part Formatting. It is now possible to invoke the Propagate Part Formatting 

command from any mode via the jump bar or a key command. 

Library Manager 
Support for more library files. The Library Manager is now able to correctly handle Dorico 

library files exported from other parts of the program, for example percussion kits 

exported from the Edit Percussion Kit dialog. 

Lyrics 
Japanese lyrics. A new option Use Japanese hyphens instead of extender line has been 

added to the Lyric Extenders section of the Lyrics page of Engraving Options, 

switched off by default both in new and existing projects. When this option is 

activated, instead of showing a lyric extender line for syllables that should be sung 

over multiple notes, or for a single note written with ties, Dorico instead shows a 

Japanese hyphen character at each notehead position. 

Lyric extender position. The right-hand end of the lyric extender line is now 

automatically aligned with the right-hand side of the notehead at the position of the 

end of the extender line. 

Lyric hyphens. By default, lyric hyphens are drawn using the default paragraph style for 

the current line of lyrics. If the lyric syllable immediately to the left of the hyphens 
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uses a different paragraph style (for example, by way of the Paragraph style 

property), the hyphen now uses the same, overridden paragraph style. 

Non-breaking spaces in Edit Line of Lyrics. In the Edit Line of Lyrics dialog, non-breaking 

spaces in lyrics appear as mid-dot characters, like this: · . If you need to add or move 

a non-breaking space while editing your lyrics, you can now type Shift+Alt+Space to 

add a mid-dot that will be replaced with a non-breaking space when you confirm 

the dialog. 

Music fonts 
New music font families. Thanks to the growing adoption of the Standard Music Font 

Layout (SMuFL), there are several music font families released under the same SIL 

Open Font License as Dorico’s default music fonts, Bravura and Petaluma. However, 

installing these fonts is typically tricky, and can require either manual installation 

or the installation of other applications. Dorico 5 therefore now installs eight new 

music font families: 

§ Finale Ash: a handwritten-style font, a modern recreation of the famous 

AshMusic font, based on the hand of copyist Ashley Wells. 

§ Finale Broadway: a handwritten-style font, designed to emulate a thin nib 

ink pen. 

§ Finale Jazz: a handwritten-style font, originally created by trumpeter Rich 

Sigler to emulate the hand copying of Clinton Roemer, using an oblique nib 

ink pen. 

§ Finale Maestro: an engraved-style font, drawing on similar source material 

to Bravura, but with overall a less bold look. 

§ Golden Age: a handwritten-style font, a modern recreation of Don Rice’s 

original Golden Age font, based on his own hand. The weight of the font is 

somewhere between the thinner appearance of Finale Broadway and the 

very bold appearance of Finale Jazz. 

§ Leipzig: an engraved-style font, initially developed by Etienne Darbellay and 

Jean-François Marti as part of the Wolfgang music notation software and 

today most associated with the Verovio project. It has greater stroke 

contrast than either Bravura or Finale Maestro. 

§ Leland: an engraved-style font, developed by Simon Smith and Martin 

Keary for MuseScore. It is designed to emulate the look of the venerable 

SCORE music notation software by the late Leland Smith. 

§ Sebastian: an engraved-style font, developed by Florian Kretlow and Ben 

Byram-Wigfield. Like Bravura, the overall look of Sebastian is quite bold. 

In addition, several of these music fonts are paired with text font families to provide 

a harmonious overall look to your scores. 
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To try out a different music font in your project at any time, choose one from 

Library ▶ Music Fonts. 

Text font family. If the font-specific metadata file does not specify a preferred text font 

family, Dorico no longer resets the font used for the default font and paragraph 

styles to Academico. 

MusicXML export 
System formatting. MusicXML files exported from Dorico now specify system and frame 

(or, in MusicXML terms, page) breaks such that the system formatting of the layout 

being exported is encoded. 

Page size, staff size, and margins. The page size and staff size specified on the Page Setup 

page of Layout Options are now encoded when exporting MusicXML. Basic page 

margins are also specified, though only a single set of margins is exported, so if your 

layout uses mirrored or different margins on facing pages, these will not be 

completely encoded. 

Music and text fonts. Dorico now exports the names of the music font and main text font 

used in the project when exporting MusicXML. 

File extension. Uncompressed MusicXML files exported by Dorico now have the 

correct .musicxml file extension, and report themselves as MusicXML 4.0 files. 

Noteheads. Dorico’s built-in X and Diamond, Large X and Diamond, and Large Circled 

notehead sets are now correctly exported to MusicXML. 

MusicXML import 
Holds and pauses. Fermatas, breath marks, and caesuras are now imported from 

MusicXML files. 

Dorico treats fermatas and caesuras as global items that affect all instruments in 

the system, as this reflects common notational practices, but MusicXML does not 

enforce this: a MusicXML file can encode a fermata, for example, on just one staff, 

but in Dorico, that fermata would appear at the appropriate rhythmic position on 

every instrument. As such, when importing these items from MusicXML, Dorico 

analyses the fermatas and caesuras in the MusicXML file and groups them such 

that it creates only the appropriate global items. This means that it is not 

guaranteed that fermatas and caesuras will appear at precisely the same positions 

as encoded in the MusicXML file, but the result should always make musical sense. 

With both caesuras and breath marks, there is the additional complication that 

different applications specify the rhythmic position of caesuras in different ways. 

Dorico employs heuristics based on which application exported the MusicXML file 

to try to produce the intended result as often as possible. 
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Ornaments. MusicXML specifies a wide range of ornaments that can be encoded, and 

Dorico now imports all of these, except for delayed turns, delayed inverted turns, 

and shakes. 

Harmonics. Dorico now imports natural and artificial harmonics from MusicXML files.  

Playing techniques. A wider range of playing techniques is now imported from 

MusicXML files, including mute/open/stopped indications for brass instruments, 

and bowing marks and snap pizzicato indications for string instruments. 

In addition, MusicXML allows the encoding of relatively freeform playing 

techniques either as text or glyphs using the other-technical element, and Dorico 

will do its best to import these as playing techniques. You may prefer to exclude 

these, in which case deactivate Import other-technical playing techniques on the 

MusicXML Import page of Preferences. 

Staff labels. The handling of instrument transpositions in staff labels has been greatly 

improved. The staff label in the MusicXML file itself could be encoded as, for 

example, “Clarinet in Bb”, and Dorico would correctly identify this part as belonging 

to a Clarinet, but also import the part name from the MusicXML file exactly, then 

apply the prevailing layout options for staff labels, resulting in nonsensical names 

like “Clarinet in Bb in B♭”. 

Dorico now takes a more nuanced approach, attempting to parse the part name in 

the MusicXML file to identify the instrument name and the transposition 

independently, and adjusting the layout and engraving options such that the 

automatic staff labels in Dorico match the appearance specified in the MusicXML 

file as closely as is practical. 

Voice direction for grand staff instruments. When importing music in multiple voices, 

particularly for grand staff instruments like piano, Dorico’s choice of voice 

direction, which uses heuristics to determine whether a voice should be nominally 

up-stem or down-stem, did not always in previous versions conform to the default 

voice directions that are used when inputting notes yourself. This could lead to 

unexpected behavior when editing or adding more music later on. 

The approach to determining voice directions has been improved such that voices 

with ambiguous directions now default to up-stem rather than alternating between 

up- and down-stem, and Dorico tries also to make sure that a single voice on a staff 

will always be up-stem. 

Note grouping 
Note grouping in cut time. A new Use common time note grouping for cut common 

time signatures option has been added to the Time Signatures With Half-Bars 
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section of the Note Grouping page of Notation Options. When activated, this causes 

Dorico to group notes, beamed groups and rests in 2/2 and cut common time using 

the rules for 4/4 or common time. 

A new property, Use common time note grouping, has been added to the Time 

Signatures group, allowing you to selectively apply the new notation option to 

group notes and rests in cut common time in the same manner as common time for 

an individual time signature if required. 

Note input 
Double-tap for dotted note values. You can now specify that the next note to be input 

should be dotted by tapping the key for the note duration twice in quick succession: 

tap 6 once for a quarter note (crotchet), or tap 6 twice for a dotted quarter note 

(dotted crotchet). 

This works both when note input is active (i.e. the caret is shown), and when editing 

the durations of selected notes, but not when pitch before duration input is active.  

Add bar at end of flow. A new command Add Bar at End of Flow has been added to the 

Note Input category in the Key Commands page of Preferences, allowing you to 

assign a custom shortcut to add a bar at the end of the flow. This command can also 

be triggered via the jump bar. 

Deleting bars. A new command Edit ▶ Delete Bars command, intended to make it easier 

to discover how to delete bars. Dorico determines the bars to be deleted by the 

positions of the earliest and latest selected items. 

Single-stem tremolos. When joining notes in the same voice with ties, Dorico now 

preserves any existing single-stem tremolos on all selected staves affected by the 

operation, rather than only the first selected one. 

Note spacing 
Voice column handles. When editing note spacing in Engrave mode, each global spacing 

column shows a square handle, and when selected, each square handle shows one 

or more circular handles, corresponding to the voice columns for the items in that 

global spacing column on that staff. 

You can see at a glance when a global column has an adjustment, as the square 

handle will be colored red. However, to see whether a voice column has an 

adjustment, you had to select the corresponding square handle, as the circular 

handles appear only when the square handle is selected. 

This has now changed in Dorico 5, such that any adjusted voice column will always 

show its circular handle in red. This makes it much easier to locate spacing 

adjustments to voice columns. 
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Ornaments 
More default ornaments. The Baroque and Classical section of the Ornaments panel in 

Write mode now includes a wider range of default ornaments. 

Page templates 
Importing page templates. When importing page templates from library files in previous 

versions, it was common for any custom paragraph styles used in its text frame 

definitions to be duplicated, even if the destination project already contains the 

same styles. 

Dorico is now much more selective about importing paragraph and character styles 

when importing page templates. A style will now only be imported if it is user-

defined and does not already exist in the destination project.  

Exporting page templates. If a page template uses one or more custom character styles 

in its text frame definitions, these styles are now included in the exported library 

file. 

Pedal lines 
Merging pedal lines. When merging multiple selected pedal lines, Dorico now creates a 

retake at each position corresponding to the start of each merged pedal line. 

Playback 
Repeats playback. Sometimes it is necessary to specify that certain notes, dynamics, or 

other items should be played back only on a specific pass through the music when 

following a repeats structure. To accommodate this, the Suppress playback 

property in the Common group of the Properties panel has been extended, and now 

allows you to specify whether the selected item should be suppressed in playback 

Always (on every repeat), or On Passes (on one or more specific repeats). 

When you choose On Passes, by default the item will play back on every repeat. To 

specify on which passes the item should not play back, activate the new Suppress 

on passes property, found immediately below Suppress playback, and specify the 

passes on which the item should not play back. 

The first time something is played is considered pass 1, the first repeat is considered 

pass 2, and so on. Specify the passes on which the item should not play back using a 

comma-separated list of passes, or specify a range of passes by separating the first 

and last pass with a hyphen. For example: 1,3,5-7. 

Be aware that suppressing playback for tempo items can have unexpected effects. 

Specifically, if you suppress the immediate tempo change preceding a gradual 

tempo change on only some passes, the gradual tempo will play back as if the 
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immediate tempo change were not suppressed: it will start from the suppressed 

tempo.  

Suppress playback. A new Toggle Suppress Playback command has been added to the 

Edit category in the Key Commands page of Preferences, allowing you to toggle the 

Suppress playback property for the selected items using a custom keyboard 

shortcut, or via the jump bar. 

Pedal lines. Pedal lines that cross repeat barlines and endings now play back correctly, 

considering the multiple passes through the music. 

Tremolos. Articulations of attack (such as accents) now only affect the first played note of 

the tremolo, rather than being repeated on every note. By contrast, articulations of 

duration (such as staccato) are now applied to all the notes of the tremolo. 

Measured tremolos now play back using the appropriate note length condition for 

the played durations of the notes in the tremolo, rather than the original written 

duration of the notes on which the tremolo strokes appear. 

Note length conditions. When Dorico is determining which switch to use in the 

expression map, it has a system of fallbacks that it uses if the specific combination 

of playing techniques used in the score does not map directly onto either a single 

base switch, or a combination of a base switch and one or more add-on switches. If 

the switches in the expression map define note length conditions, Dorico will now 

prefer to fall back to a switch that matches, say, only one of the desired playback 

techniques, and additionally satisfies the note length condition. 

Dynamic power curve. Two new options, Minimum dynamic level and Maximum 

dynamic level, have been added to the Dynamic Curve section of the Dynamics 

page of Playback Options. As their names suggest, they specify the dynamic levels at 

either end of the dynamic power curve, allowing you to compress the overall 

dynamic range. 

By default, these are set to -6 and 6 respectively, corresponding to and . 

If your music typically doesn’t use dynamics beyond and  , try setting these 

values to -3 and 3. This will allow a greater difference between these dynamic levels; 

any written dynamics softer or louder than the minimum and maximum defined 

here will play back with the minimum or maximum value as appropriate. 

Used in conjunction with the existing Dynamic curve power option, this allows 

greater control over the dynamic response during playback. The new options can 

also be overridden in any expression map in the Playback Options Overrides 

section of Library ▶ Expression Maps. 
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Microtonal playback. Dorico can now play back microtonal pitches using MIDI pitch bend 

if required. 

Using MIDI pitch bend rather than VST Note Expression (as used by e.g. HALion 

Sonic and Pianoteq) or VST detune (as used by NotePerformer) has a couple of 

notable disadvantages: because MIDI pitch bend is a channel-wide message, you 

cannot play chords that require different pitch bend values to produce the required 

pitches; and Dorico cannot determine automatically what pitch bend range is 

supported by a plug-in or MIDI device (it will typically be either a whole step or an 

octave). 

Nevertheless, for certain applications using monophonic instruments, using MIDI 

pitch bend for microtonal playback can have advantages, too: it allows you to 

produce microtonal playback for plug-ins that don't support either of the other, 

better methods (for example, Kontakt); and MIDI pitch bend messages are included 

when exporting MIDI, which allows microtonal pitches to be taken into your DAW 

or other application. Using MIDI pitch bend for microtonal playback is opt-in, and 

must be activated for your plug-in via the new Microtonality playback menu in 

Library ▶ Expression Maps. 

Playback templates 
Overwrite warning. When you export a playback template via Play ▶ Playback Template, 

Dorico will now warn you if the template you’re exporting will overwrite an existing 

file. 

Play mode 
Routing for percussion kit components. Each individual unpitched percussion 

instrument included in a percussion kit now appears as a separate track in the track 

overview in Play mode, making it possible to select each instrument and change the 

settings in the Routing section of the track inspector panel independently. 

This restores functionality that was present in versions of Dorico up to 3.5 that was 

temporarily removed as a consequence of the rebuilding of Play mode in Dorico 4, 

allowing each instrument in a percussion kit to be routed to a different endpoint if 

necessary. 

Reset Playback Overrides. Using Play ▶ Reset Playback Overrides to remove playback 

overrides from a large selection is now considerably faster than in earlier versions. 

Project files 
Creating new projects via the Hub. The last value entered for Number of bars on the 

Create New page of the Hub is now remembered not only during the current Dorico 

session, but also between sessions. 
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Rehearsal marks 
Horizontal alignment. When Position of rehearsal mark at start of system is set to Left-

aligned with systemic barline on the Rehearsal Marks page of Engraving Options, 

the horizontal position of the rehearsal mark is now adjusted to consider whether 

the systemic barline appears, so that it is always perfectly aligned with the start of 

the system. 

Repeat endings 
Creating repeat endings from the selection. When Dorico uses the extent of the current 

selection to determine the position and duration of the first segment in a newly-

created repeat ending, it now considers items including multi-bar rests. 

Rests 
Rest positioning. Dorico has always provided the option to align rests within a beat group 

at the same vertical position, but not rests in different beat groups. This can lead to 

successive rests within a bar being assigned different vertical positions, and you 

might prefer them to be assigned the same position. 

A new Align rests in the same voice vertically option has been added to the Rest 

Positioning section of the Rests page of Notation Options. Set this to When in the 

same bar to ensure that all rests in a voice are assigned the same vertical position. 

Scripting 
Script Console. Script ▶ Console allows you to run Lua commands in an interactive 

fashion. The console has been given some significant quality of life improvements 

in this release: 

§ The Script ▶ Hide Console menu item has been removed; instead, Script ▶ 

Console is now a toggle, so you can toggle the visibility of the console with a 

single key command or via the jump bar. 

§ A new Always on top checkbox has been added to the console, allowing you 

to specify that the console should always float on top of other windows. 

Dorico will remember the state of this checkbox not only during the current 

session, but between sessions. 

§ The size and position of the console is now preserved between sessions. 

§ You can resize the upper log view and lower command entry panes in the 

console by dragging the splitter between them. The relative size of these 

panes is also preserved between sessions. 

§ A monospaced font, Source Code Pro, is used for the console output. 

§ When the console opens, the focus is put into the command entry pane by 

default. The command entry pane now has a distinctive appearance, with a 

white background and line numbers shown in the left margin, so it is now 
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much clearer which pane you can type into, and which shows the 

interpreter’s output. 

§ The command entry pane now accepts multi-line input: simply hit Return 

to add a new line. To execute the script, either click the Execute button, or 

use the shortcut Ctrl+Return (Windows) or Command-Return (macOS). 

Recording a macro. When you choose Script ▶ End Recording Macro to complete a 

macro recording, Dorico now prompts you to specify the name of the script, and 

automatically presents a file chooser dialog defaulting to the appropriate location 

in your user application data folder to save the script such that it will appear in the 

Script menu. 

Submenus for scripts. If you create subfolders inside the Script Plug-ins folder in your 

user application data folder, Dorico uses the names of these subfolders to create 

submenus in the Script menu, making it easier to categorize your script plug-ins. 

Dorico also loads scripts from the global application data folder, if any are found 

there. 

Jump bar. Scripts that appear in the Script menu can now be triggered via the jump bar: 

simply type the beginning of the script name, and it will appear in the list of 

commands that can be executed. If the script appears in a submenu of the Script 

menu, the submenu name is appended to the name of the script in parentheses. 

Scripts that sequence multiple commands. In earlier versions, scripts that execute 

multiple commands in sequence would not always work as expected: for example, a 

script that attempts to set two different properties in succession on a single 

selected note would often fail, because Dorico would not notify about each edit 

before attempting to perform the next one. Dorico now takes a different approach 

to running scripts, such that each edit can notify, and as a result, scripts now run 

more reliably. This also means that all the edits performed by a script can now be 

undone in a single step. 

Setup mode 
Renumber instruments. A new Setup ▶ Renumber Instruments command has been 

added, which renumbers the instruments in the project according to the order in 

which the players are listed in the Players panel in Setup mode. 

This is useful if you have, say, four horns in your project, and after having written 

music for them, you want to change the order of the players: simply dragging the 

players into a new order in the Players panel won’t renumber the instruments, but 

now you can do this with one click. 

Instrument transpositions. Dorico now only appends a text description of an 

instrument’s transposition to its name as it appears in the Players panel if the 



 

 

Dorico 5 Version History 117 Steinberg Media Technologies GmbH 

instrument has variants that define different transpositions; hitherto Dorico has 

appended the transposition for instruments that have variants of any kind. For 

example, baritone saxophone provides variants with different clefs for concert and 

transposed pitch, but the actual transposition of the instrument is the same in all 

cases. As such, baritone saxophone used to appear in the Players panel as Baritone 

Saxophone (E flat), which is redundant: now, it appears simply as Baritone 

Saxophone. 

Relatedly, this instrument name is also used to create the default name for each 

part layout. This would result in the boxed text in the top left corner of the first page 

of each layout showing the transposition in words, for example, “Clarinet (B flat)”. 

Dorico now automatically uses the appropriate accidental symbol, so the boxed text 

instead shows, for example, “Clarinet (B♭)”. 

Staff labels 
Player names as staff labels. A new option Show player names has been added to the 

Staves and Systems page of Layout Options allowing you to specify whether staff 

labels should use player names rather than instrument names On all systems or 

On first system only. 

Leading for editing staff labels. In simple cases, overrides made to the horizontal 

alignment and leading of staff labels in the Edit Instrument Names dialog are now 

carried through to the resulting staff labels. 

Staff spacing 
Frame fullness indicator. The frame fullness indicator now appears in the left page 

margin rather than in the right margin, to make the difference between the 

indicators for vertical and horizontal fullness clearer. 

Steinberg Licensing 
Latest version of Steinberg Activation Manager required. Dorico 5 requires Steinberg 

Activation Manager version 1.4.30 or later. If you are running an earlier version of 

SAM, please ensure you update it. The easiest way to update SAM is by running 

Steinberg Download Assistant. 

Text 
Text frame background and border color. Two new properties, Background color and 

Border color, have been added to the Text group in Properties, allowing you to 

modify the appearance of text frames. To use these properties, activate frame 

editing in the Engrave mode toolbox, then select the text frame whose border or 

background color you want to override. 
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Select More. A new special behavior has been added to Edit ▶ Select More: if you select a 

single staff- or system-attached text item and invoke Select More, Dorico will select 

only other text items that use the same paragraph style. 

Change Paragraph Style. New Edit ▶ Notations ▶ Text ▶ Change Paragraph Style dialog, 

allowing you to change the paragraph style used for selected staff- or system-

attached text items. This is handy when used in conjunction with the new ability to 

use Select More to select more text items that use the same paragraph style as the 

first selected text item. 

Unicode text input. If you want to input a music symbol in a text item in Dorico, the 

easiest way is to right-click and choose Insert Music Text from the context menu, 

which opens a dialog showing all the music symbols in SMuFL; any symbol you 

insert is automatically set to use the Music text character style. 

Until now, however, it has been awkward to input other arbitrary Unicode symbols, 

but Dorico 5 introduces a new way to do this: when editing text, either for a staff- or 

system-attached text item or in a text frame, type the four-character hexadecimal 

number that represents the code point of the character you want to insert, then 

type Alt+X. Dorico converts the four characters to the left of the insertion point into 

the appropriate Unicode character. 

For example, the horizontal ellipsis character has the code point U+2026. To insert 

this in Dorico, type 2026 into the text editor, then type Alt+X. 

Hexadecimal numbers use the Arabic digits 0–9 and the Roman letters A–F. For 

one more example, the interpunct or middle dot character has the code point 

U+00B7. To insert this in Dorico, type 00B7 into the text editor, then type Alt+X. You 

do need to include any leading zeroes so that the code point is always expressed as 

four characters. 

You can also do this in reverse: if the four characters immediately to the left of the 

insertion point are not recognized as a hexadecimal number, Dorico will instead 

convert the character immediately to the left of the insertion point into its code 

point. 

Leading control. It is now possible to adjust the leading (line spacing) of an 

individual text item via the text editor popover, using the control shown on the 

right. 

Tokens for project duration. New tokens for the total duration of the project have been 

added, and can be used in text frames: 

§ {@projectDuration@} uses smart quotes, for example 4’33”. 
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§ {@projectDurationStraightQuotes@} uses straight quotes, for example 

4'33". 

§ {@projectDurationPrimes@} uses primes, for example 4′33″. 

To insert one of these tokens, right-click while editing the text in a text frame, and 

choose the appropriate entry from the Project Info submenu. 

Font families with extended styles on macOS. One of the troublesome differences 

between the way Windows and macOS handles font families concerns extended 

styles beyond the four standard style names (Regular, Bold, Italic, and Bold Italic). 

Windows only allows these four styles and will automatically synthesize a missing 

style – so if a font family does not provide, say, a bold weight, Windows will 

dynamically create one. macOS, by contrast, does not have a fixed idea about the 

styles that need to exist in a font family. 

Take, for example, the Futura family that is included with recent versions of macOS. 

Although a much wider range of styles is available in alternative cuts of this 

typeface from Linotype and URW Type Foundry, the version that ships with macOS 

provides five styles: Medium, Medium Italic, Bold, Condensed Medium and 

Condensed ExtraBold. 

On Windows, each of these weights would appear as a separate font family with the 

four standard styles: Futura Medium Regular, Futura Medium Bold, Futura Medium 

Italic, Futura Medium Bold Italic; of these, only Futura Medium Regular is an actual 

font file on disk; the other three are synthesized by Windows itself. Futura Medium 

Bold, for example, would not use the actual Futura Bold font file, because as far as 

Windows is concerned, “Futura” and “Futura Medium” are distinct families. 

On macOS, by contrast, styles are never synthesized by the operating system: in 

most macOS applications you can only choose the styles that are really installed. 

This presents some difficulties for cross-platform applications, since beyond the 

fundamental difference in how extended styles are handled, there are other 

difficulties, such as font files defining family and style names in multiple ways, and 

different operating systems and even applications on those operating systems 

electing to use different information to find and name fonts. 

Previous versions of Dorico have had an unhappy compromise in trying to handle 

these platform differences. On Windows, everything is straightforward: all font 

families have four standard styles, and beyond that, any further styles appear as 

distinct families, as the operating system intends. But on macOS, Dorico has shown 

Windows’s four standard styles in addition to the actual named styles provided by 

the font family, and relied on the font substitution behavior of the underlying 
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application framework to choose an appropriate style if one of the standard styles is 

unavailable. 

To return to the example of the Futura font family included with macOS, it was 

possible in previous versions of Dorico to choose Futura as the font family for a font, 

paragraph or character style and leave the style set to Regular, despite this named 

style not existing. In practice, for text displayed in your project, Futura Medium 

ends up being used. 

However, when that project is subsequently reopened, Dorico will warn that Futura 

Regular is missing. Because you can see text using Futura in the project, you might 

consider the warning spurious, but in fact it is correct: Futura Regular is being 

requested, but it is not available. 

To address this, Dorico on macOS now only shows the named styles for a font family 

that are present on the system. This affects everywhere that font family and style 

names are shown in the application, including the Font Styles, Paragraph Styles and 

Character Styles dialogs, and the text editor popover. 

When you change the font family to one that does not implement the currently 

chosen named style, Dorico explicitly chooses the first available named style. If you 

choose Futura, for example, Dorico will automatically choose the Medium style, 

rather than making it appear that it has chosen the Regular style. 

Furthermore, Dorico now also automatically updates all font and paragraph styles 

that define the edited style as their parent and which inherit its choice of font 

family, to ensure that every dependent style also specifies a named style that exists. 

This means that when Dorico will not allow you to choose an unavailable style by 

default, and you will not see any warnings about missing fonts when you reopen the 

project. 

Unfortunately, this does nothing to address the inevitable difficulties that can occur 

when moving projects that use these kinds of extended font styles between macOS 

and Windows. It is still necessary to carefully remap the fonts via the Missing Fonts 

dialog when opening such a project on the other operating system. 

Trills 
Double sharp accidentals. In previous versions, the size of a double sharp accidental 

above a trill marking indicating the trill interval was too small to be read 

comfortably; Dorico now enlarges the accidental to make it clearer. 

User interface 
Follow playhead during playback. A new Follow playhead slide switch has been added to 

the status bar. By default, when starting a new project, this follows the Follow 
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playhead during playback option on the Play page of Preferences. You can 

determine whether Dorico should scroll the score, Key Editor and track overview in 

Play mode to follow the playhead during playback independently for each project 

window. This can be useful if you have multiple windows open on the same project, 

and want one to follow the playhead during playback, and another to remain static 

unless you explicitly move the view. This setting is preserved between sessions for 

each window. 

If you prefer to toggle this setting via a custom key command, you can assign a 

shortcut to Window ▶ Toggle Follow Playhead in the Key Commands page of 

Preferences, or invoke this command using the jump bar. 

Layout transposition. The read-out that shows whether the current layout is shown in 

Concert Pitch or Transposed Pitch has been replaced with a pair of toggle buttons, 

allowing you to change the current transposition directly without using the Edit 

menu. 

View type. The drop-down menu for choosing between Page View and Galley View has 

been replaced with a pair of toggle buttons, saving you a click when changing the 

view type with the mouse. 

Middle C convention. Different hardware and software manufacturers use different 

numbering schemes for octaves, which can lead to confusion when trying to cross-

reference between different devices, software applications, and plug-ins. 

Dorico by default numbers middle C (MIDI note 60) as C4, following the widely-used 

International Pitch Notation standard, which is also the standard followed by 

manufacturers such as Roland for their synthesizer products. However, Steinberg’s 

other host applications, including Cubase, and plug-ins, including HALion, by 

default number middle C as C3. Yamaha also numbers middle C as C3 in their 

synthesizer products. A third scheme, less widely used but popularized by 

Cakewalk’s products, numbers middle C as C5, so that MIDI note 0 is numbered as 

C0, rather than as either C-1 (when middle C is numbered as C4) or C-2 (when 

middle C is numbered as C3). 

Dorico now allows you to choose how you want middle 

C to be numbered throughout the application. To 

change this setting, open the Preferences dialog, and on the General page, set 

Middle C (note 60) to C3, C4, or C5, as you prefer. 

This setting affects octave numbering throughout the application, including: the 

piano roll in the Key Editor; the Keyboard panel; the selected note read-out in the 

status bar; MIDI trigger regions; the String property in the Properties panel; the Edit 
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Strings and Tuning, Transpose, Filter Notes by Pitch and Write ▶ Transform 

dialogs; and everywhere where you can specify a pitch using a spin box. 

One place in the application that has an independent representation of middle C is 

Library ▶ Expression Maps: this allows you to match the numbering scheme used in 

the documentation of a third-party plug-in or sample library manufacturer without 

changing the representation of middle C everywhere else in Dorico. 

Instrument transpositions. Instruments that use a different clef depending on whether 

the layout uses concert or transposed pitch are now described in the instrument 

picker in Setup mode in these terms, instead of misleadingly being described as 

using one clef in full score layouts and another in part layouts. 

Tool tips. All buttons in the project window now once again show tool tips if appropriate. 

Missing fonts. When Dorico shows the Missing Fonts dialog during project opening to 

report that text items, font styles, paragraph styles and character styles in the 

project use fonts that are not installed on the system, the dialog now additionally 

shows the name of each style that specifies the missing font. 

Transpose dialog. When returning to the Transpose dialog during the same editing 

session, Dorico now remembers the last chosen value for Apply atonal spelling 

options. 

Audio export dialog. When returning to the Export Audio dialog, Dorico now remembers 

the last chosen audio format and (if applicable) bit depth.  

Localization. When running Dorico in Spanish, Portuguese, and Chinese, some default 

translations (for example, for buttons like OK, Cancel, Apply, Close, etc. in dialogs) 

were missing; these default translations are all now included. 

Background colors. It is now possible to define gradients with any number of stops in the 

gradients.xml file in the user-level application data folder. Dorico will display these 

gradients as intended in the music area background, though gradients with more 

than four stops, or where the distribution of the stops is irregular, will not appear as 

intended in the Colors page of Preferences. 

Device Setup. If Dorico detects that the current audio device is only presenting a single 

output, rather than a stereo pair, a warning now appears in Edit ▶ Device Setup, 

together with a link you can follow to a knowledge base article with instructions for 

reconfiguring your audio settings in Windows to solve the problem. 

Default plug-in output slider. The Default output level slider on the Play page of 

Preferences now shows the effective gain level of the current slider value. 
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Missing playback components. During start-up, Dorico checks whether the 

recommended VST instruments and sound content are correctly installed. If it 

determines that any component or content is missing, the message it shows now 

tells you the exact name of the download choice you need to download and install 

via Steinberg Download Assistant. 

If you prefer not to use the instruments and content included with Dorico and don’t 

want to install them, you can activate the Don’t say this again checkbox in the 

prompt to suppress the warning in future. However, certain components are 

installed by the main Dorico application installer itself, and their absence could 

indicate a wider installation issue, so this message cannot be suppressed: to 

prevent this message from appearing in future, please reinstall Dorico via its 

application installer to repair your installation. 

Automatic crash report collection. In the unlikely event that Dorico crashes, the next time 

you start the application, you will be shown a prompt to send the crash report to 

Steinberg. Crash reports do not contain personally identifiable information and 

crash logs are automatically renamed when they are uploaded to our servers so 

that even the original filenames are changed. 

If you prefer, you can completely opt out of automatic crash report collection, and 

in any case Dorico will never send crash reports to Steinberg without first 

prompting you: every time it finds a crash report, it will show you a prompt and ask 

if you want to send the log to Steinberg. 

If you choose to opt out and later want to opt back in, activate Show prompt to send 

crash reports to Steinberg on the General page of Preferences. 

We encourage you to send crash logs to Steinberg. They allow us to find and fix 

problems in our applications and deliver improved software quality to you and all 

Dorico users. 

Guided tour in multi-user environments. Dorico will now read the finishedTours.xml file 

that records the completion state of the guided tour in each of the project window's 

modes from the global user data folder, if not found in the user's own data folder. 

This is useful in multi-user environments such as schools, colleges, and 

universities. 

Improvements in Dorico Elements 
The capabilities of Dorico Elements have been expanded, as follows: 

§ Projects can now have an unlimited number of players (previously limited 

to 24 players). 

§ Play ▶ Playback Options is now included. 
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§ Font Styles, Paragraph Styles and Character Styles are all now included in 

the Library menu. 

§ Note spacing and staff spacing tools are now included in Engrave mode. 

Dorico Elements also gains all the new features added in Dorico 5, except for the 

new Library ▶ Instruments dialog. 

The above new capabilities are also available in Dorico for iPad, with an active 

monthly or annual subscription, or if the Lifetime Unlock in-app purchase has been 

purchased. Dorico for iPad with an active subscription or Lifetime Unlock also gains 

support for playback through an external MIDI device. 

Improvements in Dorico SE 
Dorico SE’s capabilities have also been expanded, and you can now work on projects 

with up to eight players. (As before, projects with more than eight players will open 

read-only, allowing playback and printing.) 

Dorico SE also gains many of the new features added in Dorico 5, except for Library 

▶ Instruments, stage and space templates, scrub playback, MIDI trigger regions, 

and Groove Agent SE. 

Dorico for iPad is similarly expanded, with the free version also now able to work on 

projects with up to eight players (12 after you sign in with your Steinberg ID). 
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Issues resolved 
Component Issue 

Accidentals Under some circumstances, changing the accidental of a note would not cause the accidentals 

on notes within the same bar to be recalculated right away as required; this has now been 

fixed. 

Articulations Articulations that consist of multiple symbols would draw incorrectly when positioned on the 

stem side of the note; this has now been fixed. 

Bar numbers Under some circumstances, bar numbers would not update correctly when undoing changes 

to local time signatures; this has now been fixed. 

Brackets and 

braces 

Dorico will no longer allow a secondary bracket to join adjacent players with identical 

instruments that are in different player groups. 

Chord diagrams When changing the tuning used for chord diagrams shown for a player, Dorico no longer 

unnecessarily resets the choice of shape back to the default one for that tuning. 

Chord diagrams Chord diagrams that are created via Generate Chord Symbols from Selection will now show 

fingerings if enabled via Layout Options. 

Chord symbols When changing the capo transposition for chord symbols, Dorico now automatically resets 

the appearance of any chord symbols that have been overridden; this prevents overridden 

chord symbols from continuing to draw using the root of the original capo transposition. 

Chord symbols Under some circumstances, it was possible for saved chord symbol appearances in Library ▶ 

Chord Symbols to have a mismatch between their saved transposition and the displayed 

chord symbol, resulting in chord symbols showing the wrong root in the score; this has now 

been fixed. 

Chord symbols Under some circumstances, Dorico could crash when using Edit ▶ Reset Appearance in a 

layout showing both chord symbols and chord diagrams; this has now been fixed. 

Clefs When Clef at start of systems following first system on the Clefs page of Notation Options is 

set to Hide clefs, Dorico now only hides the clef if the system contains a single instrument, and 

if that single instrument shows only a single staff. 

Comments It is no longer sometimes possible for Dorico to get caught in a loop of selecting and 

reselecting the same two comments in the Comments panel when navigating quickly through 

the list of comments with the arrow keys. 

Dynamics In rare circumstances, grouping dynamics, then undoing, then re-grouping the same 

dynamics would fail; this has now been fixed. 

Dynamics Deleting individual dynamics from different groups of dynamics now works correctly, instead 

of only deleting the selected dynamics from the first group. 
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Component Issue 

Grace notes Under rare circumstances, grace notes could unexpectedly not appear at the start of a system 

where an explicit system break is present; this has now been fixed. 

Guitar notation When the Pre-bend interval property is set to a negative value, the automatic allocation of 

notes to strings and the String property could behave incorrectly, causing some valid pitches 

to display incorrectly as ?; this has now been fixed. 

Holds and pauses When a fermata appears both above and below a rest, the fermata below may have been 

incorrectly positioned if the single drawn rest represents multiple voices; this is now fixed. 

Jump bar It is now possible to redefine the shortcuts used to switch between Commands and Go To 

modes in the jump bar. 

Keyboard panel When dragging the range selector above the main keyboard to either extreme of the range, 

when the mouse pointer leaves the range selector during the drag, it was possible for the drag 

to be unexpectedly re-interpreted as changing the displayed range; this has now been fixed. 

Key Editor Dorico could crash when updating the Key Editor when selecting something in the music area 

resulted not only in the piano roll being replaced by the percussion editor but also switching to 

a different flow; this has now been fixed. 

Library Manager Under some circumstances, opening a new project or project window with the Library 

Manager visible could cause the Library Manager window to become blank until you start 

interacting with it again; this has now been fixed. 

Lines Lines drawn with repeatable symbols now print in the correct color if their color has been 

overridden via the Color property. 

Lines The Start position and End position properties now once again appear correctly in the 

Properties panel for rhythmic position-attached lines shown within the staff. 

Localization After changing the user interface language via Preferences, all key commands now work as 

expected, according to the appropriate keyboard language for the newly-chosen language. 

Localization Toggle buttons in some dialogs were not correctly translated into the appropriate language 

when running Dorico in a language other than English; this has now been fixed. 

Lyrics When multi-pasting music containing lyrics to several instruments, lyrics could be incorrectly 

linked across multiple staves; this has now been fixed. 

Lyrics Lyrics with formatting changes within them are no longer sometimes incorrectly positioned 

as if they had hanging punctuation. 

Music fonts If a music font specifies a particular text font in its metadata file, Dorico now correctly applies 

the chosen text font to the default font and paragraph styles. 
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Component Issue 

MusicXML export Dorico no longer sometimes incorrectly exports notes that are not visible in the layout (for 

example, because they are covered by a rhythmic slash region) without specifying their pitch, 

which is invalid MusicXML; instead, such notes are simply omitted. 

Note input When determining which endpoint to use for echoing notes played on the MIDI keyboard, 

Dorico now considers independent voice playback, and chooses the most appropriate 

endpoint based on the selection, rather than simply always choosing the first endpoint for the 

instrument. 

Note input It is no longer possible to delete all the material in a flow in Insert mode such that the flow 

ends up with zero duration. 

Note input Input via MIDI keyboard into a percussion kit or an individual unpitched percussion 

instrument that has been imported from a library file now works reliably; in previous versions, 

Dorico could fail to choose the expected playing technique. 

Note input Under certain circumstances, removing material via Insert mode or the Shift+B popover could 

fail to remove tuplets correctly, for example when the notes in the tuplet to be removed are 

slurred to notes outside the tuplet; this has now been fixed. 

Note input It is no longer possible to add a rhythm dot to a selected implicit bar rest. 

Note input Under some circumstances in transposed layouts, Dorico could add intervals with the wrong 

note spelling when using the Shift+I popover; this has now been fixed. 

Note input Under some circumstances, attempting to navigate from the first or last rest in a voice in a 

percussion kit could cause a crash; this has now been fixed. 

Play mode It is once again possible to duplicate the VST instrument selected in the VST and MIDI panel in 

Play mode with a key command or via the jump bar. 

Playback The value of Increase written dynamic of other beats in the bar on the Dynamics page of 

Playback Options is no longer subtracted from off-beat notes. 

Playback When applying the Min./Max. velocity values specified in expression map switches, Dorico 

now correctly considers any defined note length conditions. 

Playback If you have an immediate dynamic and a gradual dynamic at the same rhythmic position and 

they are not in the same group, the immediate dynamic will now be processed for playback 

before the gradual dynamic, so the dynamic change will be as expected. 

Playback When editing linked slurs or dynamics that are linked to instruments not shown in the current 

layout, when you subsequently play back, those instruments not present in the layout no 

longer unexpectedly play back. 
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Component Issue 

Playback A messa di voce hairpin of the form diminuendo-crescendo no longer plays back in the opposite 

direction. 

Print mode When toggling between Mono and Color, the Watermark checkbox is now always correctly 

enabled or disabled as appropriate. 

Project files When starting a project from a user project template, if a new flow needs to be created, it is 

now created before playback is set up, thus ensuring that playback will always work as 

expected right away. 

Project files When starting a new project via the Hub, the Project will use multiple flows setting will now 

apply not only to the part layouts that are created when the project is first created, but to all 

future part layouts subsequently created in the project. 

Project files Under rare circumstances, Dorico could hang during project saving; this has now been fixed 

(macOS only). 

Project files When exporting flows from a project, Dorico no longer includes a thumbnail preview; 

previously, this preview could be for a flow or layout that was not included in the exported 

material, which could be confusing. 

Project files When saving a project as a template, Dorico now removes all MIDI CC and automation data in 

any preserved flows. 

Project files Under rare circumstances, an unpitched instrument in a percussion kit could be unexpectedly 

silent during playback; this has now been fixed. 

Script plug-ins The Lua interpreter on Windows requires filenames for loaded scripts to be encoded using the 

appropriate code page for the operating system’s current region and language settings; Dorico 

now correctly encodes script filenames in the right code page, but this means that scripts with 

names that use characters outside the current code page will not load correctly. You are 

advised to stick to characters in the Latin-1 code page if possible (Windows only). 

Slurs When multi-pasting material including slurs to a different bar, Dorico no longer incorrectly 

links the newly pasted slurs at the new position to the original slur at its position. 

Staff labels Instruments that use player names as their staff label are no longer allowed to be grouped. 

Tempo When Dorico is set to show metronome marks to a specific level of precision, it could 

incorrectly display floating point values with leading zeroes: for example, 152.09 would 

display as 152.9; this has now been fixed. 

Tempo Under very rare circumstances, setting a sufficiently slow final tempo for a gradual tempo 

change could cause Dorico to crash; this has now been fixed. 



 

 

Dorico 5 Version History 129 Steinberg Media Technologies GmbH 

Component Issue 

Tempo Under certain circumstances, a gradual tempo that coincides with a time signature was no 

longer correctly aligned with the time signature in the presence of another tempo marking at 

its end; this has now been fixed. 

Tempo The abbreviation for circa in metronome marks has been changed to ca instead of ca., i.e. the 

period (full stop) indicating the abbreviation has been removed. 

Ties Edits to the endpoints and curvature of a segment of a tie at the start of the system where the 

tied is between independent notes (for example, in different voices, or non-rhythmically 

contiguous notes) now correctly update the display immediately. 

Tonality systems Under certain circumstances, custom tonality systems in projects created in Dorico 3.5 or 

earlier could be overwritten with a different tonality system in the user library that happens to 

have the same internal identifier, causing unexpected effects when opening that project in the 

latest version; this has now been fixed. 

Tuplets Attempting to create a tuplet where either side of the ratio is zero no longer causes Dorico to 

crash. 

User interface The preview in Library ▶ Paragraph Styles now correctly displays foreground and background 

colors, if specified. 

User interface After saving a custom ensemble in the ensemble builder, if you switch to the Choose page 

without first closing the ensemble builder, the new custom ensemble now correctly appears 

there right away. 

User interface The ensemble builder popover now disappears when the application window is deactivated, 

such that it now behaves the same as the instrument popover. 

User interface The alignment of noteheads and flags to stems when using a standard resolution (i.e. non-

Retina) display has been improved (macOS only). 

User interface When closing a project that was previously displayed full screen, an empty Space is no longer 

left behind (macOS only). 

User interface When opening a new window for an existing project, the Mixer button on the toolbar is now 

correctly enabled if appropriate. 

User interface If you specify a bar number that cannot be found in Edit ▶ Go To, Dorico will now navigate to 

the first system in the relevant flow, rather than doing nothing. 

User interface Key commands shown in the hands-on tutorials accessed via the Learn page of the Hub now 

show the appropriate shortcut modifier keys for macOS and Windows as appropriate. 
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Component Issue 

User interface It is no longer possible to incorrectly specify negative durations for grace notes and tremolos 

on the Timing page of Playback Options. 

User interface The long-lamented disclosure arrow in the tree control in the Key Commands page of 

Preferences has returned home after a heart-wrenching absence of nearly 18 months. 

User interface If a popover is visible when the application loses focus, when the application regains focus, the 

popover itself regains focus, allowing you to continue typing into it without clicking in it again. 

User interface The bars in the system track would often not highlight when hovered over with the mouse; this 

has now been fixed. 

User interface When one of the right-hand panels is shown, it is now correctly updated to match the current 

selection state. 

User interface The single step size for the spin box paddles in the Zoom dialog is now 1%. 

User interface The Follow selection changes on undo and redo option on the Note Input and Editing page 

of Preferences now works as expected once more. 

User interface Longer instrument names are now elided in the track header in Play mode if necessary. 

User interface The layout selector in the toolbar is now correctly disabled both in Print mode and when 

editing page templates and flow headings in Engrave mode. 

Video Under some circumstances, Dorico could fail to connect the appropriate channel for the video 

soundtrack so that it can be heard and balanced via the Mixer when reopening an existing 

project; this has now been fixed. 

Video When playing back video during real-time recording, the video would jump forwards by 20 

seconds compared to normal playback; this has now been fixed. 
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